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FCC Notice
The F Series tables have been tested and found to comply with the limits for Class A
digital devices, pursuant to Part 15 of the FCC Rules. These limits are designed to provide
reasonable protection against harmful interference when the equipment is operated in a
commercial environment. The cutters generate, use and can emit radio frequency energy,
and if not installed and used in accordance with the instruction manual, may cause
harmful interference to radio communications.
The user assumes the risk of any harmful interference caused by operating the cutters in
a residential area.

Caution!
Changes or modifications, not expressly approved by Summa’s FCC compliance, could
void the user’s authority to operate this equipment.

DOC Notice
The F Series do not exceed the Class A limits for radio noise for digital apparatus, set out
in the Radio Interference Regulations of the Canadian Department of Communications.

Notice
Summa reserves the right to modify the information, contained in this User Manual, at any
time without prior notice. Unauthorized copying, modification, distribution or display is
prohibited. All rights reserved.

Waste Electrical and Electronic Equipment (WEEE) Directive
Directive 2002/96/EC of the European Parliament and of the Council
The symbol (right) is shown on this product. It indicates that the
product should not be disposed of with regular household waste, but
should be disposed of separately.
Electrical and electronic equipment can contain materials that are
hazardous to the environment and human health and therefore should
be disposed of at a designated waste facility or returned to the retailer
for the appropriate recycling to take place.For information on
recycling, selling or exchanging parts, please contact Summa.
Copyright © Summa NV

Registering the Flatbed Cutter
Please register the Flatbed Cutter on the following link:
http://www.summa.be/registration.html
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Failure to register the cutter may result in a delayed response to warranty and service
inquiries.

Contact Information
All inquiries, comments or suggestions concerning this and other Summa manuals should
be directed to:
Summa, nv
Rochesterlaan 6
B-8470 GISTEL
Belgium
Website
www.summa.eu
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Welcome
Congratulations on Your Purchase of the New F Series cutting table
The F Series flatbed cutting tables are capable of cutting rigid materials as well as roll stock.
Up to three tool holders can be inserted at one time on the multi-module tool holder.
Changing tools is quick and easy. Automatic tool recognition, combined with digital and
mechanical depth control, ensures precision cutting on a wide variety of materials.
The cutting table base unit comes equipped with a drag knife tool module and an optical
camera recognition system for accurate contour cutting of printed flexible or rigid substrate
materials. A laser pointer is also included for manual origin registration.
A variety of tools, modules and blades are also available, depending on different applications.
For roll stock, the media handling support rollers and the conveyor system will make cutting
over long distances a child’s play.

This manual is a reference guide for installing and operating the F Series cutting table.
Minimum revisions needed for this manual:
Firmware table: 024 (MD9974)
Summa Flatbed Tools: 1.25 (Axis Control 3.20)
SummaFlex Pro : 7.5.13 (ECD version 2.24)
BlueSoleil: 8.0.376
Toshiba: 8.00.02
USB driver: 6.4
Camera driver 1.0.136
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Machine components

1.1 Safety and Ideal Operating Environment
1.1.1 Operating environment
Environmental conditions can significantly affect the machine’s performance.
Most
restrictions or recommendations for the ideal operating environment are already described
in the site preparation document.
The environmental conditions of the machine (without media) are as follows:
Operating Temperature
Storage temperature
Relative humidity

15 to 35° C
-30 to 70° C
35 - 75 %, non-condensing

59 to 95° F
-22 to 158° F
35 - 75 %, non-condensing

It is possible that the environmental conditions of the used media are stricter than those of
the machine itself. Please refer to the documentation about the used media.
Also make sure that the media has had enough time to acclimatize.

1.1.2 Safety
1.1.2.1 General
The purpose of the user’s manual is not only to explain the operating procedures in order to
operate this machine. It also provides the owner, users and operators with precaution
procedures for safe and proper machine operation for its intended purpose.
All information in this manual must be read and understood before any attempt is made to
operate the machine.
The manufacturer has no direct control over the machine operation and application. Proper
safety practice is the sole responsibility of the owner, user and operator.
All instructions and safety warnings in this manual are based upon the use of this machine
under proper operating conditions without alterations from the original design.
The proper use and the limits of the application of the cutting table depend on the module
and tool, used in combination with the material.
Any use of the flatbed that is beyond the capabilities of the combination tool/material is
considered as improper use and may result in injury and/or serious damage to the machine
and will lead to loss of warranty.
The installation of the machine, accessories and spare parts must not be done by untrained
or unauthorized persons. Also the described maintenance procedures need to be followed
and performed by trained personnel.
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1.1.2.2 Symbols used in this manual
Warning with dark (red) symbol: Refers to immediate threat that
can cause serious injuries and effects on health and safety.
Warning with light (yellow) symbol: Refers to a dangerous
situation that can cause injuries and serious damage to the
machine.
Attention with dark (red) symbol: Refers to useful information to
prevent damage to the equipment and prolong the service live of
the machine.
Attention with light (yellow) symbol: Refers to useful tips to
enhance the user-friendliness and make the work significantly
easier.
Note: Can be considered as a general tip, something that is useful
to know.

1.1.2.3 Danger areas
•

GENERAL DANGER AREA

FIG 1-1
1-1 GENERAL DANGER AREA

The easiest way to define the general danger area is the complete area where the table itself
stands and which also covers the moving parts.
WARNING: The top beam is wider than the table itself. This means that the
danger area is wider than the table itself.
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SAFETY AREA DURING OPERATION

front machine

x

FIG 1-2
1-2 SAFE WORKING AREA

During normal production the operator should stay out of the area marked in light gray color.
If the operator moves inside this area, the flatbed table pauses automatically. The current
job is not lost but nothing will move on the table until the operator leaves the area and tells
the flatbed cutter to continue its job (with Axis Control).
WARNING: If the operator needs to be within the area, marked in light gray to
change media or tools, the procedures to perform these actions need to be
followed strictly, as described further in the manual.
The danger area for other personnel is marked in dark gray. It covers 1 meter outside the
area, marked with the safety poles and 1 meter away from the operator’s desk.
WARNING: The operator must always make sure the remote is in its loading
station when it is not in use. This way no other personnel will inadvertently press
the buttons and start up the machine while the operator is in the danger area.
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DANGER AREA AROUND THE HEAD

FIG 1-3
1-3 DANGER AREA AROUND THE HEAD

The head with the modules and about 20 cm around it can be considered as the extra danger
area during module/tool installation. When the operator is working within this area, he has to
be extra careful.
When a module or a tool needs to be changed, the operator is obliged to perform certain
actions within the danger area around the head. So the operator must be sure that the
machine will not make any unexpected movement while performing the changes. There are
only two possible ways to be sure the machine will not make any sudden movements: either
changing the module/tool while the machine is switched off, or following the module/tool
change procedure.
WARNING: When changing a module or a tool, always make sure that Axis
Control is initiated and check whether the second button in Axis Control is
If it is
more.

, then click it, so the machine comes off line and will not move any
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1.1.2.4 Safety features
•

SAFETY BEAMS

Four safety beams are installed around the table. They interrupt the movements of the
machine if a person passes through the beam, sent around the table by the poles. The
interruption is a controlled stop. The machine will stop the movement in less than five
seconds and hold the position where it stopped. This means that the machine can continue
the job when enter is pressed.
ATTENTION: If the safety beams are interrupted or not aligned during the
activation of the machine, the machine will not start up and will report a lot of
fatal errors in Axis Control. This is normal and can only be corrected by either
aligning the safety beams correctly or not interrupting them during booting.
WARNING: The safety beams are active when the machine is in production. This
means when data is sent from the cutting program (e.g. SummaFlex Pro). If the
operator is changing parameters or settings with Summa Axis Control, the safety
beams are temporarily disabled.
WARNING: The safety beams need to be installed according to the procedure
described in this manual. The owner/operator of the machine is responsible and
has signed this in the installation completion document.
WARNING: Larger tables offer the possibility to work in ‘tandem mode’. This
implies that one side of the safety area can be disabled while the table is cutting,
so media can be loaded on the table. Follow the procedure described in section
1.6.2 to avoid injury.
•

EMERGENCY STOP SWITCHES

There is an emergency switch on each corner of the flatbed table. This allows the operator to
switch off the machine quickly in hazardous situations. If the emergency stop is pressed, the
power to the motors is cut immediately. This means that the machine stops immediately, but
it also means the current job is lost.
To unlock an activated emergency switch, turn it clockwise.
•

OVERCURRENT

The cutter constantly measures the current through the motors. If the machine detects the
current is too high, the current is cut off to the motors and a fatal error message will be
displayed in Axis Control.
WARNING: All the built-in safety features cannot prevent the high level of kinetic
energy that can be released during an emergency stop or an unforeseen
malfunction of the machine. So they are not a guarantee against injuries.
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1.1.2.5 Personal protective equipment
The required safety equipment depends on the installed modules and the material that needs
to be cut/milled.
During operating or servicing the machine the operator should wear close fitting clothing and
use appropriate protective equipment.
Appropriate protective equipment can include:
• Work clothes.
• Goggles because when processing the material large particles can be generated.
• Ear protection if the continuous sound level pressure is above 80dB.
WARNING: There is a risk of injury from being caught or trapped in moving
machine parts.
Keep hands, hair, clothing and jewelry away from moving parts. Do not wear
jewelry, loose clothing, scarves or open jackets or shirtsleeves.
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1.2 Flatbed Components F1612 (no router option installed)
1.2.1 Front view

FIG 1-4
1-4 F1612 FRONT VIEW

1. Power cable entry: The F1612 has no power entry plug. The power cable has to be made
onsite and it has to be connected directly inside the machine itself. The cable will have to
be guided through this entry.
2. USB connection: This interface is based on the standards, specified in the Universal
Serial Bus. A minimum of USB 2.0 is needed for the camera connection.
ATTENTION: The F1612 needs to be connected directly to a computer. The USB
cable shouldn’t be longer than 3 meter (+0.5 m) and no hubs should be used.
3. Power On/Off switch: This turn switch can be used to switch the flatbed on or off. There
is a hole provided, so the switch can be locked with a padlock.
4. Emergency stops: There are four emergency stops on the flatbed. If they are pressed, the
flatbed stops immediately to prevent damage to the operator and to the machine itself.
Once pressed, they stay in a safe locked position and need to be turned to the right to
unlock again.
5. Carriage for modules: The carriage can hold up to three removable modules and has a
fixed central unit.
6. Central unit: The central unit houses a positioning laser and an integrated camera system
for fast and accurate registration mark recognition.
7. Drag head module: The drag head module comes standard with the flatbed cutter. It can
be used to mount the drag knife or pen.
8. Tangential module (optional): The tangential module is used for the tangential tools.
9. Safety poles: The flatbed is surrounded with 4 safety poles to make sure it stops working
when a person approaches it.
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1.2.2 Options

FIG 1-5
1-5 F1612 OPTIONS (REAR VIEW)

1. Roll support: Media support bars and a set of core holders for loading roll material.
2. Pneumatic clamps: Pneumatic media advance system. It clamps the conveyor belt and
holds the media down while pulling it forward in order to work continuously, in panels or
for multiple jobs.
NOTE: The three clamps that hold the media down can be moved from the left to
the right and can be enabled (
) or disabled (
turning the handle on top of each clamp.

) individually by

NOTE: If the media does not stay flat after feeding, it is recommended to only use
one media clamp in the middle of the media.
3. Conveyor belt: The conveyor system is needed for feeding the media when the cutout tool
is used.
NOTE: If oscillating tools are used, then a protective mat can be put over the
conveyor belt. However, with the protective mat the maximum size of the job is
restricted to the size of the table.

General Directional information:
o Front right of the machine: Where the on/off switch is located (this determines
automatically the left and back of the machine).
o X axis: From front to back.
o Y axis: From right to left.
o Origin: The origin is situated at the right side at the front.
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1.3 Flatbed components F2630
1.3.1 Front view

FIG 1-6
1-6 F2630 MAIN COMPONENTS (FRONT VIEW)

1. Power cable entry: The F2630 has no power entry plug. The power cable needs to be
made onsite and it needs to be connected directly inside the machine itself. The cable will
have to be guided through this entry.
2. USB connection: This interface is based on the standards specified in the Universal Serial
Bus. A minimum of USB 2.0 is needed for the camera connection.
ATTENTION: The F2630 needs to be connected directly to a computer. The USB
cable should not be longer than 3 meter (+0.5 m) and no hubs should be used.
3. Power On/Off switch: This turn switch can be used to switch the flatbed on or off. There is
a hole provided so the switch can be locked with a padlock.
4. Emergency stops: There are four emergency stops on the flatbed. If they are pressed, the
flatbed stops immediately to prevent damage to the operator and to the machine itself.
Once pressed, they stay in a safe locked position and need to be turned to the right to
unlock them again.
5. Carriage for modules: The carriage can hold up to three removable modules and has a
fixed central unit.
6. Central unit: The central unit houses a positioning laser and an integrated camera system
for fast and accurate registration mark recognition.
7. Drag head module: The drag head module comes standard with the flatbed cutter. It can
be used to mount the drag knife or pen.
8. Flatbed surface: Two vacuum pumps provide a vacuum in order to hold down the
material, so it can be cut/milled. The flatbed surface can be divided into 12 zones. One
vacuum pump controls the front 6 zones, the other one controls the rear 6 zones. The
zones are switched on/off according to the set media size.
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9. Safety poles: The flatbed is surrounded with 4 safety poles to make sure it stops working
when a person approaches it.

1.3.2 Rear view

FIG 1-7
1-7 F2630 OPTIONS (REAR VIEW)

1. Roll support: Media support bars and a set of core holders for loading roll material.
2. Media clamps pack: Pneumatic media advance system. It holds the media down and
clamps the conveyor belt while pulling it forward in order to work continuously, in panels
or for multiple jobs.
NOTE: The six clamps that hold the media down can be moved from the left to the
right and can be individually enabled (
turning on the handle on top of each clamp.

) or disabled (

) by

NOTE: If the media does not stay flat after feeding, then it is recommended to use
only one or two media clamp(s) in the middle of the media.
3. Conveyor system: The conveyor system is needed for feeding the material when the
cutout tools are used.
4. Routing system: The picture shows a rear view of the gantry and routing module
(optional).
General Directional information:
o Front right of the machine: Where the on/off switch is located (this determines
automatically the left and back of the machine).
o X axis: From front to back.
o Y axis: From right to left.
o Origin: The origin is situated at the front right side.
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1.4 Flatbed components F1330
1.4.1 Front view

FIG 1-8
1-8 F1330 MAIN COMPONENTS (FRONT VIEW)

1. Power cable entry: The F1330 has no power entry plug. The power cable needs to be
made onsite and it needs to be connected directly inside the machine itself. The cable will
have to be guided through this entry.
2. USB connection: This interface is based on the standards specified in the Universal
Serial Bus. A minimum of USB 2.0 is needed for the camera connection.
ATTENTION: The F1330 needs to be connected directly to a computer. The USB
cable should not be longer than 3 meter (+0.5 m) and no hubs should be used.
3. Power On/Off switch: This turn switch can be used to switch the flatbed on or off. There
is a hole provided so the switch can be locked with a padlock.
4. Emergency stops: There are four emergency stops on the flatbed. If they are pressed, the
flatbed stops immediately to prevent damage to the operator and to the machine itself.
Once pressed, they stay in a safe locked position and need to be turned to the right to
unlock them again.
5. Carriage for modules: The carriage can hold up to three removable modules and has a
fixed central unit.
6. Central unit: The central unit houses a positioning laser and an integrated camera system
for fast and accurate registration mark recognition.
7. Drag head module: The drag head module comes standard with the flatbed cutter. It can
be used to mount the drag knife or pen.
8. Flatbed surface: Two vacuum pumps provide a vacuum in order to hold down the
material, so it can be cut/milled. The flatbed surface can be divided into 6 zones. The
zones are switched on/off according to the set media size.
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9. Safety poles: The flatbed is surrounded with 4 safety poles to make sure the machine
stops working when a person approaches it.

1.4.2 Rear view

1. Roll support: Media support bars and a set of core holders for loading roll material.
2. Media clamps pack: Pneumatic media advance system. It holds the media down and
clamps the conveyor belt while pulling it forward in order to work continuously, in panels
or in order to process multiple jobs.
NOTE: The six clamps that hold the media down can be moved from the left to the
right and can be individually enabled (
turning on the handle on top of each clamp.

) or disabled (

) by

NOTE: If the media does not stay flat after feeding, it is recommended to only use
one or two media clamp(s) in the middle of the media.
3. Conveyor system: The conveyor system is needed for feeding the material when the
cutout tools are used.
4. Routing system: The picture shows a rear view of the gantry and routing module.
General Directional information:
o Front right of the machine: Where the on/off switch is located (this determines
automatically the left and back of the machine).
o X axis: From front to back.
o Y axis: From right to left.
o Origin: The origin is situated at the front right side.
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1.5 Modules
1.5.1 Camera unit
Up to three modules can be mounted on the carriage.
The carriage also has a central unit. This central unit is
fixed to the carriage and cannot be taken off. The
central unit houses a positioning laser and an
integrated camera system for fast and accurate
registration mark recognition while contour cutting.
The camera module also has two optional connections
for electricity for special tools or modules.
The camera module of the F1612 also has the
connections for the special tools or modules that
require compressed air. For the larger models, these
connections for compressed air are situated at the side
of the carriage.
Both the knob and black camera adjust plate are part of
the manual height adjust mechanism. Each time
material is loaded with a different thickness than the
previous one, the height of the camera needs to be
adjusted (only with contour cutting).

To adjust the height do following:
1. Make sure the central unit is situated above the media.
2. Turn the knob counterclockwise to loosen the central unit and let it move all the way
to the top.
3. Push the central unit all the way down.
4. Push the camera adjust-plate down onto the media.
5. Let go of the central unit whilst the adjust plate stays pushed on the media.
6. Secure the central unit by turning the knob clockwise and let go of the adjust plate.
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1.5.2 Drag head module

The drag head module comes standard with the flatbed
cutter.
The Drag Module is a fast-moving drag knife and pen
holder for making notations or kiss-cutting a wide
range of materials, using up to 600 grams of
downforce.
The clearance between the standard drag knife holder
and the flatbed base is approximately 3 mm (0.11”).
So, it has to be removed when thicker materials are
used. The clearance between the table and the drag
head module is less than 1 cm (0.4”), so if thicker
materials are used, the drag head module must be
removed or the height of the head must be changed.

ATTENTION: It is recommended to remove the module when not in use.
The height of the drag head can be changed manually. However for 99% of the cut jobs with
the drag head, the height will not have to be changed. The height of the drag head needs to
be changed only if it is used for writing on thick materials.
To change the height of the drag head do following:
1.
2.
3.
4.
5.

Remove the drag head module from the flatbed.
At the back of the module, loosen the 4 screws in the 4 slots.
Move the head to the desired height.
Fasten the 4 screws again.
Put the module back on the flatbed and check if the new height is correct. If not,
repeat this procedure.
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1.5.3 Tangential module

The tangential module offers a vertical force of 10 kg
and corresponds to a wide range of matching tools.
Each tool has a barcode ID that ensures automatic
recognition and separate parameter settings.
For each application, a corresponding tool can be
installed on the tangential module.

ATTENTION: It is recommended to remove the module when not in use.
Currently following tools are available:
1. Kiss cutting tool
2. Cutout tool (single, double and heavy duty)
3. EOT (electronic oscillating tool)
4. Creasing tool
5. V-Cut tool
6. POT ( pneumatic oscillating tool)

The flat front knob serves to hold the internal shaft steady whilst installing or removing a
tool. This is explained in detail in the next section.
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1.5.4 Rotary Module

The Rotary Module has a decagonal
tangentially controlled knife, which is
driven by an electronic motor.
Depending on the used speed and knife
diameter, all kinds of materials up to 5
mm thickness can be cut with the rotary
knife.
However, the main focus is on single
layered textiles because certain types of
fiber are hard to cut with other knife
types. Ideal materials to cut with the
rotary knife are: flag & banner material,
felt, technical textiles, fabric, foams,...
The module allocates slot 2&3 of the
head. It also requires compressed air
(standard on large tables).

Knives have to be mounted directly in the module; there are no tools available for this
module.
The Rotary module includes the following:
1.
2.
3.
4.

Rotary module
Connection for compressed air for large and small tables
Knife ∅ 28 mm
Wrench # 10 mm for knife change
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1.5.5 Standard router module (F Series router system optional)

The router module has a 1 kW Kress
motor capable of handling most used solid
boards in the graphic and sign industry:
hard foam PVC, acrylic and aluminum
covered foam boards.
The router system comes with a vacuum
cleaning kit to take away the chips and
dust. The kit includes a brush assembly, a
hose and a mounting pole. The vacuum
cleaner is optional.
The module allocates slot 2&3 of the
head. Of course, the module can be easily
dismounted and parked on the pole of the
gantry, making the two slots available
again.
The hose set and gantry of a small table are
not the same of those of a big table. So be
sure to check the option list of the table
model to be sure the correct router module
is ordered for the table.

The F Series router system includes following:
1.
2.
3.
4.
5.
6.
7.

Routing module (with brush system)
Hoses and gantry
Switch for vacuum cleaner
Kress Milling Motor
Set of collets
Universal bit to start with
Milling mat

ATTENTION: Use of a routing mat is mandatory.
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1.5.6 HF Router module (F Series HF router system optional)
With up to 1 kW output power the HF milling
motor has significantly more power than the
Kress milling motor, which allows faster
processing speeds.
The balanced spindle also generates higher
rotation speeds. This also allows faster
processing speeds and/or smoother finishing.
The HF router system comes with an own
power supply and motor driver, which are
mounted on the pole of the gantry system
outside the machine for the F1612 and inside
for the larger models.
The collet is clamping the bit pneumatically.
No wrenches are needed to replace the bit.
While in change tool/bit mode, a compressed
air switch activates and deactivates the
clamping of the bit. This can be done while the
milling motor remains in the module, which
results in fast and easy bit changes.
The router system comes with a vacuum
cleaning kit to take away the chips and dust.
The kit includes a brush assembly, a hose and
a mounting pole. The vacuum cleaner is
optional.
The hose set and gantry of a small table are
not the same of those of a big table. So be
sure to check the option list of the table
model to be sure the correct router module is
ordered for the table.
The F Series HF router system includes following:
1.
2.
3.
4.
5.
6.
7.
8.

Routing module (with brush system)
Hoses and gantry
Switch for vacuum cleaner
SycoTec Milling Motor
Power supply and motor driver
Collet: 6 mm
Universal bit (∅4mm) to start with
Milling mat

ATTENTION: Use of a routing mat is mandatory.
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1.5.7 Remote Controller
The remote controller can be used in combination with the
program Axis Control.
It is useful during media loading and tool installation while
moving around the flatbed cutter.
The arrow keys work in the same way as the arrow keys on the
keyboard.
The A key is the acknowledge key, which needs to be used when
a setting has been changed.
The key at the back of the remote (B key) is the same as the shift
key on the keyboard.
The lights at the bottom show the number of the module that is
chosen during the calibration of the tools.
The left light is blinking during origin change and the right light is
blinking during media size change.
See table below for complete list of Wii buttons / keyboard keys
Refer to section 4.2.1 for activation of the remote controller.

ATTENTION: Be sure to put the remote controller on its loading station each time
it has been used. If the computer stays activated at night, you should stop the
connection between the computer and remote.
WARNING: If the remote is used during tool calibration, the operator can
approach the table despite of the safety beams. The operator must make sure
that at that moment nobody else is in the neighborhood of the table or computer
(see safety area in section 1.7.2.3).
Wii Remote key
ARROW buttons
‘A’ button
‘Back’ button
‘-‘ button
‘Home’ button
‘+’ button
‘1’ button
‘2’ button
Shortcut Keyboard key
‘P’
‘C’

Machine components

Corresponding Keyboard key
ARROW keys
ENTER
SHIFT
PAGE DOWN and NUMLOCK SUBTRACT
(version 3.14)
ESCAPE
PAGE UP and NUMLOCK ADD (version 3.14)
F1
F2
Functionallity
Select pointer when setting origin or size.
Select camera when setting origin or size.
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1.6 Media Handling
1.6.1 Loading media on the F1612
Loading media means positioning the media on the table and setting the origin and media
size (working area). Sometimes this is a two-step process (first loading the media, then
setting the media size). Sometimes it can be done in one step (setting the size, then
loading), depending on the type and size of the media.

1.6.1.1 Loading sheet media
WARNING: For safety reasons, always use this procedure to load media.
Only if this method is used, is it sure that the machine will not make unexpected
movements and harm the operator.
1. Make sure the machine is activated and Axis Control is running.
2. The program Axis Control normally starts up in the media menu. In this menu the
working area can be set. Setting the working area is only part of the loading
procedure.

3. Click

to initiate the loading sequence.

The main window changes to the load window.
loading a roll and loading a sheet.

On the left there is the choice between

4. Click the radio button in front of “Sheet”.
The options for loading sheet material are shown.

FIG 1-9
1-9 OPTIONS FOR LOADING SHEET MATERIAL

• The park position is the position the carriage with modules and tools will go to when
the loading sequence is started. Click on a circle to set the park position. The red
circle is the current selected park position. The park position depends on whether the
media has to be loaded from the front or from the rear.
• With the default working area the origin and sheet width can be set. If the box in front
of “Origin reset” is checked, the origin is reset to the mechanical origin. Otherwise the
origin stays the same. If the box in front of “Width” is set, the width of the media that
will be loaded can be set.
• The initial state of the vacuum pump can also be set before the loading sequence is
started. If needed, the vacuum pump can be controlled with the remote during loading
itself (see section 4.2.6).
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5. Choose the setting and click the

button.

The machine adjusts the vacuum selector if a new width is chosen, moves the carriage to
the park position and sets the vacuum as chosen.
6. Go to the machine and load the sheet. Make sure to activate the vacuum at least once
(use

on the remote to control the vacuum) to check if the media is lying flat

enough. If the media is loaded correctly, click

.

The carriage returns to the origin and Axis Control goes to the media menu. The origin and
media width (size) can be changed, if needed (see section 1.6.1.3).

1.6.1.2 Loading roll media
The conveyor belt in combination with the pneumatic pack and the roll support are
recommended for roll material. Loading is then very easy with following procedure.
WARNING: For safety reasons, always use this procedure to load media.
Only if this method is used, is it sure that the machine will not make unexpected
movements and harm the operator.
1. Make sure the machine is activated and Axis Control is running.
2. The program Axis Control normally starts up in the media menu. In this menu the
working area can be set. Setting the working area is only part of the loading procedure.

3. Click

to initiate the loading sequence.

The main window changes to the load window. On the left you can choose between loading
a roll and loading a sheet.
4. Click the radio button in front of “ Roll”.
The options for loading roll material are shown.

FIG 1-10
1-10 OPTIONS FOR LOADING ROLL MATERIAL

• The park position is the position the carriage with modules and tools will go to when
the loading sequence is started. Recommended values are 850mm-1000mm,
depending on the size and weight of the media. The media can be guided on the table
until it is situated just under the media advance clamps. Heavier media has to be
pushed a bit further on the table.
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• With the default working area the origin and sheet width can be set. If the box before
the origin is checked, the origin is reset to the mechanical origin. Otherwise the origin
stays the same. If the box before the width is set, the width of the media that will be
loaded can be set.
• The initial state of the vacuum pump can also be set before the loading sequence is
started. If needed, the vacuum pump can be controlled with the remote during loading
itself (see section 4.2.6).
5. Choose the setting and click the

button.

The machine adjusts the vacuum selector if a new width is chosen, moves the carriage to
the park position and sets the vacuum as chosen.
6. Insert a media core holder in each end of the media roll. Loosen the core holders with the
black knob on the side. Figure 1-9 shows a loosened (1) core holder and an expanded (2)
core holder.

FIG 1-11
1-11 MEDIA CORE HOLDER

7. Insert the loosened core holders into each end of the roll. Tighten each end with the black
knob, making sure both core holders are secured.
8. Place the media roll on the media supply rollers from the back of the machine. Place the
flange-equipped roll on the media supply rollers. Set the flanges inside the groove of the
flange guide. The flange guides can be moved laterally on the roller.
9. First set the media advance clamps this way they divide the media into equal parts with
the two outer clamps at about 10 cm from the side. Slide the media until the front end is
situated under the media advance clamps. Use the remote (
) to control the vacuum
and to hold the media down. The media advance clamps can be controlled with the up and
down keys of the remote (
side.

or

). Try and put the media as parallel as possible to the

WARNING: Make sure that the compressed air hoses are not jammed by putting
the clamps too close to the side or to each other.
10. Click

.

The media is moved forward as far as possible (the X origin as far as possible forwards.
The carriage returns to the right; the media length is set to its maximum and Axis Control
goes to the media menu. The origin and media width (size) can be changed if needed (see
section 1.6.1.3.).
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1.6.1.3 Setting origin and media size
After loading the media, Axis Control goes to the media menu where the origin and size of
the loaded media can be changed, if necessary.
1. To change the origin, click the
button. The origin position can be changed by
either filling in a value or moving the carriage with the arrow keys.
• To change the origin by filling in the values, change the values under origin (X) and
origin (Y), then click the
Change the values, if necessary.
• Click

,

,

and

button. The carriage then moves to the new origin.
to change the origin with the keyboard or use the

keys on the remote. The carriage will move accordingly. The red light on the
carriage makes the origin visible on the table itself. Click
over the origin so the origin can be seen on screen. If
light) is set again over the origin.

. The camera is moved
is clicked, the pointer (red

FIG 1-12
1-12 OPTIONS FOR SETTING THE ORIGIN

2. There are three different ways to confirm the new origin.
• Click

to confirm the chosen origin.

• Click
to move the chosen origin forward as far as possible to the front
(mechanical origin X value -> 0).
• Click
to cut off the media at the chosen origin. If more than one tool is
available to cut off the media, the program lets the user choose the tool.

3. Or click

to leave the origin unchanged.
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4. To change the size (width and length), click the
button. The width and length of
the loaded media can be changed by either filling in a value or moving the carriage with
the arrow keys.
• To change the size by filling in the values, change the values under length and width
button. The carriage then moves to the new size. Change values,

and click the
if necessary.
• Click

,

,

and

to change the size with the keyboard or use the

keys on the remote. The carriage will move accordingly. The red light on the
.
carriage makes the maximum x and y position visible on the table itself. Click
The camera is moved over the maximum x and y position, so the size can be seen on
the screen. If
and y position.

is clicked, the pointer (red light) is set again over the maximum x

NOTE: Try and define the size in the y direction as close as possible to the edge
of the loaded media. This is necessary in order to create an optimal vacuum.

FIG 1-13
1-13 OPTIONS FOR SETTING THE SIZE

5. Click

to confirm the chosen size or click

to leave the size unchanged.

If a new media size is set, the vacuum selector will move to its new position. Subsequently
the carriage will go back to the origin.
NOTE: There is also a quick way to change the origin and media size with the
remote only. However, in this case the options are limited. This is explained in
section 4.2.4.
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1.6.2 Loading media on larger tables
1.6.2.1 Loading sheet media
WARNING: For safety reasons, always use this procedure to load media.
Only if this method is used, is it sure that the machine will not make unexpected
movements and harm the operator.
1. Make sure the machine is activated and Axis Control is running.
2. The program Axis Control normally starts up in the media menu. In this menu the
working area can be set. Setting the working area is only part of the loading procedure.

3. Click

to initiate the loading sequence.

The main window changes to the load window.
loading a roll and loading a sheet.

On the left there is the choice between

4. Click the radio button in front of “Sheet”.
The options for loading sheet material are shown.

FIG 1-14
1-14 OPTIONS FOR LOADING SHEET MATERIAL

• The park position is the position the carriage with modules and tools will go to when
the loading sequence is started. Click a circle to set the park position. The red circle
is the current selected park position. The park position depends on whether the media
has to be loaded from the front or from the rear.
• With the default working area the origin and sheet width can be set. If the box in front
of “Origin reset” is checked, the origin is reset to the mechanical origin. Otherwise the
origin stays the same. If the box in front of “Width” is set, the width of the media that
will be loaded can be set.
• The initial state of the vacuum pump(s) can also bet set before the loading sequence is
started. If needed, the vacuum pump(s) can be controlled with the remote during
loading itself (see section 4.2.6).
5. Choose the setting and click the

button.

The machine switches the correct vacuum zones on or off, moves the carriage to the park
position and sets the vacuum as chosen.
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6. Go to the machine and load the sheet. Make sure to activate the vacuum at least once
(use

on the remote to control the vacuum) to check if the media is lying flat enough.

If the media is loaded correctly, click

.

The carriage returns to the origin and axis control goes to the media menu. The origin and
media width (size) can be changed, if needed (see section 1.6.2.3).

1.6.2.2 Loading roll media
The conveyor belt in combination with the media clamps pack and the roll support are
recommended for roll material. Loading is then very easy with following procedure.
WARNING: For safety reasons, always use this procedure to load media.
Only if this method is used, is it sure that the machine will not make unexpected
movements and harm the operator.
1. Make sure the machine is activated and Axis Control is running.
2. The program Axis Control normally starts up in the media menu. In this menu the
working area can be set. Setting the working area is only part of the loading procedure.

3. Click

to initiate the loading sequence.

The main window changes to the load window. On the left you can choose between loading
a roll and loading a sheet.
4. Click the radio button in front of “ Roll”.
The options for loading Roll material are shown.

FIG 1-15
1-15 OPTIONS FOR LOADING ROLL MATERIAL

• The park position is the position the carriage with modules and tools will go to when
the loading sequence is started. Recommended values are 0 to 200 less than the
maximum cutting length, depending on the size and weight of the media. The media
can be guided on the table until it is situated just under the media advance clamps.
Heavier media has to be pushed a bit further on the table.
• With the default working area the origin and sheet width can be set. If the box before
the origin is checked, the origin is reset to the mechanical origin. Otherwise the origin
stays the same. If the box before the width is set, the width of the media that will be
loaded can be set.
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• The initial state of the vacuum pump can also be set before the loading sequence is
started. If needed, the vacuum pump can be controlled with the remote during loading
itself (see section 4.2.6).
5. Choose the setting and click the

button.

The machine switches the correct vacuum zones on or off, moves the carriage to the park
position and sets the vacuum as chosen.
6. Insert a media core holder in each end of the media roll. Loosen the core holders with the
black knob on the side. Figure 1-14 shows a loosened (1) core holder and an expanded
(2) core holder.

FIG 1-16
1-16 MEDIA CORE HOLDER

7. Insert the loosened core holders into each end of the roll. Tighten each end with the black
knob, making sure both core holders are secured.
8. From the back of the machine, place the media roll on the media supply rollers. Place the
flange-equipped roll on the media supply rollers. Set the flanges inside the groove of the
flange guide. The flange guides can be moved laterally on the roller.
9. First set the media advance clamps this way they divide the media into equal parts with
the two outer clamps at about 10 cm from the side. Leave around 50 cm space between
each clamp. Disable the clamps, which are not being used, if the media doesn’t cover the
full width. Slide the media until the front end is situated under the media advance clamps.
Use the remote (

) to control the vacuum and to hold the media down. The media

advance clamps can be controlled with the up and down keys of the remote (
Try and put the media as parallel as possible to the side.

or

).

WARNING: Make sure that the compressed air hoses are not jammed by putting
the clamps too close to the side or each other.
10. Click

.

The media is moved forward as far as possible (the X origin as far as possible forwards.
The carriage returns to the right, the media length is set to its maximum and Axis Control
goes to the media menu. The origin and media width (size) can be changed if needed (see
section 1.6.2.3).
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1.6.2.3 Setting origin and media size
After loading the media, Axis Control goes to the media menu where the origin and size of
the loaded media can be changed, if necessary.
1. To change the origin, click the
button. The origin position can be changed by
either filling in a value or moving the carriage with the arrow keys.
• To change the origin by filling in the values, change the values under origin (X) and
origin (Y), then click the
Change the values, if necessary.
• Click

,

,

and

button. The carriage then moves to the new origin.
to change the origin with the keyboard or use the

keys on the remote. The carriage will move accordingly. The red light on the
carriage makes the origin visible on the table itself. Click
over the origin so the origin can be seen on screen. If
light) is set again over the origin.

. The camera is moved
is clicked, the pointer (red

FIG 1-17
1-17 OPTIONS FOR SETTING THE ORIGIN

2. There are three different ways to confirm the new origin.
• Click

to confirm the chosen origin.

• Click
to move the chosen origin forward as far as possible to the front
(mechanical origin X value -> 0).
• Click
to cut off the media at the chosen origin. If more than one tool is
available to cut off the media, the program lets the user choose the tool.

3. Or click

to leave the origin unchanged.
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To change the size (width and length), click the
button. The width and length of
the loaded media can be changed by either filling in a value or moving the carriage with the
arrow keys.
• To change the size by filling in the values, change the values under length and width
button. The carriage then moves to the new size. Change values,

and click the
if necessary.

• Click
,
,
and
to change the size with the keyboard or use the
keys on the remote. The carriage will move accordingly. The red light on the carriage
makes the maximum x and y position visible on the table itself. Click
. The
camera is moved over the maximum x and y position, so the size can be seen on the
screen. If
y position.

is clicked, the pointer (red light) is set again over the maximum x and

NOTE: Try and define the size in the y direction to the right side of a green line. If
necessary, move the media a little bit. Those lines show the vacuum zones. This
is necessary to create an optimal vacuum.

FIG 1-18
1-18 OPTIONS FOR SETTING THE SIZE

4. Click

to confirm the chosen size or click

to leave the size unchanged.

If a new media size is set, the vacuum zones, covered by the media, will be switched on; the
others will be switched off. Subsequently the carriage will go back to the origin.
NOTE: There is also a quick way to change the origin and media size with the
remote only. However, in this case the options are limited. This is explained in
section 4.2.4.
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1.7 Tools
ATTENTION: This section explains the different types of tools and how to
remove/install the knives from/in those tools. After installation of the tool in the
module, a calibration is mandatory. That is explained in section 2.
NOTE: The result of the calibration of the tools (tool parameters) is stored on the
mainboard of the table. The reference that is used is the slot position on the
carriage. This means that calibration has to be redone each time the position of
the tool is changed or each time the tool is used in another module.

1.7.1 Drag knife holder for the drag head module
1.7.1.1 Removing the knife from the drag knife holder
1. Turn the knurled adjustment knob (3) clockwise to push the knife (1) out of the holder (2).

FIG 1-19
1-19 REMOVING THE KNIFE FROM THE STANDARD DRAG KNIFE HOLDER

2. Carefully pull the knife from the holder.

1.7.1.2 Installing the drag knife into the drag knife holder
1. Remove the aluminum part from the plastic knife holder (2) by turning the knurled
adjustment knob (3) counterclockwise until the aluminum part comes out of the holder.
2. Insert the conical, non-cutting end of the knife into the opening in the narrow end of the
holder. Gently push the knife all the way in.
3. Turn the holder upside down and tap it lightly on a solid surface to ensure that the knife is
completely inserted.
4. Slowly turn the knurled knob clockwise until the tip of the blade extends the distance
required for the desired cutting media (t), as shown in the figure below.

FIG 1-20
1-20 KNIFE LENGTH ADJUSTMENT

5. Insert the knife holder into the head clamp, seating it firmly.
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1.7.2 Kiss Cutting Tool for the tangential module
1.7.2.1 Kiss Cutting Tool
The Kiss Cutting Tool is able to kiss cut the most demanding roll materials. The applied force
can be up to 2000 gr. There are 3 pressure adjustment screws, so the applied cutting
pressure can be manually adjusted accurately.

FIG 1-21
1-21 KISS CUTTING TOOL

1.7.2.2 Removing a knife from the Kiss Cutting Tool
A knife has been pre-installed in the Kiss Cutting Tool. For safety reasons, the knife depth
has been set to zero. Simply turn out the knife to start.
.

FIG 1-22
1-22 KNIFE HOLDER KISS CUTTING TOOL

Turn the knife holder counterclockwise. The holder will rise up, eventually making it possible
to lift the knife holder out of the tool.
The knife can be removed from the knife holder by using something like a flat screwdriver to
pry between the knife and the knife holder in the groove.

FIG 1-23
1-23 REMOVAL OF THE KISS CUTTING KNIFE
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1.7.2.3 Installing a knife from the Kiss Cutting Tool
1. Insert the standard knife blade into the knife holder. Make sure the knife blade is firmly
fixed in the holder. The knife is inserted correctly if it cannot be removed manually from
the knife holder. The installation tool can be used to apply enough pressure on the
knife to secure it.

FIG 1-24
1-24 BLADE ASSEMBLY KISS CUTTING TOOL

2. Gently insert the knife holder into the tool shaft. Hold the nose piece in place with one
hand and, with the other hand, turn the knife holder counterclockwise until the
alignment pin fits into the small notch of the tool shaft. Now, turn the knife holder
clockwise until its thread takes hold inside the tool shaft.
3. Hold the nose piece in place with one hand. Adjust the knife depth with the other hand
by turning the knife holder clockwise until the knife tip is just visible from under the
nose piece.

Film
Backing

FIG 1-25
1-25 KNIFE DEPTH ADJUSTMENT KISS CUTTING TOOL

NOTE: For most vinyl cutting operations, the knife blade tip will be barely visible
at the bottom of the knife tool. If the knife blade tip is clearly visible, the knife
depth must be readjusted.
ATTENTION: To benefit fully from the advantages of the tangential knife, the
amount the knife extends is very important. The knife pressure should not control
the knife depth. The two rollers of the nose piece should always touch the media,
thus controlling the knife depth.
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1.7.3 Cutout Tool for tangential module
ATTENTION: The Cutout Tool can only be used when the flatbed has a protective
mat or when the conveyor system is installed.

1.7.3.1 Types of cutout tools
The Cutout Tool serves for cutting completely through the material. There are three different
cutout tools, each of which used for specific applications.
The Single Edge Cutout Tool is designed for detailed cutting (e.g. on vinyl, thin cardboard ...).
The Double Edge Cutout Tool ensures minimal wear when cutting tough materials (e.g.
magnetic, textile ...) and the Heavy Duty Cutout Tool is suitable for thicker materials (e.g.
softboard, carpet,...).

FIG 1-26
1-26 SINGLE EDGE CUTOUT TOOL

FIG 1-27
1-27 DOUBLE EDGE CUTOUT TOOL

FIG 1-28
1-28 HEAVY DUTY CUTOUT TOOL

1.7.3.2 Removing a knife from the Cutout Tool
The knife is clamped with a metal piece that is fixed with two screws.
The single edge and the double edge knife also have a gliding disk for protection.
To remove the knife from the holder, loosen the two screws a turn or two.
Then carefully take out the knife. The gliding disk of the single edge and double edge knife
will have to be pushed backwards before the knife can be reached.

1.7.3.3 Installing a knife in the Cutout Tool
In order to install a knife, check at first if the metal piece, that clamps the knife, is loose. If
not, loosen it by turning the two screws. Then turn the tool this way the plate faces down.
Take the knife with the tool and gently slide it into the tool.
Hold the tool upside down and check if the knife is completely pushed down. Then secure the
knife with the two screws.
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1.7.4 Electronic Oscillating Tool (EOT) for the tangential module
ATTENTION: The EOT can only be used when the flatbed has a protective mat or if
the conveyor system is installed.

1.7.4.1 EOT
The tool fits into the tangential module and needs to be connected with a cable to the
camera unit. The cable is slotted and marked with a triangle (see detail figure). Orientate the
cable this way so this triangle faces the top before connecting the cable. The Oscillating Tool
is driven by an electric motor, producing up to 12.000 rpm and it has a stroke of +/-1mm.
Knives are available to cut material up to a thickness of 24 mm. The EOT is used for cutting
foam boards, corrugated cardboard and other soft thick materials.

FIG 1-29
1-29 ELECTRONIC OSCILLATING TOOL

1.7.4.2 Removing a knife from the EOT
The knife is clamped with a screw. Relatively short knives also have a gliding disk for
protection. To remove the knife from the holder, first remove the gliding disk.
Then completely remove the setscrew that holds the knife. This to make sure that the
setscrew is not fastened by mistake without a knife in the EOT because this could seriously
damage the knife holder shaft. Then carefully take out the knife.
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1.7.4.3 Installing a knife in the EOT
Check if the gliding disk is removed and if the setscrew, that clamps the knife, is completely
removed. If not, do so. The picture below shows when the gliding disk is removed. The
setscrew is also removed and the knife holder shaft is slightly sticking out at the left side.

FIG 1-30
1-30 KNIFE HOLDER SHAFT – SETSCREW REMOVED FROM EOT

Take the knife and gently slide it in the tool.
Not OK

Not OK

OK

FIG 1-31
1-31 KNIFE IN EOT

Look in the threaded hole and check if the knife is completely pushed down. Then secure the
knife with the setscrew.
ATTENTION: Fasten the setscrew carefully. Make sure it fastens the knife. Only if
the knife is inserted deeply enough, secure the setscrew.
If the setscrew is fastened without a knife, then the knife holder will be damaged
and it will be impossible to put in a knife correctly. Never fasten the setscrew
when no knife is inserted. It is advised to replace the setscrew from time to time.
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1.7.5 Creasing tools for the tangential module

FIG 1-32
1-32 CREASING TOOLS

The creasing tools are available in different sizes and shapes to easily create folds into
cardstock, cardboard, corrugated cardboard and plastics for boxes or displays.
Basically, creasing wheels with a pronounced rim are ideal for the processing of ‘filled
material’. The ones with the more rounded shapes are ideal for the processing of materials,
which have corrugated or honeycombed centers.
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1.7.6 V-Cut tools for the tangential module
1.7.6.1 Types of V-Cut tools
The V-Cut tools are basically static knives that are placed under an angle. By cutting in two
directions, V-groves will be cut out. This makes it possible to bend/fold thicker materials.
This tool is particularly well suited for honeycomb boards, soft foam boards, sandwich
boards and corrugated cardboards. Depending on the folding angle, different V-shapes are
required. There are different angles.

FIG 1-33
1-33 V-CUT TOOLS

1.7.6.2 Installing knives in the V-Cut tools
There is a special fixture delivered with the V-Cut tools to be able to change the knives
quickly. If this fixture is used for installing the knife, fewer calibrations need to be done
when the knife is changed. First remove the knife clamp. Put the fixture on the tool. Put the
knife in its place (make sure the knife tip just touches the fixture). Put the knife clamp back
and secure the two screws firmly.

FIG 1-34
1-34 INSTALLING KNIVES IN THE V-CUT TOOLS
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1.7.7 Pneumatic Oscillating Tool
1.7.7.1 General
The Pneumatic Oscillating Tool (POT), powered by compressed air, moves the knife up and
down with a stroke of maximum 8 mm and a frequency of maximum 150Hz. It can cut
material up to 25 mm thick. The robust construction of the tool makes it suitable to cut thick
and or though boards like honeycomb board, corrugated cardboard and foam boards. Also
some soft foams and rubbers can be cut with adjusted speeds. The POT fits into the
tangential module. Use the adaptor with the two tubes for connection to the central camera
unit of the F1612. Use the adaptor with the single thicker tube for connecting to the left side
of the carriage of the larger tables. Use the connection marked with L or POT. The tool can
be placed in any of the three slots but only one POT can be installed at once.

FIG 1-35
1-35 POT

1: pneumatic oscillator; 2: pneumatic connections; 3: knife; 4: gliding disk

1.7.7.2 Replacing a knife in the POT
Remove the gliding disk. Locate the setscrew that holds the knife. Unscrew it. Take the knife
and gently take it out. Take the new knife and slide it in the tool.

FIG 1-36
1-36 KNIFE POT

Check if the knife is completely pushed down. Then secure the knife with the setscrew.
ATTENTION: Fasten the setscrew carefully. Make sure it fastens the knife. Only if
the knife is inserted deeply enough, secure the setscrew.
If the setscrew is fastened without a knife, the knife holder will be damaged and it
will be impossible to put in a knife correctly. Never fasten the setscrew when no
knife is inserted. It is advised to replace the setscrew from time to time.
The gliding disk can only be put on the tool when the tool is mounted in the tangential
module. The gliding disk is keyed so it clicks in its position.
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Setting up modules / tools

2.1 Introduction
2.1.1 General remarks on the calibration of the tools
There are four kinds of modules: the drag module, the tangential module, the miller module
and the rotary module. The tangential module automatically recognizes which tool is mounted.
The router module is specially made for the miller only. The rotary module has no tools; the
knife is mounted in the module itself. The drag module cannot automatically recognize
whether a pen or drag knife is mounted. The user will have to define this while setting the
pen/knife parameters.
There are two sets of parameters for the tools/knives.
The first set of parameters is more related to the module and the up and down position.
Down position
Up Position
Velocity
Lift –up velocity
Lowering velocity

Maximum down position the knife/tool can reach, is usually the
position at which the job is cut.
Height of the knife/tool when it is moving but not cutting during a
job.
Speed used for running the internal test of Axis Control.
Speed at which the module raises.
Speed at which the module goes down.

Flute direction

Special parameter only used for creasing wheels in combination
with corrugated cardboard (section 0).

Down position offset

Special parameter only used for creasing wheels in combination
with corrugated cardboard (section 0).

Down delay

Special parameter for the Router module. The amount of time the
router waits before it starts routing after it reaches the down
position.

The second set of parameters is more related to the knife/tool itself (a routing bit has no
second set of parameters).
Origin

Correction factor for the direction in which the knife cuts. Wrong
setting results in an irregular bend in the start of a cutting line.

Lateral

Correction factor for the offset for the knife along the cutting path.
Wrong setting results in misalignment of cutting lines in the opposite
direction.

Longitudinal

Correction factor for the start point of the cutting line. Wrong setting
results in unclosed corners or unwanted overcut.

Blade compensation
Frequency RM

Setting up Tools

Correction factor for cutting materials. Wrong settings result in bad
small curves.
Speed at which the rotary knives rotates.
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Speed at which the Electric oscillating tool goes up and down.

The flatbed has no control panel or screen. Everything is done with the program Axis Control.
Sometimes in combination with the remote control. The remote connects to the computer with
Bluetooth. Please refer to section 1.5.6 for software installation for setting up the remote.
Speed settings need to be set by hand in Axis Control. The velocity setting is only used for
internal tests. The speed at which a job is processed is set in SummaFlex Pro (see section
1.1.1)
NOTE: When calibrating a tool/module, use the same speed than the one that will
be used later. Speed settings can influence certain parameters.
Certain calibrations will need to be done after installing a tool. Those parameters have a
double function. Setting them correctly makes sure that the cutting quality is optimized and
also makes sure that the print and cut jobs are more precise.
These calibrations can be done automatically (with ADC – see section 2.4) or manually (see
section 2.5)
NOTE: It is absolutely recommended to label the modules. Also, always put them
in the same position on the carriage. The tool parameters are automatically saved
when a tool is used. However, tool parameters are also partly module dependent.
If the same module is always mounted at the same place, the tool parameter
dependency of the module will be nullified.
If a tool is calibrated at a certain place with a certain module, those parameters are saved in

the machine the moment this tool is used for a job or if
is clicked. If the tool is
remounted in the module at a later stage, the machine automatically sets the tool parameters
to the previous values.

Setting up Tools

2-2

F Series

User’s Manual

2.1.2 Automatic Depth Control
The optional Automated Depth Control (ADC) simplifies tool, knife or bit calibrations
significantly. The ADC measures the tip of the knife or bit accurately and sets the down
position of the tool to the level of the table (see section 2.4).
Also other knife settings can be measured (tangential parameters) with the ADC. This ensures
the best settings can always be used to get the most optimal cut quality.
The ADC has a sensor unit in the right-hand side cover to measure the tools in slot 2 & 3 (the
two slots to the right side of the camera module). A second optional sensor unit in the lefthand side can measure the tools in slot 1.

FIG 2-1
2-1 ADC RIGHT SIDE

When starting up the table or after a tool change, the down position of each installed knife is
measured to detect changes and avoid operator errors if the ADC is installed.
NOTE: If the ADC is not installed, then the down position will have to be tested
after each tool/knife change before the tool will become active.
NOTE: Section 2.5.2 of this chapter explains a standard tool/knife change once
the machine is fully operational (all tools have been calibrated completely) when
the optional ADC is not installed.
Only the drag knife cannot be calibrated with the ADC, the rest of the tools/knives/bits can be
calibrated with the ADC.
The calibration of the knives/tools is different for tables with an ADC then for tables without
an ADC. So this paragraph contains two large sections, one with the calibration with the use
of the ADC and one for the calibration without the ADC.
If the table has only an ADC at the right side, then the second section also applies for the
tools/modules in slot 1.
There are also a couple of sections that apply for both the tables with an ADC and without.
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Tools in the accessory box
In the accessory box, delivered with the cutting table, there are some tools for installing the
modules/tools on the flatbed cutter. Other tools may be delivered together with certain tools
or options.
Hex screwdriver 4 mm: this is used for loosening the screw that holds the module on the
carriage. It can also be used for lifting the module when it is removed.

FIG 2-2
2-2 HEX SCREWDRIVER 4 MM

Hex screwdriver 2.5 mm: this is used for removing the gliding disk (on both Cutout Tool and
Electronic Oscillating Knife) and for changing knives on the cutout tool holders.

FIG 2-3
2-3 HEX SCREWDRIVER 2.5 MM

Wrench #17 mm: This wrench is used to loosen the collet of the miller (optional) in order to
replace the router bits. This wrench is delivered together with the router option.

FIG 2-4
2-4 WRENCH #17 MM

Wrench #10 mm: This wrench is used to loosen the nut of the rotary module (optional) in
order to replace the rotary knives. This wrench is delivered together with the rotary module
option.

FIG 2-5
2-5 WRENCH #10 MM

Setting up Tools

2-4

F Series

User’s Manual

Tool wrench: this tool can be used when the tool has been tightened too much in the module.
It is not recommended to use this tool to mount other than oscillating tools in the module.

FIG 2-6
2-6 TOOL WRENCH

ATTENTION: If the wrench is used to mount the oscillating tools in the module,
do not tighten more than ¼ of a turn ‘hand tight’ without the wrench.

ATTENTION: Always use the tool this way the direction in
which is turned, is according to the arrow. Otherwise the nut
on the tool will be irreversibly damaged.
Hex key 1.5 mm: This key is used to replace the knives on an EOT. Each knife for the EOT is
delivered with such a hex key.

FIG 2-7
2-7 HEX KEY 1.5 MM

Hex key 2 mm: This key is used to replace the knives on a POT. Each knife for the POT is
delivered with such a hex key.

FIG 2-8
2-8 HEX KEY 2 MM
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2.2 Installing / Removing a module
WARNING: For safety reasons, always make sure no tool is installed in the
module. Only install a module when the flatbed is switched off or after clicking
‘Change Tool’ in Axis Control.

FIG 2-9
2-9 INSTALLING/REMOVING A MODULE

2.2.1.1 Installing a module
In order to install a module, line up the 5 highlighted areas and slide the module down. The
module glides into the carriage in a dovetail guiding. Do not use excessive force, otherwise the
connector can be damaged. Recheck the alignment when in doubt. The module must be
pushed down approximately 15 mm (0,6”) and is secured with one screw at the right side.
Before securing the module check if the connector of the module is completely seated in the
connector of the carriage.

FIG 2-10
2-10 INSTALLING/REMOVING A MODULE
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2.2.1.2 Removing a module
To remove a module, loosen the screw at the right side of the module for about 1 turn
counterclockwise with the hex screwdriver. Put this screwdriver in the hole under the module
at the right side. Now gently lift the module with the screwdriver 3 to 4 mm (0.12 to 0,16”).
Guide the module manually for an extra 10 mm (0,4”) and remove it from the carriage. The
drag module does not have such a hole to lift the module, so just lift it manually.

NOTE: It is recommended to remove any unused modules. Leaving unused modules
on the carriage can lead to poorer cutting quality.

2.2.1.3 Rotary module
Position 2 and 3 on the carriage need to be free before the rotary module can be installed. The
module has to be installed in position 3, but occupies position 2 and 3. Position 1 can still be
used should an additional tool be necessary. The rotary module needs to be connected with an
electric cable for driving the motor and a pneumatic hose for cleaning the knife. The electric
cable has a slotted connector that is marked with a triangle (see detail figure). Orientate the
cable this way the triangle faces the top before connecting the cable. Make sure the hose with
the correct pneumatic connection is attached to the rotary module (see figure 2-10 and 2-11
below) and connect the other end to the carriage. On the larger tables use the connection
marked RM or R for the pneumatic connection.

FIG 2-11
2-11 ELECTRIC CONNECTOR

FIG 2-12
2-12 CONNECTOR FOR LARGER
TABLES

FIG 2-13
2-13 CONNECTOR FOR F1612

2.2.1.4 Router module
Position 2 and 3 on the carriage need to be free before a miller module can be installed. The
module has to be installed in position 3, but occupies position 2 and 3. Position 1 can still be
used should an additional tool be necessary. The pole, which leads the tube that runs to the
vacuum cleaner, holds a plate with a dovetail guiding similar to the guiding on the carriage.
This can be used to store the miller module when it is not in use. There is no screw available to
secure the miller module.
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2.3 Installing Tools and knives.
2.3.1 Installing Kiss Cutting Tool

1. In the Axis Control window click
. If the tangential module is not mounted on the
flatbed yet, install it as explained in section 2.2.
2. Check if the correct adjust screw is mounted (there are three ranges: up to 120 gram; up
to 650 gram and up to 2000 gram). Mount the Kiss Cutting Tool in the tangential module.
Align the pin in the slot as shown in the figure below and hold the internal shaft of the
tangential module in its place by pressing the rotation lock plate (black plastic on the front
of the module). Screw it all the way down.
ATTENTION: Do not overtighten the tool in the tangential module.

FIG 2-14
2-14 INSERT THE KISS CUTTING TOOL

3. Press

.
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2.3.2 Installing Cutout Tool
WARNING: If the heavy duty knife is not in use, it has to be removed from the machine
and capped with a safety cap. Do this also when shutting down the machine in the
evening.

1. In the Axis Control window click
. If the tangential module is not mounted on the
flatbed yet, install it as explained in section 2.2.
2. Align the pin in the slot as shown in the figure below and hold the internal shaft of the
tangential module in its place by pressing the rotation lock plate (black plastic in front of
module). Screw it all the way down.

ATTENTION: Do not overtighten the tool in the tangential module.

FIG 2-15
2-15 INSERT THE CUTOUT TOOL

3. Press

.
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2.3.3 Installing EOT
WARNING: If the knife is not in use and it is not completely protected by the gliding
disk, it has to be removed from the machine and capped with a safety cap. Do the
same when shutting down the machine in the evening.
1. In the Axis Control window click
. If the tangential module is not mounted on the
flatbed yet, install it as explained in section 2.2.
2. Align the pin in the slot as shown in the detail below. Make sure the EOT is slightly turned
to the right, so that the position plate does not touch the positioning shaft. Hold the
internal shaft of the tangential module in its place by pressing the rotation lock plate (black
plastic in front of the module). Turn the screw all the way down.
ATTENTION: Do not overtighten the tool in the tangential module.

FIG 2-16
2-16 MOUNTING THE EOT

3. Once the tool is securely screwed, turn it this way the position plate clicks into the
positioning shaft. Also connect the extra cable. There are two connections on the camera
unit. If the module is mounted left to the camera unit, then use the left one, otherwise use
the right one. Make sure to align the slotted connector with the little triangle facing
upwards before screwing down the connector securely.

4. Press

.
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2.3.4 Installing the Creasing Wheel

1. In the Axis Control window click
. If the tangential module is not mounted on the
flatbed yet, install as explained in section 2.2.
2. Align the pin in the slot as shown in the figure below and hold the internal shaft of the
tangential module in its place by pressing the rotation lock plate (black plastic in front of
the module). Screw it all the way down.
ATTENTION: Do not overtighten the tool in the tangential module.

FIG 2-17
2-17 INSERT THE CREASING WHEEL

3. Press

.
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2.3.5 Installing the POT
WARNING: Never leave the POT on the machine without the gliding disk. Mount the
gliding piece immediately after the POT is mounted in the tangential module.
1. In the Axis Control window click
. If the tangential module is not mounted on the
flatbed yet, install as explained in section 2.2.
2. Align the pin in the slot as shown in the detail below. Hold the internal shaft of the
tangential module on its place by pressing on the rotation lock plate (black plastic in front
of the module). Turn the screw all the way down.
ATTENTION: Do not overtighten the tool in the tangential module (see usage of the
tool wrench).

FIG 2-18
2-18 MOUNTING THE POT

3. Once the tool is securely screwed, put the gliding disk on the tool. Press the gliding disk
together and slide it under the tool. Then mount it on the tool. The tool is slotted and a pin
is situated inside the gliding disk. Make sure the gliding disk is seated correctly (cannot be
turned around if it is seated correctly). For the F1612, connect the two air hoses to the
camera unit. For the larger tables use the single tube with the large connector and insert
the air hose to the connection marked with “POT” or” L”
4. Click

.
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2.3.6 Installing the V-Cut tool
1. The V-Cut tool consists out of two main parts. These parts have to be taken apart before
the tool can be mounted into the tangential module.

FIG 2-19
2-19 V-CUT TOOL IN TWO PARTS

2. In the Axis Control window click
. If the tangential module is not mounted on the
flatbed yet, install it as explained in section 2.2.
3. Align the pin in the slot as shown in the figure below and hold the internal shaft of the
tangential module in its place by pressing the rotation lock plate (black plastic in front of
the module). Screw it all the way down.
ATTENTION: Do not overtighten the tool in the tangential module.

FIG 2-20
2-20 INSTALL THE UPPER PART OF THE V-CUT TOOL

4. Screw the fitting aid in the bottom part of the V-Cut tool and align it under the tangential
module in the top part of the V-Cut tool. Turn the big knob until it fits and then secure it
firmly with the little knob on top.

FIG 2-21
2-21 INSTALL THE BOTTOM PART OF THE V-CUT TOOL

Setting up Tools

2-13

F Series

User’s Manual

2.3.7 Installing the Rotary Knife
The rotary module has no tool holder. The knives need to be mounted directly in the module.
This means that the complete module has to be taken from the machine to change the knife.

1. In the Axis Control window click
module.

. Loosen the screw at the side to remove the

2. Press the rotation lock pin to hold the knife. Consequently, loosen and remove the nut with
a wrench # 10 mm.

FIG 2-22
2-22 CHANGE KNIFE ROTARY MODULE

3. Remove the knife from underneath the module. To put a new knife, slide it from underneath
into the module and put the knife over the bearing. Then, put the nut back and secure it
with the wrench, while holding the rotation lock pin down.

FIG 2-23
2-23 PLACE NEW KNIFE IN ROTARY MODULE

4. Put the module back on the carriage, as described in section 2.2.1.3. and click
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2.3.8 Installing a router bit on Kress miller
Below is a picture of the milling motor. Part 1 and part 2 should not be dis-assembled.

1.
2.
3.
4.
5.
6.

Locknut
Collet chuck
Spindle
Locking pushbutton
ON/OFF switch
Speed turning
wheel

FIG 2-24
2-24 MILLING MOTOR

Router bits with a shank diameter of 3, 4, 6 and 8 mm can be mounted in the miller. To change
a router bit, follow the below procedure.

1. Click

.

2. Wait for the machine to stop .

FIG 2-25
2-25 TAKING THE MILLER OUT OF THE ROUTER MODULE

3. Remove the miller from the router module.
4. Press on the locking pushbutton to hold de spindle on its place. Then loosen the locknut
with a wrench # 17 mm a couple of turns. If the router bit, that will be mounted, has the
same shank diameter, remove the bit.
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5. Clean the collet with compressed air. Put in a new router bit. If the router bit has another
shaft diameter, remove the collet completely and put in the correct one.

FIG 2-26
2-26 ROUTER BIT POSITION ON THE COLLET

ATTENTION: The ideal depth of a routing bit is when the distance between the end of
the spiral, that guides the chips away, and the collet is 3 mm. If the routing bit is too
long, make sure not to push the bit all the way down. This way, the end of the router
bit stays free inside.
ATTENTION: Never tighten the nut when there is no router bit inserted. This might
damage the collet. However, when tightening it with a bit inside, make sure it is tight.
ATTENTION: The distance between the tip of the routing bit and the collet has to be
at least 15 mm (19 mm for firmware revisions lower than 024).
ATTENTION: Do not use the same bit for different types of material. Each material
wears down the bit in a different way. It is possible the wear of one type of material
does not affect the cutting quality in that type of material but does affect the cutting
quality in another type of material.
6. Put the miller back in the router module (mind the orientation. The red part must be facing
the module) and secure it with the handle.
7. Turn on the extractor height control handle, so that the extractor is set halfway (red plate
is situated under the middle of the hole). For very thick material, the extractor will have to
be set a bit higher. This setting is provisionally, so that the tip of the router bit is visible
while up and down positions are set.

FIG 2-27
2-27 START POSITION EXTRACTOR BRUSH
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2.3.9 Installing a router bit on HF miller
Below is a picture of the HF miller motor.

1. HF motor
2. Compressed air
supply for bit change
3. Compressed air
supply for air lock
4. Power cable
5. Collet ∅ 6mm
6. Routing bit
7. Dummy collet used
during transport
FIG 2-28
2-28 HF MILLING MOTOR

The miller is delivered with a collet of 6 mm. For transportation a dummy collet is used. This
has to be removed on first use.
ATTENTION: Upon first use the dummy collet has to be replaced with a collet and
routing bit in it. See maintenance section 5.1.2.9
ATTENTION: Upon first use the miller has to run-in this is a sequence that takes
about 30 minutes. This run-in procedure has to be done each time the miller has
functioned less than 20 minutes in 3 weeks (an internal counter in Axis Control helps
the user to remember) see maintenance section 5.1.2.9

1. Click

, then click on the picture of the router module and click

2. The knob on the brush has a ‘locked’ position. This position is used when changing a router
bit. Push the brush upwards and turn the knob until it snaps into its locked position. The
left figure shows the position during operation; the right figure shows the knob and brush
in its position during a bit change.
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FIG 2-29
2-29 BRUSH POSITION FOR BIT CHANGE

3. Hold the bit and flip the switch on the back of the router module. The bit will come loose.

FIG 2-30
2-30 SWITCH FOR BIT CHANGE

4. Take the new bit and put it in the miller. Put the routing bit as deep as possible; however
make sure the flute end stays free so the chip removal path is not obstructed.

FIG 2-31
2-31 SWITCH FOR BIT CHANGE

ATTENTION: Use only routing bits with a total length between 50 mm and 58 mm. It
is not advised to use unbalanced routing bits.
5. Flip the switch on the back of the router again. The router will now clamp the routing bit.

Click

to finish the procedure.

ATTENTION: Never clamp the collet without a routing bit in it.
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2.4 Tool/ knife calibration with ADC
The ADC is integrated in the side covers of the table. Once installed and calibrated it is
permanently available. The ADC works by interruption of a light beam. This is harmless for the
tools. The sensor unit in the right-hand side cover is used to measure the tools in slot 2 & 3.
The sensor in the left-hand side can measure the tools in slot 1.

NOTE: The drag module, which moves low over the table, can’t pass over the ADC
sensor units. The drag module must be used in slot 1. If the left ADC sensor is
installed, the working area will be reduced when using the drag module in order to
avoid that the module hits the ADC sensor unit. The front margin is moved 80 mm to
the rear, so module 2 and module 3 can use the full table width.

2.4.1 General calibrations with the ADC
The down position of ADC controlled tools is set automatically each time the machine is
switched on or when a tool is changed. The down position is a value, relative to the table
height.
WARNING: The measurement of the POT knives isn’t as accurate as on the other
tools. Extra manual fine tuning may be required to have the most optimal down
position. It is important to have stable pressure on the compressed air supply.
Variations in air pressure result in depth variations!
The up position should be set manually. The up position is the relative distance from the down
position. Make sure the up position measures significantly more than your material thickness.

To set the up position, first click
. If Axis Control is not automatically selecting the
tool, whose up position needs to be checked/set, click the picture of the corresponding
module. Click ‘Up position’ in Axis Control or press ‘Up’ on the remote. Press the down arrow
(computer or remote) until the tip of the knife is about 4 – 5 mm above the material, then
press apply (computer) or A (remote). It is not necessary that the material is on the table, the
up position can also be set if the thickness of the material is known. Just press the up/down
arrow until the value is 4 – 5 mm higher than the thickness of the material.

FIG 2-32
2-32 SETTING THE UP POSITION WITH THE ADC

The origin, lateral and longitudinal parameters can also be set by the ADC. Those parameters
are material independent and should only be set during first installation of a tool or when
there are quality issues.

In order to automatically calibrate those parameters, first click
. If Axis Control is not
automatically selecting the tool, whose tool calibration needs to be checked/set, click the
picture of the corresponding module. Then click
parameters and store the values.
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Different materials (or speeds) may need different down positions. The down position can be
adjusted manually and indicates the difference compared to the calibrated table height. If the
tool is measured again it will maintain the manually calibrated shift to make sure the cutting
result is the same as before.

NOTE: If a protection mat is used, the down position should be around 2.5 mm. With
the routing tool, the routing mat should always be used. The machine takes this into
account, so the down position values should also be around 0 mm.
WARNING: The best way to prepare for a depth test is to put the media a couple of
centimeter to the left of the machine origin. Then set the origin a centimeter or two
inside the media.

To adjust the cutting depth, click
. If Axis Control is not automatically selecting the
tool, who’s down position needs to be checked/set, click the picture of the corresponding
module. Click ‘Down position’ in Axis Control or press ‘Down’ on the remote. Then move the
tool, so that the knife tip is set to the right of the loaded media. Then click
or test on the
remote. Check the cutting depth after the test has been done. If the cutting depth needs to be
adjusted, then click on the down arrow. Wait for the tool to come back to its starting point.
Then adjust the depth by clicking on the up arrow or down arrow and redo a test to check if it
is OK or not. When the cutting test is OK, click

or

on the remote.

FIG 2-33
2-33 CHECKING THE CUTTING DEPTH

Another special parameter is the blade compensation parameter. In order to obtain a smooth
curve, the knife orientation needs to be set in the direction of the cutting line. When thick
media is cut, the knife orientation will only be correct at the bottom of the material. At the
top of the material the knife orientation will not be set in the direction of the cutting line. In
order to compensate this, the parameter blade compensation is used. This parameter
anticipates the knife orientation (distance is set with the parameter), so the top cut and the
bottom cut are both closest to the ideal cutting line. However, this parameter can never
compensate a 100% due to the physical limitations of the knife and cutting process.
Therefore, it is also recommended to transform small curves in the design into corners or
polygons (depending on the design itself).

FIG 2-34
2-34 KNIFE ORIENTATION IN THICK MATERIAL
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To set the parameter, do following. Click ‘Blade compensation’ (it becomes blue highlighted).
Then click ‘Test’. The cutter will cut out a small square with rounded corners. Fill in a value
and do the test. A good starting value is the length of the overcut, visible in the knife depth
test.

FIG 2-35
2-35 TEST PATTERN CUTOUT TOOL – BLADE COMPENSATION PARAMETER

The picture above shows two possible results of the blade compensation test. In the left
pattern the blade compensation value is too low. In the right pattern it is set correctly. If the
blade compensation is set too high, the result will be more deformed and distorted. Therefore,
it is best to execute the test from a value, which is too low in relation to the correct value.

NOTE: Blade compensation values of the POT are limited due to the geometry of the
knives.
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2.4.2 Practical tool changes with the ADC
When the machine has been set up, then a tool change is very easy. When frequently used
materials are processed, just change the tool and wait for the ADC to set the down position.
Then check/set the up position to be sure the tool will not hit the material while it is moving in
the up position.
However, there are some tool specific actions, which are necessary during first installations or
when the parameters need to be altered slightly for different sorts of material. These steps are
explained in the sections below.

2.4.2.1 Calibrating the Kiss Cutting Knife with the ADC
The kiss cut tool is a special case. The cutting depth is mechanically controlled by the
pressure and the amount that the knife protrudes between the two bearings of the nose piece.
When the down position is set for the first time, it is best to make sure the knife does not
protrude. The ADC will then set the down position, using the bottom of the two bearings in the
nose piece. The up position will then be set automatically 4 mm (0.16”) higher. This is enough
because the maximum cutting depth of the kiss cutting tool is 1.2 mm (50 mils).
Procedure to set the cutting depth for the kiss cutting knife:
Put the knife in the kiss cutting tool and make sure the knife does not protrude (it is best to
set it flush, the cutting depth can then be set quickly). Do this by touching the bearings or by
checking on a piece of paper.
Then install the kiss cutting knife and let the ADC measure the down position.
Check if the origin of the loaded media is still set correctly. If not, adjust it and click
. If
Axis Control is not selecting the correct module to calibrate automatically, correct it by
clicking the picture of the module.
Turn the knife holder to set the cutting depth. If the start position was flush with the bearing,
then know that one quarter of a turn is setting the cutting depth about 0.12 mm (5 mils)
deeper. Press
to do a knife depth test. Check the result. Change the knife depth, if
necessary, or if the pressure is not high enough/too high. Adjust by turning the adjust screw.
Finally calibrate the knife parameters. Do this by clicking the
button. Axis Control will
pause just before the tests and prompt the user to take off the nose piece.

2.4.2.2 Calibrating the Cut Out Knives with the ADC
The following applies for the Heavy Duty cutout tool, the single edge cutout tool and the
double edge cutout tool.
The general calibration procedure with the ADC applies for these three tools. Install the tool,
let the ADC set the down position. Check the up position. And then do the extra calibration of
the knife parameters.
When the tool is installed for the first time, it is advised to do a knife depth test and adjust, if
necessary. The knife depth can differ a little bit from media to media. The softer the media that
needs to be cut, the deeper the knife depth needs to be set. Softer backing/media bends a
little bit just before the knife pierces through the media.
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2.4.2.3 Calibrating the EOT with the ADC
One of the typical properties of an oscillating tool is that the cutting depth depends on the
used cutting speed. The faster the cutting speed, the deeper the knife depth needs to be set.
To calibrate the EOT, perform the standard calibration with the ADC. Install the tool, let the
ADC set the down position. Check the up position. Then do the extra calibration of the knife
parameters.
Select the down velocity that will be used in the actual job and set the oscillating frequency.
Then check the cutting depth as described in section 2.4.1.

2.4.2.4 Calibrating the Creasing Wheels with the ADC
The ADC can calibrate the depth and the other parameters of the creasing wheel as described
in the general calibration. However, working with creasing wheels requires some extra
settings.
To calibrate a creasing wheel, do the standard calibration with the ADC. Install the tool, let the
ADC set the down position. Check the up position. Then do the extra calibration for the origin,
latitude and longitude.
After this the creasing depth needs to be checked. There are two main types of materials to
crease. Corrugated media and none corrugated media.
The extra parameters flute direction and down position offset are only used for corrugated
media. For none corrugated media set the flute direction to None and set the down position
offset to 0.
To set the down position click ‘Down position’ in Axis Control or press ‘Down’ on the remote.
Then press the down arrow (computer or remote) until the creasing wheel pushes in the
material. Press Test. The flatbed makes a pattern. Check if the creasing wheel is set deep
enough. If not, adjust the down position a bit more. The pattern consists out of an array of
horizontal and vertical lines.

FIG 2-36
2-36 SETTING OF CREASING DEPTH PARAMETERS

If the media is corrugated, then the creasing depth will be too much in one direction (flute
direction). In this case set the flute direction correctly and set an offset for this direction.
Then do the depth test again. Adjust the down position offset, if necessary.

1.Flute direction
2. Top liner (outside)
3. Bottom liner (inside)

FIG 2-37
2-37 FLUTE DIRECTION CORRUGATED CARDBOARD
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2.4.2.5 Calibrating the POT with the ADC
As mentioned earlier the down position of the POT tool is not as accurate as with the other
tools. The reason is threefold. First of all there is the specific nature of a pneumatic tool.
Secondly, this tool needs to cut into a very wide range of media harnesses, from light foam to
sandwich boards with PVC top and bottom layers. Finally, the typical properties of an
oscillating tool interfere, as well: the speed influences the cutting depth.
The calibration of this tool is the same as described in the section of the general calibration of
a tool with the ADC. However, checking the knife depth needs be done during each material
change (even if the material is the same, but differs in thickness).

2.4.2.6 Calibrating the V-Cut knives with the ADC
The down position that is set by the ADC is 0.5 mm higher than the table surface for the V-Cut
knife. This is the case because the V-Cut knife never cuts completely through the material. The
below figure explains how the ADC calibrates the knife (top figure) and how the knife should
eventually be calibrated (bottom figure). This cannot be done automatically because this
calibration is media dependent. However, once calibrated, the adjustments are kept in the
memory, which means that there is no need for extra adjustments if the same media is used
and the knife is re-installed on the machine.

1. Media cut out with V-Cut
2. Media
3. Conveyor belt

FIG 2-38
2-38 CORRECT V-CUT

In order to calibrate a V-Cut knife, perform the standard calibration with the ADC. Install the
tool, let the ADC set the down position. Check the up position. Then do the extra calibration
for the origin, latitude and longitude. The best way to check the V-Cut parameters is by
cutting a square with an oscillating knife and by cutting one V-Cut line in the middle of the
square from left to right. Then remove the square from the media, bend it and check the angle
and gap.
WARNING: It is mandatory to move the knife to the right of the media before doing a
depth test. If this is not done, then the knife tip will be destroyed if the knife depth is
adjusted.
The knife depth needs to be adjusted, so the knife scratches scarcely in the bottom liner and
in case the cut out part is not completely loose after the cut. Usually the angle of the bend
improves if the lateral parameter is lowered by 20 or 30.
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2.4.2.7 Calibrating the Rotary knife with the ADC
The ADC can calibrate the depth and the other parameters of the rotary knife as described in
the general calibration. It can also check the up position.
The rotary knife is ideal to cut fabrics. Different fabrics contain different fibers, so the knife
depth might need to be adjusted slightly.
When a new fabric is tested, first perform the automatic calibration. Then set the rotating
speed and perform a depth test in order to check if the knife depth needs to be adjusted.

2.4.2.8 Calibrating the routing bit with the ADC
The routing bit only has three parameters. The up position, the down position and the down
delay. The down position can be set with the ADC. The up position is best set with the material
on the machine. The height of the brush can then also be adjusted when the up position is set.
The down delay needs to be adjusted to be able to drill holes in relatively soft materials.
The router module has another origin position in reference to the camera/positioning laser
than the tangential module. When the router is used for the first time, then the center of the
router bit needs to be calibrated in reference to the camera.
This calibration is mandatory if the router before the ADC will become active. In order to
calibrate the origin for the router, follow the below procedure.
1. Load the media, install the module and tool.
2. Click
and click the picture of the router. Set the up and down position of the router
manually. (the down position does not have to be exact but just deep enough to drill a
hole). After the origin is set, the depth of the router bit can be set automatically with the
ADC.
3. Click the picture of the camera unit in the window.
4. Click slot 3. The machine will drill a hole in the media with the router.

FIG 2-39
2-39 CALIBRATION DISTANCE ROUTER MODULE - CAMERA

5. You have the choice to calibrate automatically or to set the miller with the arrow keys in the
center above the drilled hole.
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2.5 Tool/ knife calibration without ADC
2.5.1 Calibration of the tools/ knives during first use
All the relevant parameters for a certain knife/tool need to be calibrated the first time the tool
is installed. Once calibrated, all settings are stored internally and a tool change can then be
done quicker, as described in section 2.5.2.

2.5.1.1 Calibration of the Kiss Cutting knife

1. After installation of the tool, click

. Axis Control will give a reminder in order not to

to
forget to calibrate the tool before using it in case it just has been changed. Click
acknowledge. Check if the origin of the loaded media is still set correctly. If not, adjust it
and click
. If Axis Control is not selecting the correct module to calibrate
automatically, correct it by clicking the picture of the module. If the remote is used to
choose the module, press the module several times until the correct one is chosen. The
lights on the remote show which module is currently chosen to calibrate. The left light is
module 1; the light next to that is module 2 and the second last light in the row is
module 3. First the up/down parameters need to be set.

FIG 2-40
2-40 UP/DOWN PARAMETERS KISS CUTTING TOOL

2. Set the same value for the velocity as the one that will be used in the job. Leave the lift
and lowering velocity at 200 mm. The lowering velocity can be set to a lower value if the
material, that needs to be cut, is very tough. Calibrate the down position by clicking ‘Down
position’ in Axis Control or press ‘Down’ on the remote. Press the down arrow (computer
or remote) until the nose piece and knife holder are pushed into the tool holder for about
1 to 2 mm (see picture below).

FIG 2-41
2-41 SETTING THE DOWN PARAMETER KISS CUTTING TOOL
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3. Then press ‘Test’. The flatbed will now cut out two squares. Peel them out and check if the
pressure and knife depth are set correctly. If the knife depth is not correct, adjust by
turning the knife holder (a quarter of a turn changes the knife depth by 0.12 mm). If the
pressure is not high enough, adjust by turning the adjust screw. If the depth is set, press
Apply (computer) or A (remote).

NOTE: Check the imprint the bearings of the nose piece make. If they are clearly
visible it means the pressure is set too high, which will affect the cutting quality.
4. The up parameter is automatically set 4 mm higher. Normally it is not necessary to raise
this value. Should it be necessary, click ‘Up’ (remote) or ‘Up position’ (Axis Control).
Then press the up arrow to adjust. Do not forget to confirm the new setting.
5. Now, the knife parameters need to be set. This can’t be done with the remote. In Axis
Control, click the parameter that needs to be checked or set. Then click ‘Test’. Check the
pattern that was cut out. In Axis Control a window opens with a drawing of the cut out
pattern. In this window click the place where the correct pattern was cut out. It is
possible that the test needs to be done more than once if the setting of the parameter
was not satisfactory.

FIG 2-42
2-42 SETTING OF KNIFE PARAMETERS – KISS CUTTING TOOL

ATTENTION: Failing to set the knife parameters correctly will result in poor cut
quality and shorter life time of the blades.
Setting the origin parameter.
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FIG 2-43
2-43 TEST PATTERN KISS CUTTING TOOL ORIGIN PARAMETER

The fan shaped pattern should have a clear cut line in the middle. The ones at the sides show
burs. Check which pattern comes closest to the correct pattern and then choose this one in
Axis Control. The values in the figure above are not cut out. They are indicative so the user
can adjust the value manually should it show that the correct pattern is probably just in
between two cut out patterns.
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Some thick or hard materials may damage the knife with this test. There is a special origin test
for those kinds of materials. Just hold down the Ctrl key while clicking the test button to start
this test.

180 120 60

0 -60 -120-180

FIG 2-44
2-44 ORIGIN PATTERN TEST FOR THE KISS CUTTING KNIFE

The cutter will cut out a test pattern and a window will pop up in Axis Control. The special
origin test looks like the pattern above. Look for the straightest line between the 7 lines. When
the origin is not correct, then the knife is pushed in the media under an angle (in reference to
the cut direction) and then dragged straight into the cut direction. This means that the
beginning of the line needs to be inspected. The figure above contains values; the cut out
pattern doesn’t. These values are different than the current value. Check for the straightest
line and select the according one in the pop-up window. The extended cut out test goes from
+180 over 0 to -180. The values may differ depending on the firmware revision. However, the
procedure is the same. Just click the most correct line.
Note: With some materials it is necessary
to use a magnifying glass to check the
start of the line. The start will then look
something like the picture on the right.
Setting the lateral parameter.

FIG 2-45
2-45 TEST PATTERN KISS CUTTING TOOL LATERAL PARAMETER

The squares should all be equal in size and be cut out at the same height. Check which pattern
comes closest to the correct pattern and then choose this one in Axis Control. The values in
the figure above are not cut out. They are indicative, so the user can adjust the value
manually should it show the correct pattern is probably just in between two cut out patterns.
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ATTENTION: If it is impossible to set the lateral parameter in order to cut out the
correct pattern, this means that the origin is still not set correctly. If this is the case,
change the origin first before adjusting the lateral parameter again. The combination
origin – lateral parameter can also be checked in the test pattern of the origin test. If
pattern 1 weeds out without it catching in the middle, both the origin and lateral
parameter are set correctly.
Setting the longitudinal parameter.
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FIG 2-46
2-46 TEST PATTERN KISS CUTTING TOOL LONGITUDINAL PARAMETER

The horizontal cut lines should meet. Check which pattern comes closest to the correct
pattern and then choose this one in Axis Control. The values in the figure above are not cut
out. They are indicative so the user can manually adjust the value should it show the correct
pattern is probably just in between two cut out patterns.
Setting the blade compensation parameter.
This parameter is ideal for thicker material that will not be cut with a kiss cutting knife.

2.5.1.2 Calibration of the Cutout knife
WARNING: If the heavy duty knife is not in use, it has to be removed from the machine
and capped with a safety cap. Do this also when shutting down the machine in the
evening.

1. Click

if the tool was just changed. Axis Control will give a reminder in order not to

forget to calibrate the tool before using it. Click

to acknowledge. Check if the origin

. If Axis Control is
of the loaded media is still set correctly, if not, adjust it and click
not selecting the correct module to calibrate automatically, correct it by clicking the
picture of the module. If the remote is used to choose the module, press several times
on the module until the correct one is chosen. The lights on the remote show which
module is currently chosen to calibrate. The left light is module 1; the light next to that is
module 2 and the second last light in the row is module 3. First the up/down parameters
need to be set.
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FIG 2-47
2-47 UP/DOWN PARAMETERS CUTOUT TOOL

2. Set the same value of velocity as the one that will be used in the job. Leave the lift and
lowering velocity at 200 mm. The lowering velocity can be set to a lower value if the
material that needs to be cut is very tough. Calibrate the up position by clicking ‘Up
position’ in Axis Control or press ‘Up’ on the remote. Press the down arrow (computer or
remote) until the tip of the knife is about 4 – 5 mm above the material. Press apply (on
computer) or A (on remote).
3. Calibrate the down position. To calibrate the down position, click ‘Down Position’ in Axis
Control or press ‘Down’ on the remote. It is best to first move the knife next to the media
with the right arrow (on computer or on remote). Otherwise it is not possible to see how
deep the knife is set. Then press the down arrow (computer or remote) until the tip of
the knife just touches the grey mat. A white sheet of paper can be used to see exactly
where it touched the mat. The sheet can be put behind the knife for a visual check or
under the knife to check physically. Then press Test. The flatbed will now cut out two
squares. Check if the knife is set deep enough. If not, adjust the down position a bit
more. Do not forget to first click Apply before another parameter is chosen. Otherwise
the value is not saved.

ATTENTION: Make sure the down position is not set too deep. Otherwise the mat will
wear down fast. Therefore, it is recommended to do following. If the correct down
position is found, set the down position two steps higher and do the test again. If the
knife does not cut deep enough, set the down value again to what it was before. If it
still cuts completely through the material, this means the down position was set too
low and needs to be changed.
4. After this, the knife parameters need to be set. This can’t be done with the remote. Click
the parameter that needs to be checked or set in Axis Control. Then click Test. Check the
pattern that was cut out. A window opens in Axis Control with a drawing of the pattern
that was cut out. In this window, click the place where the correct pattern was cut out.
The test will differ according to the parameter that was chosen (highlighted in blue).

FIG 2-48
2-48 SETTING KNIFE PARAMETERS CUTOUT TOOL
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Setting the origin parameter.
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FIG 2-49
2-49 ORIGIN PATTERN TEST FOR THE CUTOUT KNIFE

The cutter will cut out a test pattern and a window will pop up in Axis Control. The origin test
looks like the pattern above. Look for the straightest line between the 7 lines. When the origin
is not correct, the knife is pushed in the media under an angle (in reference to the cut
direction) and then dragged straight into the cut direction. This means that the beginning of
the line needs to be inspected. The figure above contains values; they are not cut out. These
values are different from the current value. Check for the straightest line and select the
according one in the popup window. The values are indicative, so the user can adjust the value
manually should it show the correct pattern is probably just in between two cut out patterns.
NOTE: With some materials it is necessary
to use a magnifying glass to check the
start of the line. The start will then look
something like the picture on the right.
Setting the lateral parameter.
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FIG 2-50
2-50 LATERAL PATTERN TEST FOR THE CUTOUT KNIFE

The horizontal lines are cut out in two parts. Each line is cut from the middle to the side. If the
lateral parameter is not set correctly, the lines do not meet in the middle but will be shifted.
The figure contains values; the cut-out pattern doesn’t. The values in the picture are different
from the current value. Check for the line where there is no shift in the middle and select the
according one in the popup window. The values are indicative, so the user can adjust the value
manually should it show the correct pattern is probably just in between two cut out patterns.
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Setting the longitudinal parameter.
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FIG 2-51
2-51 LONGITUDINAL PATTERN TEST FOR THE CUTOUT KNIFE

The horizontal cut lines should meet. Check which pattern comes closest to the correct
pattern and then choose this one in Axis Control. The values in the figure above are not cut
out. They are indicative, so the user can adjust the value manually should it show the correct
pattern is probably just in between two cut out patterns.
There is a second long test (shown in the figure below). Just hold down the Ctrl key while
clicking the test button to start this test.
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FIG 2-52
2-52 ORIGIN PATTERN TEST FOR THE KISS CUTTING KNIFE

The cutter will cut out a test pattern and a window will pop up in Axis Control. The special
origin test looks like the pattern above. With the single edge knife and the heavy duty knife,
look for the pattern where the horizontal line starts flushing with the vertical line. With the
double edge knife, look for the pattern where the overcut in the corner is the same on both
lines. The values may differ, depending on the firmware revision. However, the procedure is
the same. Click the most correct pattern.
Setting the blade compensation parameter.
This is only necessary for materials of more than 2 to 3 mm thickness. When thick media is
cut, the knife will bend in the corners. As a result the cut line on top of the media will be
shifted a little bit in reference to the cut line in the bottom of the media. The smaller the
curve, the tougher and the thicker the media and the more this will be visible. To compensate
this, you can use the parameter blade compensation. This parameter anticipates the knife
orientation (distance is set with the parameter), so the top cut and the bottom cut are both
closest to the ideal cutting line. However, this parameter can never compensate a 100% due
to the physical limitations of the knife and cutting process. Therefore, it is also recommended
to transform small curves in the design into corners or polygons (depending on the design
itself). To set the parameter, do following. Click Blade compensation (it becomes blue
highlighted). Then click Test. The cutter will cut out a small square with rounded corners. Fill
in a value and do the test. A good starting value for the heavy duty knife is a bit less than half
of the thickness of the media. For the single edge a good starting value is a bit less than a
quarter of the thickness of the media. This is a trial and error test. Values between 0 and
1mm are not used; they are by default set at 1 mm.
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FIG 2-53
2-53 TEST PATTERN CUTOUT TOOL BLADE COMPENSATION PARAMETER

The picture above shows two possible results of the blade compensation test. In the left
pattern the blade compensation value is too low. In the right pattern it is set correctly. If the
blade compensation is set too high, the result will be more deformed and distorted. Therefore,
it is best that this test is done from a value, which is too low relative to the correct value.
ATTENTION: Failing to set the knife parameters correctly will result in poor cut
quality.

2.5.1.3 Calibration of the EOT

1. Click

if the tool just has been changed. Axis Control will give a reminder in order not

to forget to calibrate the tool before using it. Click

to acknowledge. Check if the origin

. If Axis Control is
of the loaded media is still set correctly. If not, adjust and click
not automatically selecting the correct module to calibrate, correct it by clicking on the
picture of the module. If the remote is used to choose the module, press several times on
the module until the correct one is chosen. The lights on the remote show which module is
currently chosen to calibrate (M1, M2 or M3, counting from the left). First the up/down
parameters need to be set.

FIG 2-54
2-54 UP/DOWN PARAMETERS CUTOUT TOOL

2. Set the same value of velocity as the one that will be used in the job. Leave the lift and
lowering velocity at 200 mm. The velocity can be set to a lower value if the material that
needs to be cut is very tough. Calibrate the Up position by clicking Up position in Axis
Control or press Up on the remote. Press the down arrow (computer or remote) until the
tip of the knife is about 4 – 5 mm above the material. Then press apply (on computer) or A
(on remote).
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3. Calibrate the down position. To calibrate the down position click Down position in Axis
Control or press Down on the remote. It is best to first move the knife next to the media
with the right arrow (computer or remote). Otherwise it is not possible to see how deep the
knife is set. Then press the down arrow (computer or remote) until the tip of the knife just
touches the grey mat. A white sheet can be used to see exactly when it touches the mat.
The sheet can be put behind the knife for a visual check or under the knife to check
physically. Then press Test. The flatbed will now cut out a square. Check if the knife is set
deep enough. If not, adjust the down position a bit more. Do not forget to first click Apply
before another parameter is chosen. Otherwise the value is not saved.

ATTENTION: Make sure the down position is not set too deep. Otherwise the mat will
wear down fast. Therefore it is recommended to do following. If the correct down
position is found, set the down position two steps higher and do the test again. If the
knife does not cut deep enough, set the down value again to the previous one. If it
still cuts completely through the material, this means the down position was set too
low and needs to be changed.

ATTENTION: Make sure the test is done at the same speed at which the job will be
cut. Otherwise it is possible the knife depth will not be set correctly and the cutting
lines will look like a dashed cutting line at the rear side of the material. The
maximum speed for the oscillating tool has been limited to 300 mm/s. Also the knife
frequency needs to be set correctly before the knife depth test is done. It is
recommended to use a standard frequency for the EOT. This will normally lead to
good quality and is less stressful for the tool, so it does not wear down that fast.

ATTENTION: The rest of the calibration is the calibration of the knife parameters.
These calibrations may be too hard on the knives if the material is too thick.
Therefore, it is sometimes recommended to do the knife calibration test (origin,
lateral and longitudinal) with a reduced knife depth. Set the knife depth correctly
afterwards. The recommended knife depth is then usually around 1-3 mm deep in the
material.
4. After this, the knife parameters need to be set. This can’t be done with the remote. In Axis
Control click the parameter that needs to be checked or set. Click Test. Check the pattern
that was cut out. In Axis Control a window opens with a drawing of the pattern that was cut
out. In this window click the place where the correct pattern was cut out. The test will differ
according to the parameter that was chosen (highlighted in blue).

FIG 2-55
2-55 SETTING KNIFE PARAMETERS EOT
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Setting the origin parameter
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FIG 2-56
2-56 ORIGIN PATTERN TEST FOR EOT

The cutter will cut out a test pattern and a window will pop up in Axis Control. The origin test
looks like the pattern above. Look for the straightest line between the 7 lines. When the origin
is not correct, then the knife is pushed in the media under an angle (in reference to the cut
direction) and dragged straight into the cut direction. This means the beginning of the line has
to be inspected. The figure above contains values, the cut out pattern doesn’t. These values
are different from the current value. Check for the straightest line and select the according
one in the popup window. The extended cut out test goes from +180 over 0 to -180. The
values are indicative, which means the user can adjust the value manually, should it be clear
that the correct pattern is probably just in between two cut out patterns.
NOTE: With some materials it is necessary
to use a magnifying glass to check the
start of the line. The start will then look
something like the picture on the right.
Setting the lateral parameter
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FIG 2-57
2-57 LATERAL PATTERN TEST FOR EOT

The horizontal lines are cut out in two parts. Each line is cut from the middle to the side. If the
lateral parameter is not set correctly, the lines do not meet in the middle. They are shifted.
The figure above contains values, the cut out pattern doesn’t. These values in the picture are
different from the current value. Check for the line where there is no shift in the middle and
select the according one in the popup window. The values are indicative, which means the
user can adjust the value manually should it be clear that the correct pattern is probably just
in between two cut out patterns.
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Setting the longitudinal parameter
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FIG 2-58
2-58 LONGITUDINAL PATTERN TEST FOR EOT

The horizontal cutting lines should meet. Check which pattern comes closest to the correct
pattern and then choose this one in Axis Control. The values in the figure above are not cut
out. They are indicative, so the user can adjust the value manually should it be clear that the
correct pattern is probably just in between two cut out patterns.
There is a second long test (shown in the figure below). Just hold down the Ctrl key while
clicking the test button to start this test.
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FIG 2-59
2-59 ORIGIN PATTERN TEST FOR THE KISS CUTTING KNIFE

The cutter will cut out a test pattern and a window will pop up in Axis Control. The special
origin test looks like the pattern above. With the single edge knife and the heavy duty knife,
look for the pattern where the horizontal line starts flushing with the vertical line. With the
double edge knife, look for the pattern where the overcut in the corner is the same on both
lines. The values may differ, depending on the firmware revision. However, the procedure is
the same. Just click the most correct pattern.
Setting the blade compensation parameter
This is only necessary for materials of more than 2 to 3 mm thick. When thick media is cut,
the knife will bend in the corners. As a result the cutting line on top of the media will be
shifted a little bit in reference to the cutting line in the bottom of the media. The smaller the
curve, the tougher and the thicker the media and the more this will be visible. To compensate
this, there is the parameter Blade compensation. This parameter anticipates the knife
orientation (the distance is set with this parameter), so that the top cut and the bottom cut
are both closest to the ideal cutting line. However, this parameter can never compensate a
100 % due to the physical limitations of the knife and cutting process. Therefore, it is also
recommended to transform small curves in the design into corners or polygons (depending
on the design itself). To set the parameter, do the following. Click Blade compensation (it
becomes blue highlighted). Click Test. The cutter will cut out a small square with rounded
corners. Fill in a value and do the test. A good starting value is half the width of the knife.
This is a trial and error test. Values between 0 and 1 mm are not used.
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FIG 2-60
2-60 TEST PATTERN CUTOUT TOOL BLADE COMPENSATION PARAMETER

The picture above shows two possible results of the blade compensation test. In the left
pattern the blade compensation value is too low. In the right pattern it is set correctly. If the
blade compensation is set too high, the result is more deformed and distorted. Therefore, it is
best that this test is done from a value, which is too low, to the correct value.
ATTENTION: Do not use small curves in the design and do not use hard material. This
will cause the knife to break.
ATTENTION: Failing to set the knife parameters correctly will result in poor cut
quality.

2.5.1.4 Calibration of the creasing tool

1. Click

if the tool just has been changed. Axis Control will give a reminder in order not

to forget to calibrate the tool before using it. Click

to acknowledge. Check if the origin

of the loaded media is still set correctly. If not, adjust and click
. If Axis Control is
not automatically selecting the correct module to calibrate, correct this by clicking on the
picture of the module. If the remote is used to choose the module, press several times on
the module until the correct one is chosen. The lights on the remote show which module is
currently chosen to calibrate. The left light is module 1; the light next to that is module 2
and the second last light in the row is module 3.

FIG 2-61
2-61 SETTINGS OF CREASING PARAMETERS

2. Set the same value of velocity as the one that will be used in the job (recommended speed
for creasing tool is 800mm/s or more). Leave the lift and lowering velocity at 200 mm. The
lowering velocity can be set to a lower value if the material, that needs to be creased, is
very tough. Then calibrate the up position by clicking on ‘Up position’ in Axis Control or
press ‘Up’ on the remote. Then press the down arrow (computer or remote) until the tip of
the knife is about 4 – 5 mm above the material. Press ‘Apply’ (on computer) or ‘A’ (on
remote).
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3. Then calibrate the down position. To calibrate the down position click ‘Down position’ in
Axis Control or press ‘Down’ on the remote. Then press the down arrow (computer or
remote) until the creasing wheel pushes in the material. Press Test. The flatbed makes a
pattern. Check if the creasing wheel is set deep enough. If not, adjust the down position a
bit more. Do not forget to first click ‘Apply’ before another parameter is chosen to change.
Otherwise the value is not saved. The pattern consists out of an array of horizontal lines
and vertical lines.
4. Certain materials need a different depth setting in the X and Y axis. This can then be
adjusted through the flute direction parameter in combination with the down position offset
parameter. The extra parameters flute direction and down position offset are only used for
corrugated media. For none corrugated media set Flute direction to None and Down
position offset to 0.
5. To set the down position, click ‘Down position’ in Axis Control or press ‘Down’ on the
remote. Then press the down arrow (computer or remote) until the creasing wheel pushes
in the material. Press Test. The flatbed makes a pattern. Check if the creasing wheel is set
deep enough. If not, adjust the down position a bit more. The pattern consists out of an
array of horizontal lines and vertical lines.

FIG 2-62
2-62 SETTINGS OF CREASING DEPTH PARAMETERS

6. If the media is corrugated, then the creasing depth will be too much in one direction (flute
direction). If so, then set the flute direction correctly and set an offset for this direction.
Then do the depth test again. Adjust the Down position offset, if necessary.

1.Flute direction
2. Top liner (outside)
3. Bottom liner ( inside)

FIG 2-63
2-63 FLUTE DIRECTION CORRUGATED CARDBOARD

7. First set the depth with the down position parameter. Then set the flute direction. Set the
down position offset and do a test. Adjust, if necessary. Only one direction will be corrected
(the direction where the creasing wheel is set too deep).
8. Finally check the lateral parameter (the other tool parameters are not that critical and
usually they do not need to be adjusted).
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2.5.1.5 Calibration of the V-Cut tool

1. Click

if the tool just has been changed. Axis Control will give a reminder in order not

to forget to calibrate the tool before using it. Click

to acknowledge.

ATTENTION: When a V-cut tool is installed, the machine resets the media size and
origin automatically. The maximum area is reduced by 80 mm (40 mm at each
border).
ATTENTION: When de knife depth of a V-cut tool is set, the knife moves straight
down. This means that there can be no material underneath the knife when the down
position is set. So make sure the loaded media (for calibrating) is at least 60 to 70
mm to the left of the origin (origin when cutting without V-Cut tool).

2. Click
. If Axis Control is not selecting the correct module to calibrate automatically,
correct it by clicking on the picture of the module. If the remote is used to choose the
module, press several times on the module until the correct one is chosen. The lights on
the remote show which module is currently chosen to calibrate. The left light is module 1,
the light next to that is module 2 and the second last light in the row is module 3.

FIG 2-64
2-64 UP/DOWN PARAMETERS V-CUT

3. The first parameter to calibrate is the up position. To calibrate the up position click ‘Up
position’ in Axis Control or press ‘Up’ on the remote. Then press the down arrow (computer
or remote) until the knife is about 4 – 5 mm above the material. Press ‘Apply’ (on
computer) or A (on remote).
4. The calibration of the down position is done in several steps. First, the knife parameters
need to be set with reduced knife depth. Afterwards, the knife depth can be set correctly.
The knife depth for setting the origin is a couple of mm, the knife depth for the lateral and
longitudinal setting is set this way the knife just scratches the surface of the material. To
calibrate the down position, click ‘Down position’ in Axis Control or press ‘Down’ on the
remote. Press the down arrow (computer or remote) until the knife pushes a little bit in the
material. Then press ‘Test’. The machine cuts a pattern. If the lateral parameter is already
set correctly, one line in the middle will be cut twice. If the lateral parameter is set
correctly, there will be a little distance between the two lines in the middle.
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FIG 2-65
2-65 TEST PATTERN KNIFE DEPTH TEST V-CUT

5. The knife parameters can’t be set with the remote. In Axis Control click the parameter that
needs to be checked or set. Then click ‘Test’. Check the pattern that was cut out. In Axis
Control a window opens with a drawing of the pattern that was cut out. In this window click
the place where the correct pattern was cut out. The test will differ according to the
parameter that was chosen (highlighted in blue).

FIG 2-66
2-66 SETTING KNIFE PARAMETERS V-CUT

Setting the origin parameter
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FIG 2-67
2-67 ORIGIN PATTERN TEST FOR V-CUT KNIFE

The cutter will cut out a test pattern and a window will pop up in Axis Control. The origin test
looks like the pattern above. Look for the straightest line between the 7 lines. When the origin
is not correct, then the knife is pushed in the media under an angle (in reference to the cut
direction) and then dragged straight into the cut direction. This means the beginning of the
line has to be inspected. The figure above contains values; the cut-out pattern doesn’t. These
values are different from the current value. Check for the straightest line and select the
according one in the popup window. The extended cut out test goes from +180 over 0 to 180. The values are indicative, so the user can adjust the value manually should it show the
correct pattern is probably just in between two cut-out patterns.
Setting the lateral parameter
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FIG 2-68
2-68 LATERAL PATTERN TEST FOR V-CUT KNIFE

Setting up Tools

2-40

F Series

User’s Manual

The horizontal lines are cut out in two parts. Each line is cut from the middle to the side. If the
lateral parameter is not set correctly, the lines do not meet in the middle. They will be
shifted. The figure above contains values; the cut out pattern doesn’t. These values in the
picture are different from the current value. Check for the line without shift in the middle and
select the according one in the popup window. The values are indicative, so the user can
adjust the value manually should it be clear that the correct pattern is probably just in
between two cut-out patterns.
Setting the longitudinal parameter
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FIG 2-69
2-69 LONGITUDINAL PATTERN TEST FOR V-CUT KNIFE

The horizontal cut lines should meet. Check which pattern comes closest to the correct
pattern and then choose this one in Axis Control. The values in the figure above are not cut
out. They are indicative, so the user can adjust the value manually, should it show the correct
pattern is probably just in between two cut-out patterns. Press apply or A on the remote to
leave the knife parameter tests.
6. Finally the down position will have to be set. Click ‘Down Position’ in Axis Control or press
‘Down’ on the remote. First press the right arrow key, so the knife is not situated above the
media any more. If the knife cannot be set next to the media, reload the media to enable
this. Press the down arrow (computer or remote) until the knife depth is approximately
correct (usually a little bit above the table surface). Press Test. The machine cuts a pattern.
Check if the knife depth is set correctly. If this is not the case, adjust it.
ATTENTION: The V-Cut tool is a tool that is not easy to calibrate. The only way to
check if the tool has been calibrated is to perform a V-Cut with the cutting software.
After a test has been cut out, check the V-shaped part that comes out of the material
and check if the bend is correct. Usually the bend gets better if the lateral parameter
is lowered by 20 or 30 and by adjusting the depth also. A similar test is the only way
to check if the parameters are set correctly or not.
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2.5.1.6 Calibration of the POT
1. Axis Control will give a reminder in order not to forget to calibrate the tool before using it.
Click
to acknowledge. Load the media. Make sure there is a bit of space between the
origin (y-axis) of the table and the material. (Use ‘line drawn’ to mark the origin as
described in section 4.1.6).
2. Click
. If Axis Control is not selecting the correct module to calibrate automatically,
correct it by clicking on the picture of the module. If the remote is used to choose the
module, press several times on the module until the correct one is chosen. The lights on
the remote show which module is currently chosen to calibrate (M1, M2 or M3, counting
from the left).
3. The POT tool cannot always be calibrated in the media. It will be cut (e.g. origin cannot be
set in foam materials). The best material for complete calibration is a rigid material of a
couple of mm. On the other hand if the material is too thick, then some tests cannot be
done at full depth.
4. The first parameter to calibrate is the up position. To calibrate the up position, click ‘Up
position’ in Axis Control or press ‘Up’ on the remote. Then press the down arrow (computer
or remote) until the knife just touches the material. Move the knife left - right to check if
the tip of the bit scratches the media. Set the height so it just scratches the media. Look at
the value on screen and memorize it. Now set the value about 4 – 5 mm lower. Then press
‘Apply’ (on computer) or ‘A’ (on remote).
5. To calibrate the down position, click ‘Down position’ in Axis Control or press ‘Down’ on the
remote. If the material is thicker than 4 mm, then set the down position first at a value 3
mm higher than the memorized value from the previous step. The final depth calibration
can then be done after the knife parameters have been set.

ATTENTION: Make sure that the test is done at the same speed at which the job will
be cut. Otherwise it is possible that the knife depth will not be set correctly and that
the cutting lines will look like a dashed cutting line at the rear side of the material.
6. The setting of the knife parameters can’t be done with the remote. Click the parameter that
needs to be checked or set in Axis Control. Then click ‘Test’. Check the pattern that was cut
out. In Axis Control a window opens with a drawing of the pattern that was cut out. Click in
this window on the place where the correct pattern was cut out. The test will differ
according to the parameter that was chosen (highlighted in blue).

FIG 2-70
2-70 SETTING KNIFE PARAMETERS EOT
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Setting the origin parameter
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FIG 2-71
2-71 ORIGIN PATTERN TEST FOR EOT

The cutter will cut out a test pattern and a window will pop up in Axis Control. The origin test
looks like the pattern above. Look for the straightest line between the 7 lines. When the origin
is not correct, then the knife is pushed in the media under an angle (in reference to the cut
direction) and then dragged straight in the cut direction. This means the beginning of the line
needs to be inspected. The figure above contains values; the cut out pattern doesn’t. These
values are different from the current value. Check for the straightest line and select the
according one in the popup window. The extended cut out test goes from +180 over 0 to 180. The values are indicative, so the user can adjust the value manually should it be clear
that the correct pattern is probably just in between two cut out patterns.
NOTE: With some materials it is necessary
to use a magnifying glass to check the
start of the line. The start will then look
something like the picture on the right.
Setting the lateral parameter
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FIG 2-72
2-72 LATERAL PATTERN TEST FOR EOT

The horizontal lines are cut out in two parts. Each line is cut from the middle to the side. If the
lateral parameter is not set correctly, then the lines do not meet in the middle. They will be
shifted. The figure above contains values; the cut out pattern doesn’t. These values in the
picture are different from the current value. Check for the line without shift in the middle and
select the according one in the popup window. The values are indicative, so the user can
adjust the value manually should it be clear that the correct pattern is probably just in
between two cut out patterns.
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Setting the longitudinal parameter
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FIG 2-73
2-73 LONGITUDINAL PATTERN TEST FOR EOT

The horizontal cut lines should meet. Check which pattern comes closest to the correct
pattern and then choose this one in Axis Control. The values in the figure above are not cut
out. They are indicative, so the user can adjust the value manually should it be clear that the
correct pattern is probably just in between two cut out patterns.
Setting the blade compensation parameter
A shortcut will be used for setting the knife compensation parameter after the correct depth
is set.
Now the correct down position can be set. Click ‘Down position’ in Axis Control or press
‘Down’ on the remote. First press the right arrow, so the router bit is between the material and
the Y-axis origin. Then press on the down arrow (computer or remote) until the value is the
value that was memorized during the calibration of the up position plus the thickness of the
media. Press test to cut out a square. Adjust with the up/down arrow, if necessary. And check
again until the desired depth is set (use steps of 0.3 mm).
ATTENTION: The stroke and frequency of the POT depend on the load. This means
that increasing the cutting depth by a certain amount of tenths of a mm can result in
an actual cutting depth that is a bit more than the raised couple of tenths of a mm.
Therefore, it is recommended to use a mat underneath the media if the media allows
it.
There is a second long test (shown in the figure below). Just hold down the Ctrl key while
clicking the test button to start this test.
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FIG 2-74
2-74 ORIGIN PATTERN TEST FOR THE KISS CUTTING KNIFE

The cutter will cut out a test pattern and a window will pop up in Axis Control. The special
origin test looks like the pattern above. With the single edge knife and the heavy duty knife,
look for the pattern where the horizontal line starts flushing with the vertical line. With the
double edge knife, look for the pattern where the overcut in the corner is the same on both
lines. The values may differ, depending on the firmware revision. However, the procedure is
the same. Click the most correct pattern.
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Setting the blade compensation is done as follows: Do the test with different values and then
set it to the value which gave the best result.

FIG 2-75
2-75 TEST PATTERN CUTOUT TOOL BLADE COMPENSATION PARAMETER

The picture above shows two possible results of the blade compensation test. In the left
pattern the blade compensation value is too low. In the right pattern it is set correctly. If the
blade compensation is set too high, then the result is more deformed and distorted.
ATTENTION: Do not use small curves in the design and do not use hard material. This
will cause the knife to break.
ATTENTION: Failing to set the knife parameters correctly will result in poor cut
quality.
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2.5.1.7 Calibration of the rotary module
1. If another module was previously installed in that same place, Axis Control will give a
reminder that you need to check the knife depth first. Click
the case.

to acknowledge if this is

ATTENTION: If the origin is not set correctly, the knife will seriously damage the
conveyor belt.
NOTE: When the module is installed for the first time, or when there is doubt
whether the origin is set correctly or not, do the depth and origin setting on a
piece of paper on a protection mat or in the top half of corrugated cardboard (1 –
3 mm). When the origin is set correctly, do a second knife depth setting on the
material that will actually be used.
2. Check if the origin of the loaded media is still set correctly, if not, adjust it and click
.
If Axis Control is not automatically selecting the rotary module, click the picture of the
rotary module. If the remote is used to choose the module, press several times on the
module until the correct one is chosen. The lights on the remote show which module is
currently chosen to calibrate. The third LED should be lit up. First the up/down parameters
need to be set.

FIG 2-76
2-76 UP/DOWN PARAMETERS ROTARY MODULE

3. Set the same value of velocity as the one that will be used in the job. Leave the lift and
lowering velocity at 200 mm. Calibrate the up position by clicking ‘Up position’ in Axis
Control or press ‘Up’ on the remote. Press the down arrow (computer or remote) until the
tip of the knife is about 4 – 5 mm above the material. Press apply (on computer) or A (on
remote).
4. Calibrate the down position. To calibrate the down position, click ‘Down Position’ in Axis
Control or press ‘Down’ on the remote. It is best to first move the knife next to the media
with the left arrow (computer or remote), otherwise it is not possible to see how deep the
knife is set. Then press the down arrow (computer or remote) until the tip of the knife just
touches the protection mat. A white sheet of paper can be used to see exactly where it
touched the protection mat. If corrugated cardboard is used to set the origin, make sure
the knife does not touch the conveyor. Press Test. The flatbed will now cut out a square.
Check if the knife is set deep enough. If not, adjust the down position a bit more. Do not
forget to first click Apply before another parameter is chosen. Otherwise the value is not
saved.
ATTENTION: The final knife depth is not set correctly yet. This is just the knife depth
setting for the origin and lateral test.
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5. After this, the knife parameters need to be set. This can’t be done with the remote. Click
the parameter that needs to be checked or set in Axis Control. Then click Test. Check the
pattern that was cut out. A window opens in Axis Control with a drawing of the pattern that
was cut out. In this window click the place where the correct pattern was cut out. The test
will differ according to the parameter that was chosen (highlighted in blue).

FIG 2-77
2-77 SETTING KNIFE PARAMETERS ROTARY MODULE

Setting the origin parameter.
The cutter will cut out a test pattern and a window will pop up in Axis Control. A wrong
origin setting will damage the conveyor belt. This will be clear when you check the test
pattern for errors. Due to the physical properties of the knife, the ‘footprint’ or mark the
knife cuts in the material is a thin line. If the knife is moved forward at an angle (wrong
origin) then this short line is dragged through the material, resulting in removing material
and leaving a gouge afterwards. If that happens to the conveyor, it will be irreversibly
damaged.

FIG 2-78
2-78 ORIGIN PATTERN TEST FOR THE ROTARY KNIFE

The origin test, cut in corrugated cardboard, looks like the pattern above. Look for the
straightest line between the 7 lines. The extended cut-out test goes from +180 over 0 to
-180. The values are indicative, so the user can adjust the value manually should it show
the correct pattern is probably just in between two cut out patterns.
ATTENTION: Do not hesitate to choose values between two lines, adjust the value by
hand and redo the origin test. A precise origin calibration results in a longer lifetime
of the conveyor belt
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Setting the lateral parameter.
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FIG 2-79
2-79 LATERAL PATTERN TEST FOR THE ROTARY KNIFE

The horizontal lines are cut out in two parts. Each line is cut from the middle to the side.
If the lateral parameter is not set correctly, the lines do not meet in the middle but will be
shifted. The figure contains values; the cut-out pattern doesn’t. Check for the line where
there is no shift in the middle and select the according one in the popup window. The
values are indicative, so the user can adjust the value manually should it show the correct
pattern is probably just in between two cut out patterns.
Setting the longitudinal parameter.
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FIG 2-80
2-80 LONGITUDINAL PATTERN TEST FOR THE ROTARY KNIFE

Small squares are cut out. Check for the square where the horizontal overcuts are all
the same and select the according one in the popup window. The values are indicative,
so the user can adjust the value manually should it show the correct pattern is probably
just in between two cut out patterns. If the longitudinal pattern is calibrated, then press
apply.
6. Finally set the correct depth position. Put the material that will be cut on the conveyor Go
again to ‘Down position’ and set the down position correctly in order to cut the material.

ATTENTION: Make sure the down position is not set too deep. Otherwise the
conveyor will wear down fast. Therefore, it is recommended to do the following. If the
correct down position is found, set the down position two steps higher and do the
test again. If the knife does not cut deep enough, set the down value again to its
previous value. If it still cuts completely through the material, this means the down
position was set too low and needs to be changed.
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2.5.1.8 Calibration of the router module
•

CHANGING ROUTER BIT AND DEPTH CALIBRATION

1. Click

if the routerbit was just changed. Axis Control will give a reminder in order not

to forget to calibrate the tool before using it. Click

to acknowledge.

2. Load the media. Make sure there is a bit of space between the origin (y-axis) of the table
and material. (Use ‘line drawn’ to mark the origin, as described in section 0).
3. Click
. If Axis Control is not selecting the correct module to calibrate automatically,
correct it by clicking the picture of the module. If the remote is used to choose the module,
press several times on the module until the correct one is chosen. The lights on the remote
show which module is currently chosen to calibrate. You need to choose module 3 for the
miller.
4. The first parameter to calibrate is the up position. To calibrate the up position click ‘Up
position’ in Axis Control or press ‘Up’ on the remote. Then press the down arrow (computer
or remote) until the router bit just touches the material. Move the tool to the left and/or
right to check if the tip of the bit scratches the media. Set the height this way it just
scratches the media. Look at the value on screen and memorize it. Now set the value about
4 – 5 mm lower. Press apply (computer) or A (remote).
5. To calibrate the down position, click ‘Down position’ in Axis Control or press ‘Down’ on the
remote. First press the right arrow this way the router bit is situated between the material
and the Y-axis origin. Then press the down arrow (computer or remote) until the value is
the same as the one that was memorized during the calibration of the up position plus the
thickness of the media. Press test to route a square. Adjust with the up/down arrow, if
necessary. Check again until the desired depth is set (use steps of 0.3 mm).
ATTENTION: Make sure that during this test the vacuum is not set too high (make
sure the brush is set high enough and lower the vacuum strength as described in
step 14, if necessary). If the vacuum is set too high, then the material can be lifted a
bit, so an incorrect setting of the depth will be the result. The router is set at the
correct depth if the pattern that is cut is clearly visible in the router mat (couple of
tenths of a mm cut into the mat).
6. Once the correct down position is set, turn on the extractor height control handle until the
brushes are situated just above the material (make sure the brushes do not touch the
material. It should be situated 1 – 2 mm above the material, otherwise it creates too big a
vacuum).

FIG 2-81
2-81 CORRECT HEIGHT EXTRACTOR BRUSH
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7. Press Apply to store the values.
8. The strength of the extractor vacuum can be adjusted with a ring that can be turned this
way a hole is uncovered or covered. If small parts are milled, this hole needs to be
uncovered, otherwise the little parts may disappear in the vacuum cleaner.

FIG 2-82
2-82 RING TO SET THE VACUUM STRENGTH

•

ORIGIN CALIBRATION OF THE ROUTER MODULE

The router module has another origin position in reference to the camera/positioning laser
than the tangential module. This needs to be calibrated, otherwise the origin and media size
setting will not be correct. This calibration is mandatory if the router will be used in
combination with printed job and regmarks and/or a tool in slot position 1. In order to
calibrate the origin for the router, follow the below procedure.
1. Load the media, install the module and tool.
2. Click

and click the picture of the camera unit in the window.

3. Click slot 3. The machine will drill a hole in the media with the router.

FIG 2-83
2-83 CALIBRATION DISTANCE ROUTER MODULE - CAMERA

4. There is the choice to calibrate automatically or to set the miller with the arrow keys in the
center above the drilled hole.
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2.5.2 Quick tool holder change without ADC option
The calibration parameters of the tools are very important to obtain a good cut quality. Some
tools are more difficult to calibrate than others. Because of this, the table stores the tool
parameters automatically.
So, if a previous installed tool is mounted in the machine, all settings will be restored from the
internal memory. However, the warning about checking the knife depth will still appear. If a
couple of rules and procedures are followed then changing most tools on an F Series table is
easy and quick.
There are a couple of things that need to be taken in account before using the quick change
procedures.
1. Label the modules and always mount them in the same position.
2. Make sure the tool has been calibrated completely in this module.
3. Always mount the tools in the same module, or calibrate each tool in each module.
4. The tool has not been changed in the tool holder.
NOTE: If there is more than 1 tangential module on the machine, the tools can be
calibrated in each tangential module. It is not necessary then to hold record of
where the tool was used. However, the tangential modules themselves always
need to be mounted in the same slot.
NOTE: The main tool parameters (depth and knife parameters) are media
independent. So the calibrations as described above can be done on scrap
material. Only speed is material dependent.
WARNING: Be careful with the usage of the quick tool holder change procedures.
When the normal complete calibration procedures are followed (see section 2.4.
- 2.5.1.7) then it is almost impossible to cut in the conveyor belt. This is not
guaranteed anymore, since the quick procedures use certain shortcuts and
assumptions.
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2.5.2.1 Quick tool change for the Kiss Cutting Knife
The Kiss Cutting Knife is used for thin materials. So the cutting depth usually depends on the
physical depth settings and pressure setting on the tool holder itself.

1. Mount the tool in the module (use

)

Axis Control will give a warning that the knife depth needs to be checked.

2. Click modules
to set/check the depth. If the user is confident that the knife was
not changed in the tool holder, then a knife depth test can be performed. Click ‘Down
position’ and click ‘Test’. Check if the knife cuts deep enough.
3. If it doesn’t cut deep enough set the down position correctly and check if the two bearings
press on the media. Lower them, if necessary. Otherwise the depth will have to be
adjusted with the pressure and depth of the knife on the tool holder itself. If the job
includes relatively small curves, it is advised to do the test of the lateral parameter to
check if the parameters need to be fine-tuned or not.

2.5.2.2 Quick tool change for the cutout tools
The cutout tool is usually used for cutting just through the material. So, if no extra underlay
mat, for safety or other purpose, is used, the down position is the same for any kind of
material.

1. Mount the tool in the module (use

)

Axis Control will give a warning that the knife depth needs to be checked.

2. Click modules
to set/check the depth. First check the value for the down position
and the up position. Subtract them from one another. The result should be at least 3 to 4
mm larger than the thickness of the loaded media. If not, the up position needs to be
recalibrated.
3. If the user is confident that the knife was not changed in the tool holder, a knife depth test
can be performed. Click the down position and click Test. Check the depth, adjust with the
arrow up/down, if necessary. If the job will include relatively small curves, it is advised to
do the test of the lateral parameter to check if the parameters need to be fine-tuned or not.
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2.5.2.3 Quick tool change for the EOT
One of the specific properties of the EOT is that the knife depth depends on the cutting speed
and the frequency of the tool. If the job uses media that requires speeds / frequencies, other
than the saved values, the knife depth test needs to be done as described in section 2.5.1.3.
The other parameters do not have to be recalibrated.

1. Mount the tool in the module (use

)

Axis Control will give a warning that the knife depth needs to be checked.

2. Click modules
to set/check the depth. First check the value for the down position
and the up position. Subtract them from one another. The result should be at least 3 to 4
mm larger than the thickness of the loaded media. If not, the up position needs to be
recalibrated. If the result is higher than 5 mm, it is advised to recalibrate the up position.
Otherwise too much time will be lost during the job.
3. If the user is confident that the knife was not changed in the tool holder, a knife depth test
can be performed. Click the down position and click test. Check the depth. Adjust with the
arrow up/down, if necessary. If the job includes relatively small curves, it is advised to do
the test of the lateral parameter to check if the parameters need to be fine-tuned or not.

2.5.2.4 Quick tool change for the V-Cut
The V-Cut tool is a difficult tool to calibrate for the first time. However, the fixture, used to
mount a knife in the tool holder, facilitates the calibration of the tool after a first calibration.
The depth setting depends on the thickness of the coversheet of the media. If the loaded
media has a totally different coversheet then the media used with the previous calibration of
the V-Cut tool, the knife depth needs to be set, as described in section 2.5.1.5 from step 11
onwards. However, do not forget to check the up position first.

1. Mount the tool in the module (use

)

Axis Control will give a warning that the knife depth needs to be checked.

2. Click modules
to set/check the depth. First check the value for the down position
and the up position. Subtract them from one another. The result should be at least 3 to 4
mm larger than the thickness of the loaded media. If not, the up position needs to be
recalibrated. If the result is higher than 5 mm, it is advised to recalibrate the up position.
Otherwise too much time will be lost during the job.
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WARNING: Be careful when doing a depth test with the V-Cut knife. If the knife
depth test is done during the setting of the down parameter, the knife is set in
the down position between tests. Therefore, the knife must be positioned next to
the media before the test button is pushed, while setting/changing the down
parameter.
3. Click the down position parameter. First click the right arrow until the knife tip is not
situated above the media anymore. If this is not possible, leave the test and reposition the
media a bit more to the left, so there is enough space to put the knife next to the media.
Click Test. Checking the depth consists of two steps. First check if the part the knife cuts
out is still slightly attached to the media. Tear it out and check if the cover sheet is
scratched by the knife. If the knife did not scratch the media, the knife depth is not deep
enough. See the standard knife depth calibration described in section 2.5.1.5. If the part
that is cut out is not slightly attached to the media, go to the lateral parameter, decrease it
by 20 and do the knife depth test again. Adjust the lateral parameter until it is set
correctly.
NOTE: In order to avoid having to reset the knife each time to the right of the
media, the knife depth test can also be done after clicking the up position
parameter (after at least one knife depth test whilst in the down position setting).

2.5.2.5 Quick tool change for the POT
One of the specific characteristics of the POT is that the depth is not a fixed value and that it is
very material dependent. Therefore, it is recommended to set the knife depth instead of just
checking it. To set the knife depth, follow the procedure as described in section 2.5.1.6.
If the option Overcut Compensation Mode is used during the job, it is recommended to check
the lateral parameter also.

2.5.2.6 Quick tool change for the creasing tools
The tool depth for a creasing wheel is very material dependent; it can even be job dependent.
So no quick tool change procedure is recommended, unless exactly the same material is used
with the same creasing tool. Sometimes a quick depth test can be sufficient.

2.5.2.7 Quick tool change for the router
Since it is recommended to clean the bit and collet each time before the router is mounted,
there cannot be a quick tool change procedure. So, always follow the calibration procedure as
described in section 2.5.1.8.
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2.6 Quick depth adjust
If the knife depth has to be adjusted just a little bit (e.g. compensation for wear on the knife),
the knife depth can be changed quickly.

2.6.1 General quick depth adjust

1. Click modules

, then select the module, whose knife depth needs to be adjusted.

The chosen module has a blue rectangle around it and at the right side the buttons
for changing the depth are visible.
2. Click

to set the knife depth 0.1 mm deeper or click

0.1 mm less deep. The

to set the knife depth

button can be used to check the depth.

NOTE: The knife depth can only be altered 0.2 mm with this procedure. If a larger
change is needed, the complete knife depth procedure needs to be followed.

2.6.2 Quick depth check/ adjust during a job
The knife depth cannot be adjusted during a job. However, if a series of actions is done, the
job can be saved.

1. Click

to pause the current job. Click

2. Click modules
click

to abort the current job.

. Select the module, whose knife depth needs to be adjusted and

once or twice to set the knife deeper.

3. Select the objects that need to be recut in SummaFlex Pro (or use the same selection as
before). Do not forget to check the box
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2.7 Calibration of the drag module
Although the machine does not automatically recognize the tool, mounted in the drag module,
it is still necessary to click
to mount the pen or knife in the module. This to make sure
the machine does not make any unexpected movement while the user is changing tools.

2.7.1 Calibration of the pen

1. After mounting the pen, click

. Check if the origin is still set correctly. If not, adjust

and then click
. Click the picture of the drag head module. If the remote is used to
choose the module, press several times on the module until the correct one is chosen. The
lights on the remote show which module is currently chosen to calibrate. The left light is
module 1; the light next to that is module 2 and the second last light in the row is module
3. First change the type of tool, if necessary. The button of the current selected tool is
grayed out and the parameters of this tool are shown. Set speed and pressure.

FIG 2-84
2-84 PARAMETERS PEN

2. Once a parameter is chosen to change, three new buttons will appear:
.

Press

to check if the speed and pressure are set correctly.

necessary. Then press
parameters unchanged.
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2.7.2 Calibration of the knife
1. After mounting the drag knife, click

. Check if the origin is still set correctly. If not,

adjust and then click
. Click the picture of the drag head module. If the remote is
used to choose the module, press several times on the module until the correct one is
chosen. The lights on the remote show which module is currently chosen to calibrate. The
left light is module 1; the light next to that is module 2 and the second last light in the row
is module 3. First change the type of tool, if necessary. The button of the currently selected
tool is grayed out and the parameters of this tool are shown. Set speed and pressure.

FIG 2-85
2-85 PARAMETERS DRAG KNIFE

2. Once a parameter is chosen to change, three new buttons appear:

,

to check if the speed, knife offset and pressure are set correctly.
Press
necessary.

and

.

Change, if

FIG 2-86
2-86 TEST PATTERN DRAG KNIFE

The knife pressure is set correctly when the test pattern cuts completely through the vinyl,
the vinyl is removed and the blade tip visibly scratched the front side of the media
backing. The blade should never cut through the backing but only slightly scratch the
silicon coating and the first few fibers of the backing material.
Result of test pattern when the offset is set correctly:
Result of test pattern when the offset is too low:
Result of test pattern when the offset is too high:
3. To change the value of a parameter, click it. Use the up and down arrow to change the
parameter value. In case of setting the velocity, choose the value in the dropdown box.
4. Then press
unchanged.
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2.8 Calibration of the camera unit
There are several calibrations related to the central unit. They are all done in the factory and
do not need to be redone.
One calibration is the calibration of the distance between the camera unit and the origin of the
used module. These calibration values are used to make sure that the different tools have the
same origin in case more than one tool is necessary for a job.
Only when there is doubt in accuracy about the difference in origin between the different
module positions, it is necessary to calibrate the camera unit.
ATTENTION: Only perform this calibration if instructed by a Summa technician.
ATTENTION: The calibration of the camera needs to be done for slot 3 if the router
module (option) is mounted on the machine. See section .
The calibration needs to be done with vinyl with a high contrast between vinyl colour and
backing colour (black vinyl with white backing preferred). If the tangential module is
calibrated, it is recommended to use the Kiss Cutting Tool.
This calibration can’t be done with the remote.
1. Load black vinyl; install the module and tool.
2. Click

and click the picture of the camera unit in the window.

3. Click the slot that holds the module, which needs to be calibrated. The machine will cut out
a large and a small square.

FIG 2-87
2-87 CALIBRATION DISTANCE MODULE ORIGIN - CAMERA

4. Carefully weed the large square, making sure the small middle square does not move. Click
OK (or hit the enter key). The flatbed will now measure the position of the little square and
calibrate automatically.
ATTENTION: The calibration of the camera for contour cutting is done in the program
SummaFlex Pro itself. It cannot be done in Axis Control.
The height of the camera unit can be changed, so the built-in camera is always correctly
focused. This is only necessary when the jobs are contour cutting jobs. It is recommended to
raise the camera unit completely when normal cutting jobs are done. This will prevent the
bottom of the camera unit hitting thick materials.
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Cutting / SummaFlex Pro

3.1 Introduction
SummaFlex Pro is a front-end application software with job preparation, post processor and
import plug-ins for CAD and illustration software (e.g., Adobe Illustrator and CorelDRAW).
Once the workflow is set, macros automate the process. Consequently, the operator’s
handling before starting the next job is reduced to a minimum. The downtime of the table is
also reduced to a minimum.

3.2 SummaFlex Pro sidebar
SummaFlex Pro has a side bar that groups the most used actions for a normal workflow. The
standard sidebar has 5 tabs.
NOTE: <Ctrl> 2 is used to hide or show the side bar. The blue arrow at the top of the
side bar is used to minimize or maximize the side bar. It is recommended to always
use the side bar, if possible.

3.2.1 Layer tab
NOTE: The layers are setup automatically after the correct device is installed. In
order to set up layers: Install the device, close SummaFlex Pro, then open
SummaFlex Pro again. A red V is visible in front of each layer name, if the layer has
been set up for that tool. The layers are all set up in the below figure.
If the layers are not set up, then the tools can be individually assigned to the layer.
Click this tab to assign the tools to certain layers. The procedure to set up the layers is
explained in section 3.3.

3.2.2 Files tab
The files tab is a file manager. A preview shows the file content, using a thumbnail. The list
view offers overview for large file sets. Any directory with subdirectories can be searched
automatically. Individual search paths can be defined for direct access. A search box makes
it easier searching by file name.
There are two predefined directories. These directories can be changed or directories can be
added.
The first directory list has a fixed file filter (just typical SummaFlex Pro files). If the directory
contains subdirectories, it is selectable to show them or not. The subdirectory can then be
chosen by clicking on the dropdown box next to it.
The second directory list has a selectable file filter (in the figure below it is set to pdf files) if
the directory contains subdirectories, it is selectable to show them or not. The subdirectory
can then be chosen by clicking on the dropdown box next to it.
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FIG 3-1
3-1 SUMMAFLEX PRO FILE MANAGER

can be used to add a directory.

can be used to edit a directory name and change

is used to refresh the preview view. This folder can be set to
options for that directory.
be monitored continuously or not (check the option ‘monitor folder’ when setting a folder).
These directories can also be set as a hot folder or not. If set as a hot folder, the directory is
monitored automatically and there are some extra options available.

FIG 3-2
3-2 SUMMAFLEX PRO HOT FOLDER SETTINGS

The option exists to jump to the macro tab when the file is opened (recommended setting).
You have the choice to delete the file after usage, to move it to another folder, or to leave it
alone. Also the barcode type can be set here.
If ‘macro assignment’ is used, then the action can be set after a file is chosen and double
clicked or it can be used if a new file appears in the hot folder directory.
Another possibility is to open a file immediately after the RIP creates it.
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3.2.3 Object tab
The object tab shows the object manager. The task of the Object Manager is to provide
access to any object that is on the desktop with the help of a clear tree structure. This is
important when the access is challenging because of the complexity of the design or
overlapping objects and graphics. In addition to single objects, the structure of groups and
combinations is also depicted.

FIG 3-3
3-3 SUMMAFLEX PRO OBJECT MANAGER

3.2.4 Clipart tab
If SummaFlex Pro is used for designing, then a clipart library can be built. The Clipart
Manager permits fast access to frequently required graphic vector objects such as logos,
clipart’s, pictograms …The organization takes place via individual groups. Access to
contents of the respective group is done by double clicks or "Drag & Drop". Some cliparts are
installed during the installation of the program.

FIG 3-4
3-4 SUMMAFLEX PRO CLIPART LIBRARY
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3.2.5 Macro tab
The macro tab shows all predefined macro’s, which are installed. If a job is loaded, this tab
also shows the used layers in the loaded job together with the assigned tools. To start a
macro, either double click on the text or click on the blue arrow.
Some settings exist to change the outlook of the macro tab. To change the view, click the
dropdown box at the top and click on global settings.

FIG 3-5
3-5 CHANGE THE VIEW MACRO TAB

The first option is to show the tooltip or not when the mouse is situated above a macro.
The second option is the size of the icons that can be set larger or smaller (size of the text
stays).
The third option is the number of quick layers (see later).

3.2.5.1 Pre-installed macro’s

These are the macros for file handling. The first two macros are used for importing files,
made by design software.
There are a couple of options when importing a file. After choosing the file type, a preview
can be shown, the insertion point can be set to the origin, a default rotation (steps of 90
degrees) can be set and a scaling factor can be chosen. All the settings used during
importation will be automatically set by default during the next file importation.
When Barcode (with hand scanner) is used to open a file, a window is opened first where the
type of barcode can be chosen. Then the path where the cut files are located needs to be set
correctly. The name of the file can either by filled in with the keyboard or can be read from
the printout with an external barcode reader. The possibility exists here, as well, to set a
default rotation (in steps of 90 degrees).
The file ‘open macro’ is used for opening jobs in SummaFlex Pro format (cutting job with
settings and other job info, this extra job info can be checked by going to ‘job info’ under the
edit menu).
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The files that are imported sometimes contain objects that are not closed or contain objects
on top of one another, resulting in cutting certain objects twice. This macro can be used to
clean such files. To clean up automatically, click the macro to start and click the OK button.
To clean up manually, refer to section 3.8.7.

This can be used to rotate the job, so it fits the table orientation. The orientation on the
screen should be the same as the orientation when the user stands in front of the machine.

SummaFlex Pro has a sorting algorithm to sort the order in which the objects are cut out. It
does not sort individual vectors, it sorts the objects (closed curves). This macro can be used
to visualize how the program sorts. Sorting can be set on or off in the output window.

Use this macro to open the output window.

If a file is opened, and the user does not click another tab of the sidebar, the layers used in
the job are shown. The number of layers shown can be set in the global settings (see above).
Use the scroll bar to view the other layers if there are more layers then are set to be visible.
If the layers have been properly defined in both design software and SummaFlex Pro, the
correct tool is already assigned to cut out the job.
If the correct tool has not been assigned, there is a greyed out picture of a tool. A tool can
then be assigned by first selecting the layer and then clicking Default.
The parameters of the selected tool can be changed by clicking the gears icon (
choosing a material if those were set up for that tool (see section).
is used to make the layer visible/invisible.
are visible but not selectable).
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3.2.5.2 Optional macro’s
There are some extra macros copied on the hard disk of the computer but not installed in
SummaFlex Pro.
The folder C:\Program Files (x86)\Summa\SummaFlex Pro\Macros\DefaultMacros holds all
the available macros. The macros, installed in SummaFlex Pro, are in the folder C:\Program
Files (x86)\Summa\SummaFlex Pro\Macros. So the optional macros just have to be copied
from the default folder to the folder below to be visible in the SummaFlex Pro sidebar.
ATTENTION: Make sure no files are deleted in the ..\DefaultsMacros directory.

The File save macro is used for saving jobs in SummaFlex Pro format (cutting job with
settings and other job info, this extra job info can be checked by going to ‘job info’ under the
edit menu).
For installing the macro in SummaFlex Pro, copy the file “D_file_save.pr7” from
“C:\Program Files (x86)\Summa\SummaFlex Pro\Macros\DefaultMacros” to
“C:\Program Files (x86)\Summa\SummaFlex Pro\Macros\”.

Node editing is an advanced feature that can be used to enhance the cutting quality on
curves with small radiuses.
For installing the macro in SummaFlex Pro, copy the file “F_edit_nodes.pr7” from
“C:\Program Files (x86)\Summa\SummaFlex Pro\Macros\DefaultMacros” to
“C:\Program Files (x86)\Summa\SummaFlex Pro\Macros\”.

This macro can be used to change the properties of the currently selected object(s) in the
job. Sometimes this is more useful in print and cut jobs.
For installing the macro in SummaFlex Pro, copy the file “I_object_properties.pr7” from
“C:\Program Files (x86)\Summa\SummaFlex
Pro\Macros\DefaultMacros”
to
“C:\Program Files (x86)\Summa\SummaFlex Pro\Macros\”.

This is used for easy weeding when the Kiss Cutting Tool or the Drag Knife Tool is used in
vinyl. After running this macro, the inner parts of objects will be cut with a cutout tool
instead of the Kiss Cutting Tool or the Drag Knife Tool.
For installing the macro in SummaFlex Pro, copy the file “HA Separate internal parts.pr7”
from “C:\Program Files (x86)\Summa\SummaFlex Pro\Macros\DefaultMacros” to
“C:\Program Files (x86)\Summa\SummaFlex Pro\Macros\”.
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This macro can be used when the design is printed on the back of the material. This can be
used in combination with the plug-in ‘Regmarks + Squares’. First the registration marks are
cut out (squares), then the material is turned over, the square marks are read and then the
job is cut (see section 3.8.5 for more information and detailed explanation).
For installing the macro in SummaFlex Pro, copy the file “IA_Summa Cut from Backside
Y.pr7” from “C:\Program Files (x86)\Summa\SummaFlex Pro\Macros\DefaultMacros” to
“C:\Program Files (x86)\Summa\SummaFlex Pro\Macros\”.

This macro is used for placing squares on top of registration marks. This macro can be used
in combination with the “cutting from the backside macro” if the plug-in for Illustrator or
Corel could not be used (this is the case when the RIP places the registering marks). First
select all the marks in the regmark layer. Then click the macro. The size of the marks can be
set before the squares are created. The squares will be created in the layer Cut Out Squares.
After this use the macro cutting from the backside.
For installing the macro in SummaFlex Pro, copy the file “IB_Place squares.pr7” from
“C:\Program Files (x86)\Summa\SummaFlex Pro\Macros\DefaultMacros” to
“C:\Program Files (x86)\Summa\SummaFlex Pro\Macros\”.

This macro is used for placing circles on top of registration marks. This macro can be used in
combination with the “routing from the backside macro” if the plug-in for Illustrator or Corel
could not be used (this is the case when the RIP places the registering marks). First select all
the marks in the regmark layer. Then click the macro. The size of the marks can be set
before the squares are created. The squares will be created in the layer Cut Out Squares.
After this use the macro routing from the backside.
For installing the macro in SummaFlex Pro, copy the file “IB_Place holes.pr7” from
“C:\Program Files (x86)\Summa\SummaFlex Pro\Macros\DefaultMacros” to
“C:\Program Files (x86)\Summa\SummaFlex Pro\Macros\”.

This macro can be used when the design is printed on the back of the material. First the
registration marks are milled (circles) then the material is turned over, the milled marks are
read and then the job is milled (see section 3.8.5 for more information and detailed
explanation).
For installing the macro in SummaFlex Pro, copy the file “IB_Summa routing from Backside
Y.pr7
from “C:\Program Files (x86)\Summa\SummaFlex Pro\Macros\DefaultMacros” to
“C:\Program Files (x86)\Summa\SummaFlex Pro\Macros\”.
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If it is not necessary to change anything in the output window, this macro can be used to
start the job immediately without the output window popping up first.
For installing the macro in SummaFlex Pro, copy the file “L_output to device_direct.pr7” from
“C:\Program Files (x86)\Summa\SummaFlex Pro\Macros\DefaultMacros” to
“C:\Program Files (x86)\Summa\SummaFlex Pro\Macros\”.

This macro can be used to create rectangles around selected objects (that can be used as
frame contour or trim boxes). The offset between the selected objects and the rectangle can
be set in the macro.
For installing the macro in SummaFlex Pro, copy the file “HB_Generate Cut Frame.pr7” from
“C:\Program Files (x86)\Summa\SummaFlex Pro\Macros\DefaultMacros” to
“C:\Program Files (x86)\Summa\SummaFlex Pro\Macros\”.

If it is not necessary to change anything in the output window and if the rip has been set up
to use the correct tool with the correct settings, this macro can be used to start the job
immediately without the output window popping up first directly after reading the barcode
with the hand scanner.
For installing the macro in SummaFlex Pro, copy the file
“B_file_import_barcode_direct_out.pr7” from “C:\Program Files (x86)\Summa\SummaFlex
Pro\Macros\DefaultMacros” to “C:\Program Files (x86)\Summa\SummaFlex Pro\Macros\”.

3.2.6 Production tab
This tab is only visible if the option barcode workflow is installed (see section 3.13. A special
license file has to be bought and activated first to be able to use this option.

Cutting / SummaFlex Pro

3-8

F Series

User’s Manual

3.3 Setting up layers and tools in SummaFlex Pro
It is recommended to go over the layer settings and the tool parameters before starting to
work with SummaFlex Pro. If there are no layers used to send files to SummaFlex Pro, also
colours can be assigned to certain tools. These colours can then be used when creating
templates in the design software. If colours/layers are already predefined in the design
software or RIP, this data can be used to set up the layers in SummaFlex Pro.
It is recommended to use the default layer names / layer colours used in SummaFlex Pro for
assigning tools to cutting lines and not vice versa. This is explained in the installation
manual.
Right click in the layer toolbar (if the toolbar is not visible, then click the layer tab at the
right). A window opens in which layer names, layer colours and tool properties can be
checked / set up.

FIG 3-6
3-6 LAYER MENU

Use the layer names, shown for setting up a template in the design software, if the templates
delivered with SummaFlex Pro can’t be used.
The ‘Regmark’ layer has no settings. It is a special layer used for registration marks.
ATTENTION: All registration marks should be in the regmark layer. If they are not,
then recognizing them as registration mark is more complicated for SummaFlex Pro.
ATTENTION: All registration marks must be defined as circles. The recommended
registration mark size is 5 mm. The size of the registration mark should be the same
as the size of the circle that is used to set the camera offset for maximum camera
accuracy.
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3.3.1 Tool (output) parameters
The tool parameters can be set for each tool in each layer. This section describes the tool
parameters. Not all tools contain all tool parameters; some parameters are redundant for
certain tools.
1. Slot position: is the position of the module where the cutout tool is mounted in. If
only one cutout knife is used in the job, leave this on ‘auto’.
2. HF routing speed: This is the speed at which the routing bit turns when the HF router
is mounted onto the machine.
3. Speed: This is the speed at which the knife cuts. Reduce this speed for thicker
materials.
4. Down position offset: The cutting depth can be adjusted with this parameter. This
parameter can only have positive values. The maximum cutting depth of a tool is
calibrated with Axis Control. This parameter can be used if the tool has to cut less
deep than the calibrated depth.
5. Material thickness: Is the total media thickness. If this parameter is shown, the next
three parameters are also shown. These four parameters always appear together.
6. Cutting (milling) depth: Is the depth that has to be cut (milled). It has the same value
as the one of media thickness if the media needs to be cut (milled) completely
through. If this value is not the same as the media thickness, the media will not be
cut (milled) completely through.
7. Max depth per pass: Either the material is too thick to be cut (milled) in one pass or
the tool cannot cut (mill) the media in one pass. This parameter sets the maximum
depth per pass.
8. Depth of last pass: This is the cutting (milling) depth of the last pass. SummaFlex Pro
calculates the amount of passes it needs, depending on the values of the cutting
(milling) depth, maximum depth per pass and depth of the last pass. If the last pass
is used as ‘cleaning pass’ this parameter has a lower value then the maximum depth
per pass.
9. Lift up angle: This is the maximum angle the cutter will cut without need to lift the
knife. If the angle between two consecutive vectors is larger than the set value, the
cutter will lift the knife, turn it, put it down again and then cut further. If this value is
raised, then the speed at which the job is cut might be higher, but the quality will be
lower.
10. Overcut Compensation Mode: Cutout knives are often used to cut thick materials. This
means that a relatively large natural overcut is formed at the top of the material. If
the cutout knife is a single edge one, this can be compensated by cutting the vector
in two and making sure the machine cuts away from the start and stop point of each
vector. There are 4 settings for this parameter:
a. Off: switches off overcut compensation mode.
b. All corners: this means overcut is compensated in each corner where the knife
is lifted (where the corner is larger than the lift-up angle)
c.

inside: This means that the compensation will only be done for inner corners
of closed paths.
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d. outside: This means that the compensation will only be done for outer corners
of closed paths.

11. Overcut compensation distance: This is the distance between the place where the
overcut compensation mode is done and the end of the original vector. This value
depends on the thickness of the media. Use half of the thickness of the media as
value.
12. Break point overlap: Overcut compensation cuts each vector in two parts. This
parameter determines how much these parts overlap.
13. Overcut: Is used for easier weeding. Each time the knife goes up or down, the cutter
cuts a bit further. The distance it cuts further is determined by this parameter. This
overcut is the overcut of the center of the knife point and has nothing to do with the
overcut described above. The resolution is: 1 = 0.1 mm for the drag knife and kiss
cutting knife. The resolution is: 1 = 1 mm for other tools.
14. Dynamic tool diameter compensation: This is used for the router option. A routing bit
has, in contrast to a knife, a specific thickness. This means that the path, the routing
bit needs to follow, must have an offset to the object, so the result has the exact size.
This parameter sets the offset of the routing path on or off. The size of the offset is ½
the diameter of the routing bit (see next parameter).
15. Tool diameter: Is used for the router option. If the routing path has not been defined
in the design, the bit diameter must be set here, so the program can calculate the
routing path. For more info on routing see section 3.9.
ATTENTION: The tool diameter needs to be set to 0 if the routing path was already
defined in the design.
16. Tool diameter compensation: Is used for the miller option. This parameter needs to
be set at ‘Outside’ if an object needs to be milled. When a hole needs to be milled, it
is set at ‘Inside’.
17. Tool diameter compensation for open objects: Is used for the router option. When a
curve is open, it is impossible to determine what is ‘inside’ and what is ‘outside’ the
curve. So, usually this parameter is set to off. If this parameter is set to on, the
router path is set under or above the open curve, dependent on the direction of the
curve segments.
18. Milling Orientation: This sets the orientation of the routing path.
19. Lead-in/out: If this option is activated, the tool will use a circular arc move towards
the curve that needs to be milled, unless there is a line in the curve.
20. Speed of the last pass: This parameter controls the speed of the last pass (can be
used as cleaning path). The set speed is usually lower than the speed of the previous
passes.
21. Cleaning path: This sets the cleaning path on or off. It is used to get a better finish
for routing and is also used when routing relatively small objects. The cleaning path
is the same as the last pass.
22. Cleaning path offset in %: This sets the size of the offset of the other paths to the
cleaning path.
23. Pause after tool: If this option is activated, the machine pauses after the use of this
tool.
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24. Segment helper: This is an option to compensate small errors when cutting in panels.
It needs to be set on or off in the layer settings.
Click to change the parameter value in the value column. Clicking toggles the value, creates a
dropdown box with a list or just makes the value changeable, depending on the type of
parameter.
NOTE: It is advised to build up a library of settings for frequently used materials.
Save the different materials under “material”. (see section 1.1.1) When this
material is then re-used later, the parameters for that material can quickly be set
by clicking the dropdown box under “material” and choosing the corresponded
material.

FIG 3-7
3-7 TOOL PARAMETERS
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3.3.2 Saving the layer setup
Once the tools have been changed/defined, the layer setup can be saved by clicking the layer
button (triangle left of the ‘Sel’ button) and then Save palette. It is recommended to delete
the regmark layer. This layer is only used when working with the camera. This is not
supported in SummaFlex, only in SummaFlex Pro.
Once the layer setup is done, the layer tab looks like the figure below.

FIG 3-8
3-8 LAYERS SET-UP

A red V before a layer name means the tool for this layer has been defined.
A blue V before a layer name means the tool is a router and the routing bit diameter has been
set.
The double black rectangles mean objects are defined in that layer.
The order of the layers determines the order in which the flatbed cuts (or draws and cuts).
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3.3.3 Adding a new layer
SummaFlex Pro comes with a preconfigured number of layers. If extra layers need to be
added, e.g. for extra tools or to easily differentiate the same tool with different knives, add
them as described in the procedure below.
The procedure is written for setting up a special layer for not cutting completely through with
a cutout knife.
Click New. The layer setup window opens. First click Colour and choose the colour for the
layer. If the colour is chosen, then click on the Output button.

FIG 3-9
3-9 SETTING UP THE COLOUR FROM THE NEW LAYER

Then click on Layer insert. The new layer will be inserted just above the currently selected
layer. If the order needs to be different, then the order can always be changed afterwards.

FIG 3-10
3-10 INSERT LAYER
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Fill out the box underneath ‘Information’, choose the correct tool and adjust the parameters,
if necessary.
Do not forget to save the new layer.

FIG 3-11
3-11 SAVE NEW LAYER

Click Save to save the newly inserted layer.
Click Insert to insert a layer (must be in ‘colour mode’ for this).
Click Delete to delete the selected layer.
Click Save palette to save all changes that have been done while the window was open.
If extra layers need to be added, first change the layer colour again. Otherwise the program
will display an error message.
It is recommended to define a new layer in the design software with the same name. If this is
not done, the tool will have to be assigned when importing the design into the layer or the
objects will have to be moved to the correct layer (see section 3.8.1).
NOTE: This procedure can also be used if, for instance, two types of cutout knives
are used in one job (e.g. heavy duty and double sided) or two types of creasing
wheels (e.g. crusher and creasing wheel). Then it is advised to use the name of the
tool as layer name. The slot position will then need to be set correctly, as well.
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3.3.4 Setting up parameters for different materials
Different materials need different settings. All those settings can be pre-configured. This can
be done when setting up a layer. When a layer is set up (see paragraphs above) the moment
the tool is chosen, a new dropdown box appears under the title ‘Material’.
To set up a tool for a special kind of material, use following procedure:
• Go to layer setup (right click in the layer toolbar - if the layer toolbar is not visible,
click on the layer tab at the right).
• Change the parameters according to the material that needs to be cut.
• Click on the … box next to the dropdown box under ‘Material’ and select ‘Add…’.
• Fill in the new name and click OK

FIG 3-12
3-12 ADD NEW MATERIAL

To change the default values for the layer:
• Make sure ‘Material’ is set to default, then change the tool parameters.
• Click on the … box next to the dropdown box under ‘Material’ and select ‘Save
profile’.

FIG 3-13
3-13 CHANGE LAYER DEFAULTS
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NOTE: It is advised to use easily recognizable names for setting up different
materials. There are two types of names that are usually chosen. The first type
consists out of using the name of the material that needs to be cut (e.g. B-flute
Cardboard). The second type of name is a name in which the changed parameters
are used (e.g. 50mm/s 10 lift up angle).
Different defaults:
If the … box next to the dropdown box under ‘Material’ is clicked, you have the choice
between three sets of default values (see fig 3.9):
Mode /Tool Defaults: These are the default values of the parameters as they were with the
installation of the driver. These defaults cannot be changed by the user.
Material Defaults: If the parameters are set for a new type of material and those settings are
saved in a profile (see above – setting up parameters for a new material) then those saved
values are the default values for that type of material.
Layer defaults: If a new layer is added or a palette changed and then saved (see section
3.3.3 adding new layer), those saved values are the default values for that layer.
To change the parameters in the job, just click the dropdown box underneath the tool name.

FIG 3-14
3-14 CHANGE TO PRE-DEFINED PARAMETERS

If extra parameters need to be changed, click on the gears to the right of the tool name.
However, it is recommended to predefine materials.
NOTE: These tool settings are saved in the driver file and are not palette dependent.
If a new driver file needs to be installed, use the special installation program,
otherwise the tool settings are lost (see installation manual).
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3.3.5 Determine the order of tools that are used
The order of the layers, with tools assigned to them, determines the order in which the table
uses the tools. The order defined in the standard palette is logical, but should it be changed
or should the order of new layers need to be changed, follow the next procedure.
Click the fly out box in the layer menu just before the Sel and New buttons. Choose Layer
Order and change the order of the layers. The tools, which cut completely through, should
always be used as last.

FIG 3-15
3-15 CHANGING LAYER ORDER
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3.4 Open or import a file
3.4.1 General
SummaFlex Pro has its own file format for saving files/jobs. These files not only contain the
data from the design software but also the settings, used for executing the job (whether it
has been executed or not) and other info. To open a previous job, go to File menu and then
click Open. However, the import function will be used mostly.
ATTENTION: It is recommended to work primarily in OXF and PDF file formats when
exporting/saving from the design program.

3.4.2 Import filter setting
The settings of the import filter can be set by going to Settings -> Standard settings ->
Import/Export.

FIG 3-16
3-16 IMPORT SETTINGS

This setup allows to define the search paths for the import as well as to select the file name
for the automatic import of files (F12) and to select if the file has to be deleted after the
import.
If SummaFlex Pro is loaded and an EPS-file is saved in one of the given search paths under
the defined name (for example SummaFlex Pro), it automatically activates SummaFlex Pro.
This file will be loaded directly to the working surface.
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When the imported or opened file contains bitmap data, it can take a long time before the
preview is shown. Changing the value of these settings prevents SummaFlex Pro from
creating a preview in the import window. However, it is recommended not to include bitmap
data in the file that is prepared for importing into SummaFlex Pro.

Above After Import settings are set at their recommended value.
Fit working area to objects: When this box is checked, the working area is set at the bounding
box of the objects plus a certain margin (here set at 2 mm all around). SummaFlex Pro uses
the size of the working area for its calculations when preparing the output.
Fix object size: When this box is checked, the size of the objects can’t be unintentionally
changed by the user. If an object has a fixed size, then its selection handles are red (instead
of black).
Fix object size for output: When this box is checked, SummaFlex Pro does not change the size
of the objects when it is cut out. The place and the rotation will be compensated, but not the
size itself. This is again made visible with red selection handles.
Separate layers by name: This option should be checked to facilitate the workflow. This
makes sure that the registration marks are immediately recognized by SummaFlex Pro and it
also makes sure that the correct tool is assigned to each object (if it was defined earlier).
Search/replace jog marks: If this box is checked, SummaFlex Pro recognizes every circle as a
registration mark. So keep it unchecked if the recommended settings for file import/export
are used (layer with correct names).

Above After Import settings are for DXF and HPGL import only.
There is the option to close objects automatically. This option can be set on or off. The
minimum gap can be set and also the layers, where the objects have to be closed, can be set.
Another option exists to combine all objects per layer or not.
All these pre-set properties can be changed later, if necessary.
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The Import pdf setting is the option to suppress the select page dialogue box while importing
pdf files. The other option is to embed job info when exporting to a pdf file.
Extra settings can be set if the OptiSCOUT button is clicked.

Create new job: If this box is checked then the import command works as if it would be an
open command.
And close active job: If this box is checked, then the active job is closed when a new job is
imported.
After Drag’n Drop....: It is not recommended to use drag and drop because the layer
information is lost and usually the design computer is not the computer that is used to drive
the flatbed.
ATTENTION: Be careful with the option close active job. If this is used in
combination with “do not ask for save on exit” option, then the previous job is
closed without any warning and the changes made are lost. (see below)
Load palette: If a different palette is needed temporarily, then this option can be used. Fill out
the alternative palette and check the box in front of “load palette”. If the normal palette is
needed again, then just uncheck the box.
Loading palette is usually also not used. The palette is already correctly set in the design
software or in the OXF-file from the RIP.
Get jog marks from layer: This is the recommended way to detect the registration marks.
There are a couple of layer names set by default. Other names can be added to make
SummaFlex Pro compatible with other software.
The Combine and group option affects the sorting algorithm of SummaFlex Pro, they are best
left as they are.

Cutting / SummaFlex Pro

3-21

F Series

User’s Manual

Suggest filename as jobname: This option gives the possibility to let the program suggest the
filename of the imported file when the job will be saved as a job file (native file format of
SummaFlex Pro).
The preferences that can be set when closing a file (job) can be found by going to Settings > Standard settings -> Miscellaneous.

Autosave interval: A backup file is made in the SummaFlex Pro directory called autosave.job.
This option sets with at which interval this file is updated.
Max. number of jobs in history: Sets the number of recent files in the file menu.
Don’t ask for save on exit: Option to close a job without asking if changes need to be stored.
Prompt ‘overwrite file?’ when saving: Sets the option to prompt a window to overwrite an
existing file or not.

3.4.3 Importing a file
To import a file go to the file menu and click Import. Or double click File import in the side
bar. When a file is imported, a new job is automatically started (is a setting in the import filter
setup).

FIG 3-17
3-17 IMPORT WINDOW
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There are some options in the import window:
Preview: Show a quick preview of the data in the selected file.
Insert at position (0,0): Forces the origin of the data to 0,0. This is useful for saving media.
However, if the option ‘Fit working area to object’ is checked in the general import filter
settings, then this option is redundant.
Rotate by: Is a very useful option to make sure the orientation of the job is adjusted to the
orientation of the table.
X-factor and Y- factor: Is a predefined scale factor that can be set, if necessary.
A second window is then shown with extra import settings with certain import filters
(e.g.pdf).
ATTENTION: The second window is not shown if the Import pdf setting is the option
to suppress the select page dialogue box while importing pdf files.

FIG 3-18
3-18 PAGE SELECTION IMPORT WINDOW

If the file contains multiple pages, then the page to import can be chosen. There are also
some options for object handling.
There is the option to ignore or import texts and bitmaps. It is recommended not to import
the bitmaps. And if they are imported, import them at a low resolution.
This step (page selection) can be skipped.
If the program recognizes the registration marks, then it marks them with a cross hair in the
middle of the circle.
NOTE: If the registration marks need to be set manually, define them as circles with
the correct diameter (5 mm default/recommended) in the regmark layer in the
design software. The program SummaFlex Pro can find them easily without
intervention of the user, provided that the import filter settings are set correctly.

FIG 3-19
3-19 CIRCLE RECOGNIZED AS REGISTRATION MARK
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Below is a figure explaining the orientation of the table in reference to the screen in
SummaFlex Pro. The white area is the working area. The size of the working area is usually
determined by the objects.

FIG 3-20
3-20 ORIENTATION TABLE/SUMMAFLEX PRO
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3.5 Output to the Flatbed
3.5.1 Output settings
The default output settings can be set by going to Settings -> Standard settings -> Output
Parameters. The window that is opened depends on the current opened job. The option
differs depending on the presence (print and cut job) or absence (cutting only) of register
marks in the opened job.

FIG 3-21
3-21 OUTPUT WINDOW SUMMAFLEX PRO

The parameters in red are grayed out when registration marks are in the job (print and cut
job). The parameters in blue (under the separator asterisks with OPOS) are not visible when
there are no registration marks in the job (cut job only).
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Device: This option shows the current device driver that is linked to the job. Summa F Series
is the correct driver for the table.
Mode: There are three modes to choose from. The chosen mode influences also the visible
parameters in the output window.
Output with layer assignment is the default mode and used in most cases.
Output with layer assignment fixed feed is a mode for a continuous workflow with sheets.
This is explained in section 3.12.
Output with layer assignment Tandem: Is a mode used on the large tables only. It makes it
possible to load sheets on one side of the table while it is cutting (or milling) on the other
side of the table. This is explained in section 3.11.
Output Profile: Here it is possible to store different output profiles. This is used to quickly
change a set of parameters for a specific job. The parameters that are stored in the profile
are the parameters in the white area of the output window.
Manage Profiles …: Use this to create, alter and save different profiles.

These are the parameters to cut out multiple copies of the job:
Number of jobs: applies if sheet material is used and if the total number of copies can’t be cut
in one sheet. This is then used to tell the program the number of sheets that will be used. The
total number of cut-outs will then be the number of outputs times the number of copies. Do
not use this parameter when working with a roll.
Copies per job: Is the number of copies in one output. This is the number of copies on one
sheet when working with multiple sheets or the total number of copies when working with roll
material.
Copy spacing Y direction: Is the distance between the copies in the Y direction.
Copy spacing X direction: Is the distance between the copies in the X direction.
The weed border is cut around each copy. The distance can be set with this parameter. The
weed border can then be activated in the preview window (not if multiple copies are
selected).
If the job exceeds the media size, loaded on the table, then it will report that the job will be
segmented.

If not, then there will be a report of how many copies will fit in the Y axis direction and how
many media will be used in the X direction.
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The different segmentation options are described in section 3.7.

Only Output tool-assigned layers: Keep this checked in order to make sure that no data is cut
from layers that have no tool assigned to them.
Sort before output: Check this if the cut data needs to sorted before it is sent to the table.
More info on sorting in section 3.6.
Send design relative to origin: This option is grayed out when the job is a print and cut job.
This option can be useful to several sorts of media. If not all objects are selected to be cut,
then the origin of the job is automatically set to the origin of the selection, if this box is not
checked. If this box is checked, the origin will stay as defined in the job.
Plot to file: Check this box if the cut data needs to be sent to a file instead of to the table. This
option can be usefull for troubleshooting.
Pause after segment: This option is also grayed out when doing a print and cut job. This
option makes it possible to add a pause after feeding a segment in a cut only job.
The save settings button saves the output settings ( this button has the same function as the
save button at the bottom of the window).

These settings relate to the table and loaded media. The size of the loaded media can be
filled out. It can also be set by clicking on the ‘Read material’ button.
ATTENTION: It is recommended to set up SummaFlex Pro to read the media size
automatically. Go to Settings -> Standard settings -> Output devices and check the
box in front of Automatically read the material size.

.

Material: this parameter lets the user choose between roll media and sheet media.
Vacuum setup : serves to choose between vacuum control of the SummaFlex Program or
using the standard table settings.
Park position: Sets the place the carriage parks after one job (or segment of job) is finished.
You have the choice to set the carriage at the end, in the middle, at a certain coordinate or
just lift the head after the job is finished.
Feed after last segment: Determines whether the media is moved forward after processing
the last segment.
Extended feed by…: This parameter makes it possible to add an extra feed after a job. This is
usefully to create an extra space between two cut only jobs.
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If a job needs to be segmented, SummaFlex Pro shows a preview of the job before it will send
the job to the table. This way the user can choose the way the job will be segmented.
Segmentation is explained in section 3.7.
The rest of the parameters in the white part of the output window is only visible if the job is a
print and cut job.

The Production mode parameter can be set to Manually, Manually-> Production or to
Production.
When it is set to Manually, SummaFlex Pro will pause between reading the registration marks
and cutting the job. This gives the operator time to check the reading of the registration
marks, if necessary.
When it is set to Manually-> Production, then the first copy is done in ‘Manually’ mode, all
further copies are then done without intervention of the operator.
When set to Production, then it is even not necessary to set the camera above the first mark.
The table will go to the position to where the last first mark was read. If the first mark is
there, the job will be done. If the first mark is not there, then the program waits for the
operator to set the camera above the first mark.
Click Edit to view the different registration mark settings.

Mark type: SummaFlex Pro can recognize a whole range of registration mark types. You can
choose the type here. If a different camera profile needs to be chosen, the Mark type needs
to be changed (see section 3.10.2).
ATTENTION: The position of the registration mark should always be defined with a
circle, even if the registration mark has a different shape. This means that all
registration mark positions will have to be defined twice if the user chooses to use
marks that are not circles. So, to avoid extra work and to have the highest possible
accuracy, always use printed circles as registration marks.
Mark recognition: If a very high accuracy is needed, SummaFlex Pro can read the registration
marks several times. This can be set with this parameter.
On mark read error: If a registration mark is not found, SummaFlex Pro can either ignore it or
wait for user intervention. If it is set not to wait, make sure that there are enough good
registration marks available for accurate contour cutting.
Use only group marks for adjustments: This option can be used
certain objects. In this case the program only uses the marks
objects in order to cut them out when this option is set active.
more jobs on different sheets are cut in one job. This prevents
marks (from another sheet).
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Total number of copies is the total number of copies the user wants.
The number of copies in the X-direction: Sets the number of copies that will be processed in x
direction.
The number of copies in the Y-direction: Sets the number of copies that will be processed in Y
direction (from left to right).
Number of copies in the Y direction is the number of copies the flatbed will cut out from right
to left. If the total number of copies exceeds the number of copies in the Y direction x the
number of copies in the X direction, then the media will be fed forward or the flatbed will put
its head in the park position to load a new sheet. The way the machine behaves is set with
the material parameter and the feed / no feed button.
The number of copies in the Y direction needs to be counted exactly by the user.
The offset between the copies can be set correctly or can be left unchanged. The values are
then automatically set correctly when the operator guides the camera of the flatbed over the
next registration mark, when necessary.

There are 6 compensation methods; they can be split up into two groups.
The first group can be categorized under best fit.
Best fit means that the registration marks are read and that the size and shape of the cutting
lines follow the printed data as close as possible. This means that when the printout is
scaled, the cut data is also scaled. When a printout is warped, the cut data is also warped.
There are 3 types.
Best fit: The program decides for each curve which registration marks are the closest (best
placed) registration marks to recalculate the shape of the curve to follow the printout. Only
those marks will then be actually read.
Best fit (read all marks): All marks are read to make it easier for the machine to find the
marks. While the marks are read, they are used for determining where to look for the next
mark. This can be useful on jobs with few large curves where the marks that will be used for
actual compensation are far apart (large tables) or if the job is scaled or rotated a lot.
However, the compensation method itself is the same as with the compensation method
described above: The program decides for each curve which registration marks are the
closest (best placed) registration marks to recalculate the shape of the curve to follow the
printout.
Best fit (smart compensation): Here also all the marks are read. And all the registration marks
are used for compensation of each curve. If necessary, the curves are even split up so the
printed line can be followed more or less precisely.
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The second group of the type fit to job.
Fit to job means that the shape and size of the cutting lines are fixed and it do not follow the
printed data. The cut data is just positioned in the best position in reference to the
registration marks. If the cut data is a perfect square, then the cut shape will be a perfect
square, regardless whether the printout was scaled in one direction or warped.
Fit to job: The program decides for each curve which registration marks are the closest (best
placed) registration marks to position the curve above the printout. Only those marks will
then be actually read.
Fit to job (read all marks): All marks are read to make it easier for the machine to find the
marks. While the marks are read, they are used for determining where to look for the next
mark. This can be useful on jobs with few large curves where the marks that will be used for
actual compensation are far apart (large tables) or if the job is scaled or rotated a lot.
However, the compensation method itself is the same as with the compensation method
described above: The program decides for each curve which registration marks are the
closest (best placed) registration marks to position the curve above the printout. And then
use those to position the curve.
Fit to job (smart compensation): Here also all the marks are read. And all the registration
marks are used to position each curve.
The figures on the next page are explaining in detail how the cut data is processed in
reference to the printout and the read marks.
Theoretical Shape
read and used for compensation
read and not used for compensation
printed shape
cut shape
read all

smart comp

read all

smart comp

read all

smart comp
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smart comp
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FIG 3-22
3-22 COMPENSATION METHODS
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3.5.2 Cutting only
3.5.2.1 Workflow
The workflow for cutting only with SummaFlex Pro is easy. The designs are made in the
design program. These designs are then exported to a file format that SummaFlex Pro can
understand and will be opened in SummaFlex Pro.
SummaFlex Pro is then used for controlling the flatbed. All tool parameters are also
controlled from SummaFlex Pro.

Design
software

Postscript: PDF, EPS, AI, PS

SummaFlex

Specific
cutter Language

F-Series

Specific: CAD: DXF, Corel: CMX
Bitmap: Tiff, Jpg

FIG 3-23
3-23 WORKFLOW SUMMAFLEX PRO

It is recommended to know in advance which tools will be used on the flatbed cutter. Each
line can have the tool as property, which will be used later. SummaFlex Pro recommends
using layers with as name the tool that will be used on the flatbed cutter as particular
property. If it is not yet certain during the design stage which tool will be used, it is still
recommended to use layers (with other names, if necessary) to differentiate between
different tools. If the used tool is decided later, the tool can easily be assigned to these
other layer names in SummaFlex Pro.
If a job is designed with objects in this layer and correctly exported, SummaFlex Pro will
automatically assign the correct tool to the object. If it is not possible to use layers to assign
different properties to different cutting lines, colours can also be used to differentiate them.
Each colour can then be assigned to a certain tool in SummaFlex Pro.

3.5.2.2 Output to the flatbed cutter

FIG 3-24
3-24 JOB IMPORTED INTO SUMMAFLEX PRO

The figure above shows a file, imported into SummaFlex Pro. The side bar shows the macro
tab. If the sidebar shows something else, click ‘Macros’ at the right side.
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Check if the objects have been opened in a layer that has a tool assigned to it. If that is the
case, the tool name is visible next to an icon of that tool. Select, if necessary, a predefined
parameter set for a specific material for this tool (see section 3.3.4)

FIG 3-25
3-25 CHECK TOOL SELECTION AND CHOOSE MATERIAL PRESETS CUT ONLY JOB

.
Locate the macro ‘Output to device’
Click the blue arrow or double click the text to send the job to the flatbed cutter.
The output window will be opened.

FIG 3-26
3-26 OUTPUT WINDOW CUT ONLY
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The output window is similar to the window that has been set up while setting the output
settings (previous section) , apart from the bottom row of buttons.
All parameters can be changed here if necessary and also saved as a new default or a new
profile (for settings in the white area).
The preview button can be used to preview the job. The job will automatically be previewed if
the job is segmented (see section 3.7).
The read material button can be used to read the size of the loaded media if it is not read
automatically.
ATTENTION: It is recommended to set up SummaFlex Pro to read the media size
automatically. Go to Settings -> Standard settings -> Output devices and check the
box in front of Automatically read the material size.

.

The cancel button closes the output window without anything being cut.
Click the output button to start the job.

Cutting / SummaFlex Pro

3-33

F Series

User’s Manual

3.5.3 Contour cutting
3.5.3.1 General
In general, contour cutting includes the following steps:
 Create a graphic.
 Print the graphic (laminate, if necessary).
 Load the media and register the registration marks.
 Cut the graphic.
Do not place contour lines along the edges of graphics or the slightest movement in the
media may result in an unsatisfactory cut. Instead, practice one of the following techniques:
 Place contour lines just inside the graphics (recommended).
 Place contour lines outside the graphics.
 Create thick borders around graphics and place contour lines inside these borders.

3.5.3.2 Workflow
The workflow for SummaFlex Pro (contour cutting) depends on the used RIP. There are
basically two types. The type where the RIP itself creates a file that will be used in
SummaFlex Pro and the type where the data for SummaFlex Pro needs to get the data
directly from the design software.

Design
software

PDF
EPS
AI
PS
-Tiff
Jpg

RIP

Native
Printer
Language

Printer
Screenprint
other

OXF

(also iCut format)

SummaFlex
PRO

cutter Language

F-Series

FIG 3-27
3-27 WORKFLOW FOR RIP’S THAT EXPORT TO A SPECIAL FILE FOR SUMMAFLEX PRO

Each cutting line can be cut out with a specific tool. The decision to assign a certain tool to a
certain cutting line can be taken at three possible stages. You can take it either during the
design. Properties can be assigned in the RIP process or even just before they are cut out,
in SummaFlex Pro. It is recommended to place the decision point during the design. The
recommended method to do this is using layers. It’s also possible that certain programs
prevent the free choice of the decision point.
If it is not possible to use layers to assign different properties to different cutting lines, then
colours can also be used to differentiate them. Each colour can then be assigned to a certain
tool in SummaFlex Pro.
If a job is designed with objects in a layer, which has the same name as the tool name in
SummaFlex Pro, and which is correctly exported, SummaFlex Pro will automatically assign
the correct tool to the object. If it is not possible to use layers in order to assign different
properties to different cutting lines, colours can also be used to differentiate them. Each
colour can then be assigned to a certain tool in SummaFlex Pro.
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FIG 3-28
3-28 WORKFLOW FOR RIP’S THAT CAN’T EXPORT TO A SPECIAL FILE FOR SUMMAFLEX PRO

This type of workflow serves for RIPs that do not have an export function to create files that
can be processed by SummaFlex Pro. In this case it is almost mandatory to work in layers.
This way certain layers can be exported to files for the RIP to print and other layers
(preferably already with the correct tool name assigned to it) to files for SummaFlex Pro.
Currently used tools on the cutting table are: Drag Knife, Kiss Cutting Knife, Cutout Knife,
Creasing Wheel, Oscillating Knife, various V-cut knives, Router and Rotary knife. If a job is
designed with objects in a layer, which has the same name as the tool name in SummaFlex
Pro, and which is correctly exported, then SummaFlex Pro will automatically assign the
correct tool to the object.
If it is not possible to use layers to assign different properties to different cut lines, colours
can also be used to differentiate them. Each colour can then be assigned to a certain tool in
SummaFlex Pro.

3.5.3.3 Output to the flatbed cutter

FIG 3-29
3-29 CONTOUR CUT JOB IMPORTED INTO SUMMAFLEX PRO

The figure above shows a file imported into SummaFlex Pro. The side bar shows the macro
tab. If the sidebar shows something else, then click on ‘Macros’ at the right side.
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Check if the objects have been opened in a layer that has a tool assigned to it. If that is the
case, then the tool name is visible next to an icon of that tool. Select, if necessary, a
predefined parameter, set for a specific material for this tool (see section 3.3.4).

FIG 3-30
3-30 CHECK TOOL SELECTION AND CHOOSE MATERIAL PRESETS PRINT AND CUT JOB

.
Locate the macro ‘Output to device’
Click the blue arrow or double click the text to send the job to the flatbed cutter.
The output window will be opened.

FIG 3-31
3-31 OUTPUT WINDOW PRINT AND CUT JOB
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The output window is similar to the window that has been setup up while setting the output
settings (previous section) , apart from the bottom row of buttons.
All parameters can be changed here, if necessary, and also saved as a new default or a new
profile (for settings in the white area).
The preview button can be used to preview the job. The job will automatically be previewed if
the job is segmented (see section 3.7).
The read material button can be used to read the size of the loaded media if it is not read
automatically.
ATTENTION: It is recommended to set up SummaFlex Pro to read the media size
automatically. Go to Settings -> Standard settings -> Output devices and check the
box in front of Automatically read the material size.

.

The cancel button closes the output window without anything being cut.
Click on the output button to start reading the registration marks.

FIG 3-32
3-32 REGISTRATION MARKS SEARCH WINDOW

Move the head with the arrows above the first registration mark (the position of the
registration mark is shown in the preview window at the right). The easiest way is to move
the head and look at the head itself, do not look at the left preview window yet. Move the
head, so that the red light of the pointer is situated above the first registration mark. Then
move the head a bit forward until the registration mark is visible in the left preview window.
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SummaFlex Pro will draw a circle around the registration mark if it has been recognized as a
registration mark. The circle will be green if the center of the circle is within the ‘accurate
zone’ and red if it is outside that zone. Press enter.

FIG 3-33
3-33 REGISTRATION MARKS SEARCH WINDOW CAMERA OVER REGISTRATION MARK

The flatbed will now search for the rest of the registration marks. If the production mode is
set to production, the flatbed will start cutting immediately after the marks have been read. If
production mode is set at manually, then SummaFlex Pro will pause. The recognized
registration marks will be visible in the right preview window.

FIG 3-34
3-34 ALL REGISTRATION MARKS READ
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If there is doubt about the correctness of the place of the registration marks, the user can
is pressed, the table jumps to the
check if the marks were correctly read. Each time
next mark. If the mark is accepted by the program, a red check mark is shown at the top
right side of the mark. The position of the mark is also shown on screen. If the mark is not
situated exactly in the middle of the crosshair, the button
can be used to read the mark
again. If SummaFlex Pro moves the mark it means a new position has been stored.

FIG 3-35
3-35 CORRECTION AFTER RE-READING THE REGISTRATION MARK

If the size of the job (without copies) is larger than the loaded media size, the program will
choose the size of the segments itself. The size of the different segments will not necessarily
be the same. It will depend on the number and positions of the marks. It is also possible that
SummaFlex Pro will advance the media before it will start reading the mark, if this will
optimize the size and positions of the segments.

FIG 3-36
3-36 SEGMENTATION PREVIEW
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3.6 Sorting
Click the blue arrow or double click the text of the sorting macro to start the sorting preview
(see section 3.2.5.1.).
A window will open, the selected objects can be made visible by clicking on the play button.
The objects will be drawn as they are stored in the file.

In the left side of the window are the general selection options and
the option to show the selected objects before sorting or not in the
upper right part of the window.
There is the option to choose all layers to sort together or to sort
layer per layer. It is recommended to make the selection before the
sorting window is open. Make sure all objects, which are cut with
the same tool, are selected. Then sort them all together, whether
they are on one layer or not.
For ‘view complete path’ see below.
There are two basic sorting methods. Sorting by main direction, or sorting by nearest
objects. Both sorting methods have their own specific parameters.
The sorting method that will be used when the sorting option is set on in the output window
will not change if the sorting method is changed in this window. Unless one of the buttons
‘apply settings for output’ or settings for output is clicked.
This gives the user the choice in which
direction the program has to sort. Several
options can be tried out to check which one has
the shortest path length. The shorter the path
length, the faster the job is cut.
Max deviation is the maximum distance (in
either X or Y direction the objects may be
situated before this option is selected in the
sorting algorithm).
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This sorting method will always look for the
nearest object to determine the order in which
the objects are cut. One option is to leave the
origin points as they are. Let them all start at
the same position or let the program change
the start point to minimize the ‘up’ movements
of the tool.
This can be used to show the order on the
screen, in which the objects will be cut. The
slider can be used to raise or lower the
speed at which the preview is shown.
The path length is the distance the tool has to travel in the up
position to complete the objects that are currently selected. This
is a clear indication of the time that will be ‘lost’ during the job.
These are the buttons that control the sorting itself. Click Sort to
apply the chosen sorting method to the objects. Click Reset to get
the objects in their original order. Click Apply settings for output
to copy the current sorting method to the default sorting method
when sorting just before the output is activated (see output
dialogue window). Click Settings for output see below.

This window is used to set the default
sorting method when sorting just before
output is activated.
When the box in front of ‘Sorting settings
for registration marks’ is not checked, then
the sorting order for the objects to be cut
can be set. When the box in front of
‘Sorting settings for registration marks’ is
checked, then the sorting order of the
registration marks can be set.
NOTE: After each sorting check the path length value (bottom left in the sorting
window). If this value increases, a wrong sorting method has been chosen. In this
case either cancel the sorting or sort differently. There is no specific sorting option
that is always best to optimize the order of the objects. It depends on the job and
the way the objects are placed in it.
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3.7 Segmentation
When the job is larger than the length of the table, SummaFlex Pro will divide the job into
segments. Before the program starts sending the data to the table, a preview will be shown.
There are a couple of options for defining the size and places of the segments. If an option is
chosen, a preview will be shown with the place of the segment lines (= segment size). They
can then be changed, if necessary.

FIG 3-37
3-37 SEGMENTATION OPTIONS

Optimize material (max. size + smallest at last). This is normally used when the job is cut
from a roll and if it does not matter where the segments are defined. The segments have the
maximum size and the last one is the smallest one.
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Optimize material (max. size + smallest at first). This is normally used when the job is cut on
a sheet and if the end of the media is 37 cm or less after the last segment line. This way the
machine cannot feed the media forward correctly. Therefore, it is better the last segment is
37 cm or larger. If the option smallest first is chosen, the last segment always has the
maximum size, so there is enough media to feed forward correctly.

This option tries to set the segment lines this way the objects can be cut without them being
segmented. SummaFlex Pro suggests a segment line and shows which objects will be cut per
segment. The preview above clearly shows that in some places the table cuts further then the
segment line. However, in this case this part of the object will not be cut in the following
segment. In the above example the ‘A’ of summa is completely cut in the first segment and
the machine does not cut any part of the ‘E’ in series. Then the media is moved forward and
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nothing of the ‘A’ is cut, but the complete ‘E’ will be cut in the second segment. This way the
objects always close better than if they would have to be cut in segments.

This option divides the entire job into equal parts. This can be useful when the jobs will have
to be applied on different panels, which have the same size.
The fifth option is selectable if a job has already been cut. The type of segmentation was then
automatically saved and the same type can then be chosen when this option is selected.
“Reverse cutting” is for cutting out ‘the negative’ such as for making templates for screen
printing.
The overlap repeats the data of the previous segment in the following segment over the
chosen distance.
This option can only be used if the segments will be applied separately.
The overlap is then the amount that the separate segments will be applied over one another.
If the design must stay in one piece, then the overlap value must be set to 0.
NOTE: When doing print and cut jobs, the segments are set by SummaFlex Pro. This
is done to optimize the mark position in reference to the segments.
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3.8 Most used actions in SummaFlex Pro
This section explains in detail the most used actions in SummaFlex Pro.

3.8.1 Change the assigned tool (changing objects from layer)
If an object is situated in a certain layer, it will be cut with the tool that is assigned to this
layer. If the object needs to be cut with another tool, there are two possibilities. Or the
properties of the layer can be changed, or the object can be moved to the layer that has
already been set up for the tool.
It is recommended to use the last option.
Procedure to change the assigned tool (change the object from one layer to another):
•
•
•

Select the objects.
Click the dropdown box at the top and select the destination layer.
Click the green icon next to the layer that has just been chosen.

FIG 3-38
3-38 CHANGE THE OBJECT FROM THE LAYER
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3.8.2 Most used commands in the view menu
The view menu has a couple of very handy commands. Click View to show the commands.

FIG 3-39
3-39 CHANGE THE OBJECT FROM THE LAYER

Fit page to object: SummaFlex Pro adds a border from 2 mm by default around imported
objects. This is very handy in most cases, especially when contour cutting. However in cases
where the page size is very important (e.g. for multiple copies that need to touch) it is
necessary that the page size (or bounding box) is exactly the same size as all the objects.
Click ‘fit page to objects’, so that the page size is reset. This can also be useable when the
file has been altered in SummaFlex Pro itself (absolutely not recommended for contour
cutting).
Contour View: Selecting this removes fills from objects and only shows the outline. This can
also be useful for routing applications where the routing path is shown by default as a thick
line (the thickness is the size of the router bit). Sometimes this will hide details (e.g. start
paths).
NOTE: The orientation of the curve can easily be changed just by clicking the arrow.
Show object orientation: If this option is selected, the beginning of each curve is marked with
a triangle, which also shows the direction of the curve.
Enhanced view: If this option is chosen, the objects are shown the best possible way
(smoothed). This slows down the speed when rebuilding the view and should thus only be
used for presentation.
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3.8.3 Optimizing material (simple nesting)
A possibility exists to rearrange the objects that need to be cut in SummaFlex Pro, so that
less material is used.
This nesting option is a simple nesting algorithm. It first puts each object in a bounding box
and then it nests the bounding boxes. If a more complex nesting option is needed, an extra
software module needs to be bought.
NOTE: Do not use optimizing material if it is a print and cut job. Nesting is for cut
jobs only.
To optimize the positions of the objects make sure they are selected and go to tools optimize
material. After that the Optimize windows opens.

FIG 3-40
3-40 SIMPLE NESTING

1. Weed border: Is the distance that will be kept between objects.
2. Rotate objects to shorter side: All objects are rotated, so the shorter side points
downwards.
3. Rotate as needed: During optimization all objects are rotated, so they can be
arranged, saving most of the space.
4. Only selected objects: Only the selected objects are optimized. With this option you
can optimize according to layers (colours).
5. Maximum optimization: If this option is activated two more fields are shown. The
option Maximum Optimization calculates more possible combinations that can arise
to end up with maximum optimization. Optimizing can take much time depending on
the size of the objects and the set values. Therefore, do not set used values higher
than 20-30 for the amount of objects and with an optimization level of maximum 5.
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3.8.4 Configuring output profile
Settings in the output window can be saved in Profiles. This in order to avoid, having to
change certain settings in the output window. Below you can find an example on how to do
this. In this case a profile is made for jobs that use sheet material, need a special camera
profile for the markers and with no pause between reading the markers and cutting.
1. Open a job and go to the output window (go to File -> Output… Or use the Output to
device macro).
2. Click Edit next to Mark settings and change it to User defined.

FIG 3-41
3-41 SET THE REGISTRATION MARK TO USER DEFINED

3. Click Roll next to Material and choose sheet.

FIG 3-42
3-42 SET MATERIAL TO SHEET

4. Click Manual-> Production next to production mode and choose production.

FIG 3-43
3-43 SET PRODUCTION MODE TO PRODUCTION

5. Click Manage profiles and choose Add.

FIG 3-44
3-44 SAVE AN OUTPUT PROFILE SETUP

6. Choose a name which clearly explains the profile, fill it out and click OK.
7. Perform the first job and change the camera profile as described in section 3.10.2. After
the job is done, the camera profile will automatically be linked to the profile.
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3.8.5 Cutting from the backside
3.8.5.1 Using the plug-in for Corel or Illustrator
This procedure is for cut jobs only, not for milling jobs. Some jobs require they are cut from
the none-printed side. For this purpose a plug-in for Corel and Illustrator exists, which works
well in combination with a macro in SummaFlex Pro.
Procedure to cut from the backside:
1. Make sure the print data is situated on a separate layer and the cut data on the correct
cut layers.
2. Use the plug in ‘Add SummaFlex Pro marks and cut out squares’.

FIG 3-45
3-45 PLUG-IN FOR CUTTING FROM THE BACK SIDE (COREL AND ILLUSTRATOR)

3. Print out the print layer and the Regmark layer (do not print out the Cut out Square
layer). Make a pdf file of all the cut layers, the Regmark layer and the Cut out squares
layer to open In SummaFlex Pro.
4. Leave the objects in the cut out squares layer and assign a tool to that layer. This tool will
most likely be the same tool that will be used to cut from the backside. Make sure the
parameters of this tool are set correctly for the type of material that is loaded on the table
(use the gears icon or a media profile if one was set up).
5. Click Cutting from the Backside macro.

.

6. In the output window, check if the marker type is set to ‘symmetrical’ or use a special
output profile where this parameter is already preset to this value (see section 3.8.4).

FIG 3-46
3-46 SET PRODUCTION MODE TO PRODUCTION

7. Click output. Place the camera over the first mark and click OK. The table will now read all
the markers and cut out the squares.
8. When prompted by the program, turn the sheet over with the print side down, as shown in
the figure below (watch the markers closely to see the orientation. They are cut
completely through).
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printout
FIG 3-47
3-47 TURN THE SHEET ON THE TABLE (MIRROR IN Y DIRECTION)

NOTE: Look closely at the markers, they should be considered as cut out and show
how the orientation of the flipped sheet looks like.
9. After that continue with the macro as prompted on the screen.

3.8.5.2 Cutting/ Milling from backside general procedure
Most RIP’s set the print and cut marks themselves, so the procedure with the plug-in for
cutting from the backside cannot be used in this case. The procedure below describes what
to do in this case.
There are 2 pairs of macro’s for cutting/milling from the back side. One set for cutting and
one set for milling. The set for cutting consists out of the macro ‘place squares’ and ‘cutting
from the backside’. For milling use ‘Place squares’ and ‘Milling from the Backside’.

1. Open the OXF file from the RIP in SummaFlex Pro.
2. Select all the registration marks ( click on the little blue icon next to the Regmark layer).

3. For cutting Click on the macro ‘Place Squares’, for milling Click on the macro ‘place
circles’.
4. Check the tool and its settings for the correct object (Cut Out Squares for cutting or Cut
Out Circles for milling). Adjust the tool and /or the tool properties, if necessary.
NOTE: If the default values for the Cut Out Squares or Cut Out Circles layer need to
be changed, then see section 1.1.1 .

Cutting / SummaFlex Pro

3-50

F Series

User’s Manual

5. Click ‘Cutting from the Backside’ macro.
or click on ‘Routing from the backside’ for milling

for cutting
.

6. In the output window, check if the marker type is set to ‘symmetrical’ or use a special
output profile where this parameter is already preset to this value (see section 3.8.4).

FIG 3-48
3-48 SET PRODUCTION MODE TO PRODUCTION

7. Click output. Place the camera over the first mark and click OK. The table will now read all
the markers and cut out the squares or mill out the circles.
8. When prompted by the program, turn the sheet over with the print side down, as shown in
the figure below (watch the markers closely to see the orientation. They are cut
completely through).

printout
FIG 3-49
3-49 TURN THE SHEET ON THE TABLE (MIRROR IN Y DIRECTION)

NOTE: Look closely at the markers, they should be considered as cut out and show
how the orientation of the flipped sheet looks like.
9. After that continue with the macro as prompted on the screen.
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3.8.6 Segment helper
The option segment helper is an option to compensate small errors when cutting in panels.
This is used when doing cut only jobs or with contour cutting unstable media (for instance
fabric).
This is a parameter that has to be set on or off per layer.

FIG 3-50
3-50 SEGMENT HELPER

In the layer set the segment helper on or off. Clicking on the status toggles it.
The size of the segment helper is 3 mm in both X and Y direction. Below is a detail of how the
segment helper looks like. X in the figure is the segment helper X size (amount further cut in
first panel) Y is the segment helper Y size (size of the ‘cross’ segment) also cut in the first
panel. The black line is then cut in the following panel.

x

y
FIG 3-51
3-51 SEGMENT HELPER
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3.8.7 Getting rid of ‘double’ objects
When objects are twice defined in a file, then there is a quick procedure to get rid of those
“doubles”.
Below a figure with apparently 16 objects.

16 objects are seen; the program counts 24 objects, so double objects are suspected.
Click Tools -> Welding, choose dialogue. It is possible that the program asks if the lines’
thickness needs to be converted into separate curves. Leave the box unchecked and just
click OK.

Cutting / SummaFlex Pro

3-53

F Series

User’s Manual

The dialogue window in the manual welding can even be used to get rid of double lines which
are not defined exactly one above the other but very close to one another. The minimum
distance to be taken in account can be set. Change the value, if necessary, and click Weld.

Finally go to Design -> Close Contour, because the program splits up the curves in vectors
while it welds them.

NOTE: This procedure can be useful in other cases of bad data also. If the cutting
result shows strange behavior, then try this procedure.
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3.8.8 Set Marks
All registration marks must be defined as circles for SummaFlex Pro to be able to recognize
them as a mark. The printed shape, however, can be something else.
If the file with the cut data has the printed (none circle) marks as definition for the place of
the marks, then SummaFlex Pro has some handy shortcuts to create the necessary marks on
the correct place.
Do not forget to change the Mark settings (Mark type) in the output window (section 3.5.3.3).
Case 1 Marks are Summa OPOS marks (or general symmetrical marks):
Data file has wrong marks

Select the marks and go to Plug-ins Objects Replacer

In the Window choose to replace the objects by Video marks. Check other options, if
necessary (e.g. delete original objects).

The program will now replace all the squares by circles and delete the squares. Give it as
property ‘video mark’ and it will put all those objects in the Regmark layer.
→ Mark settings in the output dialogue will have to be set to ‘symmetrical objects’.

Cutting / SummaFlex Pro

3-55

F Series

User’s Manual

Case 2 None symmetrical marks:
The data file contains wrong marks (crop marks in this case).

Go to edit nodes (see section 0 Macro tabs). Select node(s) (hold shift key down for selecting
multiple nodes) where a mark is printed. Right click Create video mark at the selected nodes.

Afterwards, delete the marks manually. Otherwise they will also be cut out.
→ Mark settings in the output dialogue need to be set as ‘crop marks’.
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Case 3 No Marks printed:
If no marks are printed, then it is usually not possible to cut the job afterwards. However in
some cases it is possible that clear unambiguous cornered shapes with high contrast, printed
in the job, can be used as mark position. For instance, if there is a text printed in the job with
a font that has sharp corners. An example is given below.

Go to edit nodes (see section 0 Macro tabs). Select node(s) (hold shift key down for selecting
multiple nodes) where a mark is printed. Right click on click on Create video mark at selected
nodes. (the selected nodes are marked here with an arrow to show which possible points can
be selected as places for marks).

→ Mark settings in the output dialogue will have to be set to ‘crop marks’.
NOTE: The three above procedures are ‘salvage’ procedures. They should not be
considered as a normal workflow. However, they can be used to save otherwise lost
printouts.
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3.9 Router module settings in SummaFlex Pro
Milling is more than just ‘cutting’ one line. With the miller there are several possibilities. If the
job consists out of milling shapes, then ‘dynamic routing’ can be used. If the jobs are more
complex, SummaFlex Pro has to calculate the routing paths (see section 3.9.4).
There are also a couple of extra things the user will have to decide on. These things are
mostly media dependent.
There is the orientation. This is explained in section 3.9.3.
The user will also have to decide if the job will be milled in one pass or in several passes. This
can be done by using either the milling layer or the milling multipass layer. Here the bit
diameter plays a significant role.
ATTENTION:
1. The recommended maximum milling depth per pass is 1.2 times the router bit
diameter.
2. The recommended maximum complete milling depth (media thickness) is 3 times
the router bit diameter.

3.9.1 Dynamic routing
If the job is just cutting out shapes, then the only parameters SummaFlex Pro needs are the
router bit diameter and the orientation it needs to route. Those two parameters can be set
when setting up the layer for milling (both single pass and multipass). If those parameters
are set, the routing path is shown as a thick outline (thickness = routing bit diameter). If
SummaFlex Pro is set in contour view (see section 3.8.2), then the original line will be
changed into a dashed line and the routing path will be shown as a thin line in the same
colour.

FIG 3-52
3-52 DYNAMIC ROUTING LEFT SIDE NORMAL VIEW RIGHT SIDE CONTOUR VIEW
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3.9.2 Setting up layers for routing
3.9.2.1 Setting up the layer and parameters for milling
Setting up this layer is similar as described in section 3.3.

FIG 3-53
3-53 LAYER SETUP MILLER

There are eleven parameters for the miller, divided in three sets:
General parameters
1. HF Router speed (10000-48000RPM): This is the speed of the HF miller motor. This
setting is ignored if the standard router is used.
2. Speed (mm/s): This is the speed at which the router moves. Reduce this speed for thicker
materials.
3. Down position offset (mm): The milling depth can be adjusted with this parameter. This
parameter can only have positive values. The maximum milling depth is calibrated with
Axis Control. This parameter can be used if the router has to mill less deep than the
calibrated depth.

Cutting / SummaFlex Pro

3-59

F Series

User’s Manual

Dynamic routing parameters
4. Dynamic tool parameter compensation: This parameter sets whether the routing path will
be on the defined line, or at an offset to it (the offset will be half the diameter of the
routing bit – see further).
5. Tool diameter (mm): Here the diameter of the routing bit is set.
ATTENTION: The tool diameter has to be set to 0 if the routing path was already
defined in the design.
6. Change bit before routing: If this is set to on, then the table will pause just before it starts
with this layer to give the user the possibility to change the routing bit. This parameter
cannot be used if there is no ADC installed on the table.
7. Tool diameter compensation: This parameter determines whether the routing path will be
defined inside or outside the object. However, if objects are defined one into another, then
the routing path switches from side for the objects that are inside another object. The
picture below illustrates this.

FIG 3-54
3-54 COMPENSATION IS SET AT OUTSIDE

FIG 3-55
3-55 COMPENSATION IS SET AT INSIDE

8. Tool diameter compensation for open objects: If there are lines in the design, which are
not closed, then they usually need to be routed on the line itself. Use this parameter to set
it up like this. If the routing path is routed at an offset of an open object, then the routing
line will be under or above the line according to the direction of the line segments of the
line.
Other parameters:
9. Orientation: This sets the orientation of the routing path. This parameter is media
dependent and is best tested out first. (see section 3.9.3)
10. Start tool path: If this option is activated, the tool will use a circular arc movement
towards the curve that needs to be milled, unless there is a line in the curve. In that case
it will start at that point.
11. Pause after tool: If this option is activated, the machine pauses after the use of this tool.
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Setting up the layer and parameters for milling multipass

Setting up this layer is similar as described in section 1.1.1.

FIG 3-56
3-56 LAYER SETUP MILLER MULTIPASS

There are seventeen parameters divided in 4 sets for the milling multipass.
General parameters:
1. HF Router speed (10000-48000RPM): This is the speed of the HF miller motor. This
setting is ignored if the standard router is used.
2. Speed (mm/s): This is the speed at which the router moves. Reduce this speed for thicker
materials.
3. Material thickness (mm): Is the total media thickness.
4. Milling depth (mm): Is the depth that needs to be milled. This is usually the same value as
the media thickness.
5. Max depth per pass (mm): Thick materials cannot be milled in one pass; the parameter
sets the maximum depth per pass.
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Parameters for last pass:
The last pass can be used as a cleaning pass (see section 3.9.4.5). If dynamic routing is
used, then use these parameters to configure the last pass.
6. Speed of the last pass: With this parameter the speed of the last pass can be set. A lower
speed can result in smoother finishes. This speed setting is normally used when the last
pass is used as a finishing pass. Refer to the routing bit tables of the routing bit
manufacturer for commonly used settings.
7. Depth of last pass (mm): This is the milling depth of the last pass. SummaFlex Pro
calculates the amount of passes it needs, depending on the values of the milling depth,
the maximum depth per pass and the depth of the last pass.
NOTE: If the last pass does not need special settings, then set the value at 0.
NOTE: Milling exerts large forces on the piece that is routed. Therefore, the
thickness of the last pass is relatively small. Small enough so the forces exerted
during routing are not too large, but still large enough, so the milled piece remains
fixed until it is completely milled. Commonly used values are between 0.5 and 1 mm.
These values are dependent on the material that is milled, the diameter of the routing
bit and the setting of the routing bit’s depth.
8. Cleaning path: This sets the cleaning path on or off. If the value is set to on, the last pass
becomes the cleaning path. It is used to get a better finish for routing and is also used
when routing relatively small objects. However, if a value is set to on, all the passes before
the last pass are milled at an offset.
9. Cleaning path offset in %: This sets the size of the offset of the other paths to the cleaning
path. (Absolute value is the % value of half the tool diameter).
ATTENTION: The tool diameter needs to be set to 0 if the routing path was already
defined in the design.
Dynamic routing parameters:
10. Dynamic tool parameter compensation: This parameter sets whether the routing path will
be on the defined line, or at an offset to it (the offset will be half the diameter of the
routing bit – see further).
11. Tool diameter (mm): Here the diameter of the routing bit is set.
ATTENTION: The tool diameter needs to be set to 0 if the routing path was already
defined in the design.
12. Change bit before routing: If this is set to on, then the table will pause just before it starts
with this layer to give the user the possibility to change the routing bit. This parameter
cannot be used if there is no ADC installed on the table.
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13. Tool diameter compensation: This parameter determines whether the routing path will be
defined inside or outside the object. However, if objects are defined one into another, then
the routing path switches from side for the objects that are inside another object. The
picture below illustrates this.

FIG 3-57
3-57 COMPENSATION IS SET AT OUTSIDE

FIG 3-58
3-58 COMPENSATION IS SET AT INSIDE

14. Tool diameter compensation for open objects: If there are lines in the design, which are
not closed, they usually need to be routed on the line itself. Use this parameter to set it up
as such. If the routing path is routed at an offset of an open object, then the routing line
will be under or above the line according to the direction of the line segments of the line.
Other parameters:
15. Orientation: This sets the orientation of the routing path. This parameter is media
dependent and is best tested out first. (see section 3.9.3).
16. Start tool path: If this option is activated, the tool will use a circular arc move towards the
curve that needs to be milled, unless there is a line in the curve. In that case it will start
at that point.
17. Pause after tool: If this option is activated, the machine pauses after the use of this tool.

Cutting / SummaFlex Pro

3-63

F Series

User’s Manual

3.9.3 Routing orientation
The routing orientation is a parameter that is media dependent and that influences the
milling quality substantially. It also affects the life time of the routing bit. Always try and
follow the recommendations of the manufacturer of the media or routing bit. When this info is
not available, try both settings (CW and CCW) and check the quality. When objects are
defined inside other objects and they are selected together for calculating a routing path,
SummaFlex Pro alternates inside and outside and clockwise and anticlockwise when the
routing path is calculated. It makes no difference if the objects are grouped or not or if they
are combined or not (SummaFlex Pro un-combines objects by default to get a higher
accuracy for cutting). The changing of the orientation is necessary, so the inside is milled the
same way as the outside (climb milled or conventionally milled).
NOTE: As a rule, metals are climb milled and (soft) plastics are conventionally milled.
However, aluminum covered sandwich board is conventionally milled and some hard
plastics are climb milled when the router bits are smaller than 4 mm.

FIG 3-59
3-59 CLIMB – “DOWN” MILLING (CLOCKWISE)

FIG 3-60
3-60 CONVENTIONAL – “UP” MILLING (COUNTERCLOCKWISE)
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3.9.4 Different routing applications
Apart from the dynamic routing, there are other router applications possible. This section
explains the different routing possibilities.

3.9.4.1 Calculating the inside or outside path
In order to mill an inside or outside router path, follow the below procedure.
1. Select the objects, of which the paths will have to be calculated. Then go to Tools >Milling/Hatching or type ‘f’

FIG 3-61
3-61 CALCULATING THE ROUTING PATH

2. A window with the routing options is shown. When calculating an inside or outside routing
path, then only the right side of the window is used. First choose the inside or outside
routing path. Then choose the adjustment layer.

FIG 3-62
3-62 ROUTING PATH OPTIONS
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FIG 3-63
3-63 INSIDE ROUTING PATH CALCULATED

FIG 3-64
3-64 OUTSIDE ROUTING PATH CALCULATED

1. Tools diameter: The thickness of the router bit needs to be filled out here, so the
program can make the correct calculations.
2. Adj. layer: This is the output layer for the routing path. Choose between milling
multipass or milling, depending on the thickness of the material.
3. Layer inf: The layer name can be altered but the new layer will still use the milling
tool. This is useful if a difference has to be made between milling layers (e.g. for
different parameter settings for the miller).
4. None: This radio button is grayed out if the option inside or outside path is chosen.
5. Adjustment: Check this radio button if the side of the routing path has to be exactly
on the object contour line.
6. Adj value: Check this radio button if an extra offset between the routing path and the
object contour line is needed. The filled out offset will be an offset between the
center of the routing bit and the contour line of the object.
7. Orientation: Choose the orientation of the routing path.
8. Fixed size: If this option is checked, the size of the new created routing path cannot
be altered any more.
9. Fixed size for output: If this option is checked, the size of the new created routing
path will not be changed when doing print and cut. Only the position of the object to
the printed register marks will be adjusted.
When two different milled parts have to fit exactly in one another, the corners will have to be
rounded before the routing path is calculated. Select the objects (corners) that need to be
rounded. Go to Design  Round corner (Shift Ctrl R). When choosing the radius, be sure that
this is a bit larger than the radius of the routing bit.

FIG 3-65
3-65 ROUNDING CORNERS
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3.9.4.2 Calculating a hatch or island fill
An island or hatch fill arises when an object is filled and then milled. This can be used to
emboss objects or text or to create a hole for an inlay.
1. Select the objects, that need to be filled. Then go to Tools ->Milling/Hatching or type ‘f’

FIG 3-66
3-66 CALCULATING THE FILLING AREA

2. A window with the routing options is shown. First choose the filling type (hatch or island).
The figure below shows the difference between an island fill and a hatch fill. The routing
paths are shown as a yellow line in the objects.

FIG 3-67
3-67 ROUTING PATH HATCH FILL

FIG 3-68
3-68 ROUTING PATH ISLAND FILL

3. First set up the layers. The target layer is the layer where the fill will be created in. The
adjustment layer is the layer in which the routing path around the fill we be created if an
offset (adjustment) is chosen. If the option ‘None’ in the path adjustment options is
chosen, the routing path around the fill will be created in the same layer as the fill and it
will be created with the center of the bit on top of the outline contour of the object.
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FIG 3-69
3-69 FILLING OPTIONS

1. Tools diameter: Here the thickness of the router bit needs to be filled out, so the
program can make the correct calculations.
2. Target layer: This is the output layer for the routing path of the fill. Choose between
milling multipass and milling, depending on the thickness of the material.
3. Hatch angle: The angle of the hatch lines can be changed with this parameter.
4. Delete original: If this option is checked, the original object will be deleted if the fill
has been created.
5. Pocket connection: This can be used to reduce the number of up/down movement
during milling. If this option is checked, the miller will not be raised between the
different lines of the hatch fill or the different ‘contours’ of the island fill.
6. Optimize: This option might shorten the milling time and is used in combination with
pocket connection. However, it might lower the milling quality.
7. Overlap: This sets the overlap between the hatch lines or islands contours (in % or
absolute).
8. Adj. layer: This is the output layer for the routing path (analogue to target layer).
9. Layer inf.: The layer name can be altered but the new layer will still use the milling
tool. This is useful if a difference needs to be made between milling layers (e.g. for
different parameter settings for the miller).
10. None: Already explained when setting layers.
11. Adjustment: Check this radio button if the side of the routing path needs to be
situated exactly on the object’s contour line.
12. Adj. value: Check this radio button if an extra offset between the routing path and the
object contour line is needed. The filled out offset will be an offset between the
center of the routing bit and the contour line of the object.
13. Orientation: Choose the orientation of the routing path.
14. Fixed size: If this box is checked, the size of the new created routing path cannot be
altered any more.
15. Fixed size for output: If this box is checked, then the size of the new created routing
path will not be changed when doing print and cut.
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3.9.4.3 Embossing text (or objects)
When SummaFlex Pro does a fill of object 1 and there is a closed object 2 in this fill, then this
object 2 will not be filled. However, if there is another object 3 in object 2, this object will be
filled. The same happens for all the objects inside. Below is a picture showing 4 objects into
one another and showing how SummaFlex Pro will fill them.
In the example below, the fill was island fill and the overlap was set greater than the router
bit size in order to show more clearly what happened. These are not settings that will be used
in production but merely settings to clarify how the filling works.

FIG 3-70
3-70 FILLING OBJECTS IN OBJECTS

So when text needs to be embossed, just put a rectangle around it. In the sample below the
fill was set to hatch fill and the overlap was set greater than the router bit size in order to
show more clearly what happens (see remark above). The difference can be seen when the
text has a rectangle around it or not.

FIG 3-71
3-71 TEXT WITH RECTANGLE AROUND IT
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3.9.4.4 Creating bridges
Sometimes small parts move during routing. This affects the overall quality. In order to avoid
this, small ‘bridges’ can be created to hold those small pieces in place.
To create a bridge, follow the below procedure.
1. Select the routing path (click on routing path). Select to edit nodes (use macro ‘edit
nodes’ in the macro tab, see section 0). Then select a node where the bridge needs to
come (click on the node), or add a node (right click on the routing path and choose add) if
there is no node in the area where the bridge needs to come. Select that one (click on the
new node).

FIG 3-73
3-73 INSERTING A NODE

2. Check in the standard settings menu under the settings menu if the size of the bridge is
set correctly. If not, change it.

FIG 3-74
3-74 SET THE BRIDGE SIZE

3. Right click on the selected node and choose to add bridge. The result is a routing path
that is interrupted.

FIG 3-75
3-75 INSERT BRIDGE
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3.9.4.5 Cleaning pass
It is recommended to have a final pass with a thickness of +/- 0.5 mm,
even if the bit could route the material in a single pass. If the final pass
has less material to remove, the dust extraction system will be more
effective and the table will be cleaner after the job. A general difficulty
when routing completely through a material is that pieces are moving on
the table and are hit by the routing bit. A small finishing pass keeps all
pieces in place until the last pass. And as the last pass contains limited
material only, the used forces are less and the risk that pieces move is
smaller. The cleaning pass is visible in red in the figure to the left.
If dynamic routing is used, a cleaning pass can be set with the tool parameters in the layer
setup. However, if the routing paths are defined manually, the parameter settings of the last
pass are more flexible (separate speed settings, separate bridge definition,..)
1. Select the objects whose paths will need to be calculated. Then go to Tools >Milling/Hatching or type ‘f’.

FIG 3-77
3-77 CALCULATING THE ROUTING PATH

2. A window with the routing options is shown. Choose the path adjustment (inside or
outside) and set the tool diameter. Then choose the adjustment layer (milling or milling
multipass, depending on the thickness of the material). Click the radio button next to Adj,
value and fill out a value, which is higher than half the diameter of the router bit (r+ 0.3 to
r+0.5). Choose the router direction (CW or CCW). Click OK.

FIG 3-78
3-78 CALCULATING THE ROUTING PATH
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3. Select the objects, whose paths will need to be calculated again. Go to Tools >Milling/Hatching or type ‘f’. A window with the routing options is shown. Choose the
same setting as in step 2, apart from the adjustment layer. This now needs to be milling.
Click the radio button next to adjustment, so that the offset is set again on half the tool
diameter.

FIG 3-79
3-79 CALCULATING THE CLEANING PASS

NOTE: If the layer in step 3 is also the milling layer, a second milling layer with as
tool the miller will have to be created (see section 1.1.1).

NOTE: If bridges will be used, use them in this last cleaning pass only.

4. Set the parameter Down Position Offset in the layer set in step 3 to a value between 0.5
and 1 mm.

FIG 3-80
3-80 SETTING THE DOWN POSITION OFFSET
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3.10 Camera – media calibrations
3.10.1 Basic calibration of the camera and registration mark recognition
This section is for SummaFlex Pro only. SummaFlex Pro has no camera support.
This calibration makes sure the flatbed cutter cuts on the exact place it should cut. The
calibration consists out of two parts. It is recommended to do both calibrations if there is an
offset problem.
The first part of the calibration calibrates the resolution of the camera (#pixels/mm). The
second calibration calibrates the physical distance between the center of the camera and the
knife.
A cutting tool will have to be mounted on the flatbed cutter and it should be calibrated to cut
normal vinyl (the second calibration will have to be done on black vinyl with white backing).
The tool should be mounted in the most left module, since SummaFlex Pro uses the most left
module for the second part of the calibration.
NOTE: It is recommended to do the first calibration with the actual printer that will
be used for the print and cut jobs. However, it can also be done with a desktop
printer (this will make the recognition of the registration marks less accurate).
1. Make sure the flatbed cutter is connected and switched on and the SummaFlex Pro
security key is connected. Keep a piece of black vinyl with white backing ready and mount
the drag head module and drag knife. Start SummaFlex Pro.
2. Go to File -> Open and open 0701080001.job.

FIG 3-81
3-81 OPEN JOB
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3. Export the file to an EPS or PDF file so it can be used to print out on the printer that will
be used for the print and cut job. If this printer is not available, this job can also be
printed out on a normal desktop printer. Go to File -> Print. Make sure the file is printed
out on scale 1:1 (click on the button).

FIG 3-82
3-82 PRINTING THE JOB FOR CAMERA CALIBRATION

4. Assign a cutting tool to the cut line. For this, click on ‘Default’ under ‘Cutpath’ and choose
the most left installed tool. Click on Macros if the view at the right side of the SummaFlex
Pro window is not the same as in the picture below.

FIG 3-83
3-83 SETTING TOOL
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5. Load the printout on the flatbed cutter. Go to File -> Output… Or use the Output to device
macro (click the blue arrow). A window will open. Click the read material button to check
if the communication with the flatbed cutter functions.

FIG 3-84
3-84 OUTPUT WINDOW

6. Click the preview button. Another window will open. Use the arrow keys to move the
camera until it is situated over a registration mark (black circle is visible). Move the cursor
in the camera view area, right click and then go to Default settings -> Mark recognition.
The window will expand at the bottom to show the calibration options.

FIG 3-85
3-85 REGISTRATION MARK RECOGNITION
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7. Click ‘Move to mark’ and then click ‘Measure’. Click ‘Move to mark’ again to check if the
orange and the green circle fit on top of each other. If the green circle hides the orange
circle, then the measurement has succeeded. Click ‘Save’ to save the result.

FIG 3-86
3-86 MEASURING REGISTRATION MARK

Explanation of the colours in the camera window:
1. A red circle means the program has recognized the shape as a registration mark,
but it is not yet in the recognition area for accurate recognizing.
2. A green circle means the program has recognized the shape as a registration mark
and it is in the recognition area for accurate recognizing.
3. The orange circle is where the program thinks the registration mark is situated and
how large it is.
4. The orange square is the accurate recognition area. The center of the registration
mark needs to be in there for accurate recognition.
ATTENTION: If more than one camera is attached to the computer, it is possible the
program chooses the wrong camera. This can be changed in this window. Just click
the dropdown box at the top of the window and choose the videology USB camera.
ATTENTION: It is recommended to disable all other cameras connected to the
computer, if possible. Otherwise these cameras can interfere with SummaFlex Pro.
Extra cameras generate extra data stream on the USB port and may result in data
loss.
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8. Click the Axis Control icon and deactivate the vacuum. Remove the printed sample and
replace by black vinyl with white backing (make sure there is a big contrast between vinyl
colour and backing colour). Switch the vacuum on again and go to SummaFlex Pro. Right
click on the camera area and go to Set camera offset.

FIG 3-87
3-87 SET CAMERA OFFSET

9. Move the head to an area where there is nothing cut in the vinyl. Click Cut Mark. Wait for
the machine to cut a circle with the mark size and a rectangle around it. Peel the
rectangle around the circle. Use the arrow keys to move the camera until it is situated
over a mark (black circle is visible). Click Measure. Click Save to save the measured offset.

FIG 3-88
3-88 CAMERA OFFSET MEASURED

NOTE: If the calibration has to be redone, choose another position away from the
already used positions.
NOTE: The basic setting-up and calibration for SummaFlex Pro is now done and can
be used. It is recommended to further refine the setup of the program, so it fits in
the normal used workflow. Once this is done a user profile can be made, so as much
unnecessary options and settings as possible are hidden.

Cutting / SummaFlex Pro

3-77

F Series

User’s Manual

3.10.2 Configuring the camera profile
Special combinations of registration mark colour/ media colour or media texture might need
special camera profiles. Such profiles can be made by the user. Although it is recommended
that those profiles are made by the dealer or Summa. There are some profiles already preinstalled when SummaFlex Pro is installed.
They can be found in the directory C:\Program Files\Summa\SummaFlex Pro\cutter\img.
The procedure to install extra profiles or to change the profile in SummaFlex Pro is described
below.
1. If the dealer sends new profiles, copy them in the profile directory.

FIG 3-89
3-89 CAMERA PROFILE DIRECTORY

2. Start the job in SummaFlex Pro in the output window. Click Mark type and change it to
User defined.

FIG 3-90
3-90 CHANGE THE REGISTRATION MARK SETTINGS

3. Click the preview button. Another window will open. Move the cursor in the camera view
area, right click and then go to Default settings -> Mark recognition.

FIG 3-91
3-91 MARK RECOGNITION
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4. In the dropdown box next to ‘Profile’, choose the correct profile.
ATTENTION: Only use a different camera profile from the standard one if the reading
of the registration marks gives problems. If the camera profile is not necessary
anymore, then it suffices to set the mark type to circle again. It is not necessary to
set the camera profile to its default value again (0.ipp).
NOTE: It is advised to define special output profiles for different configured camera
profiles, see section 3.8.4.
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3.11 Tandem mode (not for F1612)
With the Tandem Mode, the active working area on the flatbed can be divided into front and
back processing areas, which enables the user to load and unload material on one end of the
table while cutting material on the other end of the table. This will avoid idle periods during
the processing of material, which will add significant value to the overall workflow.

FIG 3-92
3-92 TANDEM MODE

3.11.1 Setting up the tandem mode
In order to facilitate loading the jobs on the table, it is recommended to mark the place
where the media has to be loaded. It is not necessary to do this each time the tandem mode
is used. Only when the lines are faded, is it necessary to redraw them.
1. Go to the media menu in Axis Control.
2. Go to ‘Set origin’. Click the pointer button. Move the carriage as far as possible to the
front and to the right. Mark this point on the conveyor.
3. Move the carriage 15 to 20 cm to the left (make sure the carriage does not move to the
back. Mark this point also.
4. Move the carriage back as far as possible to the right and then move the carriage 15 to
20 cm to the rear (make sure the carriage does not move to the left). Mark this third point
also.
5. Now, move the carriage out of the way and draw a line from the origin to the two other
points. Afterwards, move the carriage back to the origin and click OK.

FIG 3-93
3-93 ORIGIN MARKED
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1. Go to ‘Set media size’. Click the pointer button. Move the carriage as far as possible to the
back and to the left. Mark this point on the conveyor (“full size mark”).
2. Move the carriage 15 to 20 cm to the right (make sure the carriage does not move to the
front). Mark this point also.
3. Move the carriage back as far as possible to the left and then move the carriage 15 to 20
cm to the front (make sure the carriage does not move to the right). Mark this third point
also.
4. Now, move the carriage out of the way and draw a line from “full size mark” to the two
other points.
5. Move the carriage back to “full size” and click OK.
6. This marks the opposite origin for the tandem mode.

FIG 3-94
3-94 ORIGIN AT THE OPPOSITE SIDE MARKED

Now that the conveyor is marked, the front and rear origin point and the conveyor are in the
correct position to start the tandem mode. If the position of the conveyor and origin points
needs to be set correctly after the conveyor has moved because of another job, then do
following to set the positions correctly again:
1. Check if the front origin point is visible at the right side. If this is the case, go to the media
menu in Axis Control, go to ‘Set origin’ and click the pointer button.
2. Now, set the pointer above the corner of the origin mark and click the feed button.
3. If the origin mark is not possible, then click ‘feed’ and feed the conveyor for 3000 mm.
Execute a check once more.
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3.11.2 Using the tandem mode in SummaFlex Pro
The tandem mode is used to cut multiple copies over different sheets. Axis Control is used to
let SummaFlex Pro know if the media is loaded or not. If SummaFlex Pro does not get a
signal that the media is loaded, then it will send a message to the user through Axis Control,
informing him where to load the media. Whilst the table is cutting on one side, follow
following steps:
1. Import the job in SummaFlex Pro. Set the tool parameters correctly and launch the job.
Select the tandem mode in the output window.

FIG 3-95
3-95 SELECT TANDEM MODE IN OUTPUT WINDOW

2. If it is a print and cut job, fill out the number of copies in the list of the OPOS parameters
“total number of copies” (left side of the figure).
3. If it is a cut only job, then fill out the number of copies next to “number of jobs” (right
side of figure).

FIG 3-96
3-96 NUMBER OF COPIES TANDEM MODE
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4. Click on the output button. Axis Control will ask to put the media at the front side of the
table. If Axis Control is not running in the foreground, a message will appear in the lower
right corner of the screen. Click it. If Axis Control is running on the foreground, the
message appears in the event area of Axis Control. Click OK if the media is loaded.

FIG 3-97
3-97 MEDIA LOAD MESSAGE START TANDEM MODE

5. If it is a print and cut job, the camera will go to the origin and wait for the user to set the
camera above the first mark. If there are multiple copies in one job, then either fill out the
distance between the copies in advance, or set the production mode on manual - >
production, so SummaFlex Pro can learn the distance between the copies. After reading
the marks, a button “Release Area” will appear in the Axis Control windows. While the first
job is cut on the table, the rear beam between the two safety poles is disabled. The user
can pass through and load the media on the rear area of the table. After loading the
media, click the button ‘Release Area.

FIG 3-98
3-98 AREA RELEASE BUTTON TANDEM MODE

6. This procedure can be repeated until all copies are cut. If the user loads the media while a
copy is cut at the other end of the table and clicks on the Area release button, the cutting
process will not be interrupted until all copies are cut. If the media is not ready, Axis
Control displays a message, similar to the first message, which Axis Control gives at the
start of the procedure, and waits.
NOTE: With a print and cut job, SummaFlex Pro will come to the foreground each
time the marks are read. Click the Axis Control icon in the taskbar after the marks
have been read in order to get Axis Control on the foreground again.
NOTE: Make sure the jobs for the tandem mode are shorter than 1300 mm. If the
job is larger, then it will be clipped at 1339 mm when the media is loaded at the
front and at 1339 mm when the media is loaded at the rear.
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3.12 Continuous workflow fixed feed
The continuous workflow method is mostly used on the F1612 in combination with a table at
the back and in front of the machine. If the job consists out of multiple copies on multiple
sheets, the sheets can then be loaded at the back, while the machine is cutting a job.
To this purpose, a table is placed in front of and behind the machine.
In order to enhance easy loading, draw the origin lines on the mat (2) (see section 4.1.6) and
apply rulers on the table, which is placed at the back (1).

FIG 3-99
3-99 PREPARE F1612 FOR CONTINUOUS WORKFLOW FIXED FEED

Follow the procedure below for the continuous fixed feed workflow for sheets.
1. First set the media size. The width is equal to the width of the job. The length is set at its
maximum (1200 mm). Load the first copy at the back of the table. Multiple copies may be
loaded next to one another. Make sure to stay within the drawn origin lines.

FIG 3-100
3-100 LOAD FIRST COPY
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2. The recommended length of the sheets is between 560 mm and 1150 mm. The minimum
size is 300 mm (otherwise the sheet cannot be loaded). Subtract 550 mm from the sheet
length. Remember that value. If the table behind the F1612 is put as close as possible to
the F1612 and the rulers start at 0 mm from the side of the table, the sheet needs to be
loaded right up to the mark with the obtained value. For instance, in the figure below, the
sheet size is 700, which means the sheet is loaded at the 150 mm mark.

FIG 3-101
3-101 LOAD FIRST COPY

3. Go to the Axis Control media menu and feed a 1200 mm. The sheet will now be
transported to the beginning of the table.

FIG 3-102
3-102 LOAD FIRST COPY

4. A second job can be put on the back of the F1612 and can be aligned the same way as the
first one; with the ruler on the table behind the machine. Go to SummaFlex Pro and load
the job. Check if the orientation on screen is correct and if the correct tools (with the
correct tools settings) are selected in SummaFlex Pro. Click ‘output to device’. Then set
the mode to ‘Output assignment Fixed Feed’.
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FIG 3-103
3-103 START OUTPUT

5. Choose the number of copies if more copies are placed next to one another. Then fill out
that value next to the number of copies in the Y direction.
NOTE: It is not possible to put multiple copies in the X direction (because of a
feeding issue), so the copies have to be processed row per row.
6. Start the job by clicking on the Output button. Navigate the camera above the first mark
and click OK. The first job(s) will be processed.
7. After the first job is done, the F1612 will move the media forward and put it on the table
in front of the F1612, while the second row is loaded. The F1612 will continue to process
this job without user interference. While this job is cut out, the operator can put the next
job on the table, positioned at the back of the F1612 the same way in which the other
sheets were loaded.
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3.13 Barcode workflow
The camera of the F Series can also read barcodes. Certain RIP’s have the ability to print a
barcode together with the OPOS marks. This barcode can then be used to identify the job and
retrieve the needed cut data automatically from the computer.
The program Axis Control reads the barcode and supplies the info to the program
SummaFlex Pro in order to open the file with the cut data and send the data to the cutter.
After finishing the job, the program SummaFlex Pro returns control to the program Axis
Control, so it can verify whether another job with a barcode is printed. If this is the case the
whole procedure repeats itself.
Check page 4-8 on how to calibrate Axis Control in order to read the barcode correctly.
Make sure to do this before setting up SummaFlex Pro for a barcode workflow.
The installation manual describes how to install the license for the barcode flow option in
section 2.

3.13.1 Parameter settings in SummaFlex Pro for barcode workflow
There are a couple of extra settings that need to be checked/changed. Start SummaFlex Pro.
1. Click Settings. Go to Standard settings Miscellaneous. Click it.

2. Make sure the box in front of “Don’t ask for save on exit” is checked. Click the OK button.

3. Click Settings. Go to Standard settings Filter. Click it.
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4. Make sure the boxes in front of “Separate layers by name”, is checked.

5. Click the OptiSCOUT button.
6. Make sure the box in front of “Create a new job”, “… and close active job” and “Get jog
marks from layer” is checked. Make sure the box before “After Drag’n Drop rotate objects
using an angle of” is not checked.

7. Click the OK button. In the OptiSCOUT import window. Then click the OK button in the
Import/Export window.
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3.13.2 Setup of a general barcode workflow profile
A standard profile for the barcode workflow is installed when the program SummaFlex Pro is
installed. A couple of settings need to be adjusted/checked. Follow the below procedure to
set up a correct profile.
1. Click on the production tab, then click on the dropdown box next to ‘Standard’ in the
upper right corner and select Summa Postnet.

2. Click the gear icon on the upper right corner next to Summa Postnet.

3. Select Edit profile.
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4. In the profile window, click the barcode tab.

5. Click the dropdown box after Summa Postnet PDF and click Summa Postnet OXF.
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6. Click the more icon ( ) next to Summa Postnet OXF. Check if the string “ .*{0}.oxf ” is
filled out next to the Extended comparison field. If not, fill it out. Click the save button.

7. Click the more icon ( ) next to Directory for cut files. Then locate the directory where
the barcode files from the RIPS are stored and click the OK button.

8. Before clicking on the save button , compare settings again with figure above and make
sure they are set the same. Then click the save button.
9. Put the media on the table with the registration marks printed on it. Set the origin of the
media above a registration mark. Use the camera as described in section 1.6.1.3.
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10.Click the production tab. Click the gear icon in the upper right corner and select “Camera
settings”. Click the “Adjust” button so the size of the mark is calibrated (the X and Y value
will change to a value between 125 and 140).Then click “Move to mark”. The camera now
moves above the mark. Click the “Save” button.

11.Check the tool setting. Once the barcode workflow is set in motion, there is no possibility
to change the tool or tool parameters. So these settings have to be checked before a
barcode job is started. To do this, import a file from the barcode directory. Check the tool
settings. Adapt if necessary (see section 3.13.3.1 for extra options).
12. Also check the sorting order for the reading of the registry marks. To do this, import a file
from the barcode directory. Then click on the ‘Sort with simulation’ macro. Then click the’
View default settings’ button (bottom right). In the new window check the box before
‘Sorting settings for registration marks’ and fill the rest in as in the picture below. Then
click Apply and OK.

13. Now the barcode profile is set up and ready for a first test. It is recommended to do a
separate test first in order to check if Axis Control can read the barcode correctly. This
test is described in section 4.1.6. Put a printed barcode on the table, do the test and
adjust the parameters, if needed, as described in section 4.1.6.
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14.First make sure Axis Control is running (it should always be running while the table is
switched on). To run the barcode workflow, choose the correct barcode workflow profile
first. Click the green triangle.

15. Axis Control will appear in the foreground with a window showing what the camera is
registering. Use the arrows in that window to position the camera above a piece of the
barcode (such as in the figure below) then press “Apply”.

16. The barcode will now be sensed. If the barcode is recognized, it will send the result to
SummaFlex Pro and go to the background. SummaFlex Pro will open the file with the cut
data (if it is found in the cut file folder). The marks will be sensed and the vectors will be
cut automatically. The beginning of the next barcode will be searched for. Once it is
found, the whole procedure will repeat itself.

Cutting / SummaFlex Pro

3-93

F Series

User’s Manual

3.13.3 Setup additional barcode workflow profiles
The previous section describes the general barcode workflow. In most cases this will be
sufficient for working roll to roll with standard tool settings. There are, however, some extra
settings usable in the barcode workflow for specific jobs.
The parameters, visible in the general device setting of the profile, can differ a bit depending
on the installed SummaFlex PRO version. However, if certain parameters are not visible, they
can easily be added.
The figure below shows the recommended parameters, that need to be set visible. However,
if they are not used, it is not necessary to make them visible.

If the parameters are not visible then do following to add them:
Click the add parameter button.

Then select the parameter that needs to be in the list by clicking it. The parameter is selected
when the background of the parameter becomes light grey. Click ‘add’.
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Do this for all the parameters that need to be in the list.

3.13.3.1 Setting up barcode workflow with specific tool settings
Specific palettes can be prepared and then used in a separate profile, so it is not necessary
to change the palette before each barcode job. Just choose the correct barcode workflow
profile that automatically opens the correct palette.
1. To prepare a palette, open SummaFlex Pro and click the Layer tab (1). Right click in the
list of layers. Change a specific setting (3) in the layer window, or assign appropriate tools
(4), or choose a preset material (5) (see section 3.3- setting up layers). Click OK.

FIG 3-104
3-104 SETTING UP LAYER FOR BARCODE WORKFLOW

2. Save the altered palette under a recognizable name to the material directory of the
barcode workflow. This directory is “C:\Program Files (x86)\Summa\SummaFlex
Pro\Materials\SUMMA F-SERIES CAM”
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3. To make an additional profile with the tool settings as set in the palette that was just
made do following:
4. Make sure the normal profile is selected. Click the gear icon and select edit copy.

5. In the newly opened window, change the profile name to an easy recognizable name.
Select the palette with the correct tool settings next to Material.

6. Click the save button

3.13.3.2 Setting up barcode workflow for sheet mode
1. Make sure the normal profile is selected. Click the gear icon and select edit copy.
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2. In the newly opened window, change the profile name to an easy recognizable name. Set
the Material parameter to sheet, the Feed after last segment to off and Option group park
position to End. Other parameters can be changed to the user’s convenience, but the
previously mentioned parameters need to be set as such.

3. Click the save button.
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4

Axis Control, remote & Plug-in

4.1 Axis Control
Axis Control is standard delivered software that gives full control over the flatbed. The
optimized design for touch screen control makes Axis Control the optimum interface for the
machine operator.
ATTENTION: Always start up Axis Control before the machine is switched on or
before the remote is connected. Close Axis Control always as last.

4.1.1 Main Window

FIG 4-1
4-1 AXIS CONTROL MAIN WINDOW

After starting up the flatbed and the program, the window as above is displayed.
The top of the window contains info about the flatbed.
Media info:
Displays the currently set media size.
Click left in the area to set the origin procedure. The origin jumps to the position clicked (at
least to the nearest 100 (3.9”)). Adjust with the arrow keys, if necessary. Click

to

to leave the origin unchanged.
confirm or
Click right in the area to set the size procedure. The size jumps to the position clicked (at
least to the nearest 100 (3.9”)). Adjust with the arrow keys, if necessary. Click
confirm or

to

to leave the size unchanged.

Module info:
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Info about modules/tools. The mounted tool is shown and the up /down value and the speed
set for internal tests. This info is very useful to quickly check if the up position is set high
enough for the loaded media. Click the tool to go directly to the module menu with that tool.
Last machine event:
Here the last message, sent from the flatbed to the computer, is displayed. This message
disappears if it has been acknowledged by the user.
Status:
This part displays the status of several items that are being monitored.
USB: can be green (connected) or red (not connected).
Remote controller: can be green (activated), orange (SummaFlex Pro is controlled by remote)
or gray (not activated).
Emergency stop: can be green (machine ready), red (emergency stop pushed in) or grey
(machine not connected).
Safety beam: can be green (machine active), orange (not active), yellow (muted), red
(interrupted) or grey (machine not connected).
Fatal error: can be red (fatal error happened) or grey (OK).
Click on the Axis Control logo under the Status to show the model, serial number and
firmware revision.

The rest of the Window shows the different menus of Axis Control to interact with the flatbed.
They are explained in the next sections.
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4.1.2 Media menu

FIG 4-2
4-2 MEDIA MENU

Vacuum
Click the vacuum button to switch the vacuum on or off. The button is blue
if the vacuum is switched on.
Click the Blow button to blow instead of creating a vacuum. The button is
blue if the vacuum pumps are blowing.
The changes made in the status of the vacuum pump are only temporarily. Once a job or
internal test is started, the vacuum pump is controlled again by the firmware and/or
software.
Dust Extraction
Click the Dust extraction button to switch the vacuum cleaner on or
off. The button is blue if the vacuum cleaner is on.
The dust extraction parameters function only when a router module (optional) is installed.
Roll-up (optional for older F1612 models)
Click the Roll Up button to enable or disable the roll up. The roll up
button is blue if the roll up is enabled.
Settings
Check this box to use the waste matrix mode. In this mode, the
media is not tensioned when it is rolled up. This is necessary when
shapes are completely cut out.
Check this box if the table has to pause after each feed. This gives
the user the time to remove cut out shapes if needed.
This sets the size of the leading edge. If a new roll is loaded (use
the load menu!), the table pauses after feeding this amount of
media. This gives the user the opportunity to tape the material to
an empty core.
NOTE: The parameters for the roll up are only available if the roll up (optional) is
installed.

Axis Control

4-3

F Series

User’s Manual

Move
The buttons under Move become highlighted if the origin or size button is clicked. They are
described in section 1.6.
,
and
buttons are usable when media is loaded. These buttons
have been explained in section 1.6. The feed button is not highlighted if the pneumatic pack
(optional) is not installed.
If the router (optional) is installed, the table can be cleaned by clicking the
button.
The router will then clean the loaded area. The speed at which the table is cleaned can be
changed in the module menu (section 4.1.5).
If the roll up (optional) is installed, click the

button to roll up the media.

NOTE: On larger tables, the vacuum zones are indicated with green lines. The active
vacuum zones are hatched.

FIG 4-3
4-3 LOADED MEDIA LARGE TABLE
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4.1.3 Change Tool
The change tool menu must be used when a module or tool is changed on the flatbed. If a
tool or module is changed while the flatbed is not in the change tool menu, the machine will
not detect the change and the cutting surface may be irreversibly damaged if a job is started
afterwards.
After a module or tool change, click the Online button. The machine will then detect any
module or tool change. It will also remind the operator to calibrate the tool before using it.

FIG 4-4
4-4 TOOL CHANGE MENU

WARNING: Only change/install a module or tool after clicking ‘Change Tool’ in
Axis Control. The machine will not make any unexpected movements after the
change tool button is pressed and as long as the online button is visible. The
power to the motors is cut, so after Online is clicked, the motors return to their
original position. Do not move them too far out of their original position.

4.1.4 Reset
Click Reset to stop the table with the current job. The origin of the loaded media is also reset.

FIG 4-5
4-5 RESET BUTTON

NOTE: When the table is cutting a job from SummaFlex Pro, there are more options
available then just resetting (see section 4.1.11).
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4.1.5 Modules
This menu is the menu to set the tool parameters. Each time a tool is changed, the
parameters need to be at least checked.
If the machine detects a new tool is installed (after change tool), it will refuse to use that tool
until it has been calibrated.
The module that is chosen to calibrate has a blue border around it. The parameter that is
currently chosen to calibrate is highlighted in blue or magnified.

FIG 4-6
4-6 TOOL CALIBRATION MENU (MODULE MENU)

ATTENTION: The up and down head positions can also be set with the remote. It is
even advised to use the remote for this.

4.1.6 Load
With this menu media is loaded. How to load media is explained in section 1.6.

FIG 4-7
4-7 LOAD MENU
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4.1.7 Menu
With this menu the standard parameters for the cutting table can be changed. Select the
parameter that needs to be changed. The background of the selected parameter will become
blue. Then use the up/down arrow to change the value. The software for sending jobs may
overwrite some of the parameters. Press Apply to save the value or Cancel to deselect the
parameter without changing the value.

FIG 4-8
4-8 PARAMETER MENU

Overcut: with this parameter weeding is facilitated. Each time the knife goes up or down, the
cutter cuts a bit further then it should.
OptiCut: increases the cutting quality in case the knife is worn out or not calibrated
correctly. OptiCut is default-set to Off.
Quality level: is default set to High, setting it to Standard increases the throughput.
Concatenation: is used to have a smoother velocity profile when cutting curves. The default
value is 0,17 mm.
Cut off barcode: If this parameter is set to “On”, the table will cut off the media in front of
the barcode. The table will first read the barcode to retrieve the cut data and before it will
read the marks. The media will be cut before the barcode.
Slot to cut off barcode: This parameter determines which tool should be used to cut off the
media. The parameter refers to a slot position, not to a tool.
Margin to cut off barcode: With this the distance between the cut off line and the barcode
can be set. If the margin is larger than the offset of the barcode from the origin, the media
will be cut off at the origin.
Velocity to clean the table: This is the speed at which the table will be cleaned with the router
module as soon as the cleaning option is activated from the media menu (see section 4.1.2)
Other possible actions in this menu are:
and
. This is used to save or restore a backup of the current parameter
settings of the flatbed.
NOTE: It is advised to make a backup file just after installation of the
machine.
is used to send a test file to the flatbed. This action can be used for remote
troubleshooting.
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starts an internal cut test (only if the drag knife or kiss cutting knife is the
selected tool – to select a different tool, go to module menu).
is used to upgrade the internal firmware of the flatbed. A choice is offered to
either install from a local drive or to download the latest version from www.summa.be (link to
the latest version of firmware is also on the installation CD).
is used to draw the boundaries. First put a pen in the drag module.
Consequently, set the tool to pen in the menu. Click Draw Origin. When the conveyer belt is
mounted, the table will draw a line at the right side, marking the origin. At the left side a line
will be drawn, marking the maximum Y size. When no conveyer belt is mounted, the table will
draw a rectangle, marking the origin and maximum media size.
is a calibration procedure to compensate for errors in the X axis when cutting in
panels (without registration mark recognition). You have the choice between an automatic
and a manual calibration. The manual calibration needs to be used if the camera can’t detect
the cut out registration marks.
is used to set the parameters in Axis Control and for the remote.
is used to set the parameters for the camera, so it can read the barcode and
marks. The camera is normally calibrated to detect black marks on white vinyl. Most other
combinations of colours can also be detected with the standard settings. It is possible to
adjust this standard setting to read less obvious colour combinations of media and marks.

The left side of the window (Camera) shows the camera view. The middle (Start position and
Actions) will show active buttons that can be used while setting the parameters. The right
side can save the profile and select the settings, whose parameters need to be set.
Some profiles are predefined and are installed when Axis Control is installed (default and
reflective). To use them click the dropdown box just under profile and choose the correct
profile.
A predefined profile can be altered or a new profile can be made. It is advised not to change
a default profile, but copy it and change the parameters of the copy.
The parameters of following settings can be set.
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Camera LED

Click Mode to set the LED to Always ON, Always OFF.
Click PWM and set the LED light intensity with the slider between OFF (value 0) and maximum
(255).
Calibration

This is used to set the filter (profile) that will be used when Axis Control searches for marks.
There are two filters. In order to switch between the setting of each filter click the tab.
First set a colour filter that can be disabled or enabled. Click the filter test button to expand
the window with an extra view of the camera. The different tabs in that view show the result
when changes in the filter are applied.
The colour filter has four parameters: Minimum hue and maximum hue to filter out specific
colours and a minimum and maximum saturation to filter out the grey component of the
colour.
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The second filter (just called filter) is more important. Click the tab to show the parameter
settings of that filter.
There are 5 parameters. Click the parameter to change it. A slider under the set parameter is
then shown to adjust the parameter. Click the filter test button to expand the window for an
extra camera view. This extra view has 5 tabs. Each tab corresponds more or less with a
parameter of the filter. Click the first tab to see what the first parameter does to the camera
view. Click the second tab to check what the second parameter does and so on. The aim is to
get a clear thin line in the last tab.
Median filter: preserves the edges, but smooths out patterns.
Truncate filter: sets all grey levels below a certain value in relation to that value.
Blur: Blurs the picture slightly in order to smooth out sharper edges.
Edge smoothing: blurs out the pattern nears the edges.
Threshold: sets the level to decide whether an edge is white or black.
Example: parameter settings to hide the pattern of reflective vinyl:
Click the filter test button.
1. Change median filter be sure first tab is shown.
2. Change Truncate filter be sure second tab is shown.
3. Change blur filter be sure third tab is shown.
4. Change edge smoothing be sure fourth tab is shown.
5. Change Threshold be sure fifth tab is shown.
Click the Test circle mark button. If the circle is recognized as a mark, a green circle will be
drawn around it.

Barcode

This filter is used when the camera reads the barcode. There are 4 sets of parameters.
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The workflow parameters determine how fast the barcode is read. There are three speed
parameters.
1. Search velocity: Is the speed at which the camera searches for the next (or first)
barcode.
2. Track velocity: is the speed at which the camera searches for the right side of the
barcode.
3. Scan velocity: is the speed at which the barcode is read.
Select a speed and change it with the slider at the bottom, if necessary.
The final parameter is scan retries. This determines how many times the camera tries to read
the barcode if it fails. The reading speed is automatically lowered when the barcode is reread.
The colour filter and the filter settings function similar as with the calibration settings.
There is one detection parameter. It is called ‘Contrast’ and can be set if a light barcode
needs to be read on darker material.
Click
to check if the barcode can be read. The cutter will prompt the user to set
the knife under the barcode. After that, the barcode will be scanned. If the barcode is
detected correctly, a window will appear with the value, that has been read.

Poster Trim

The poster trim function is an option, enabling to trim posters without the need for special
marks and without the use of SummaFlex Pro. When the posters are printed out, a black
border of 5 mm around them needs to be printed with a distance of 5 mm between the
copies. To start the job, simply set the camera under the black border. The borders will be
read and afterwards the table will cut inside the black border. More info about the exact
workflow can be found in section 4.4.

Axis Control

4-11

F Series

User’s Manual

Click the first tab in order to set the workflow parameters.
Tool: With this parameter the tool, that will be used for trimming, can be set.
Cut Offset: Is the distance between the line that will be cut and the inside of the black border.
OverCut: Is the distance, which the knife will cut further in each corner.
Velocity: is the speed at which the borders will be read. Lower this value if the computer
resources are limited.
Camera stabilization: The camera adjusts the brightness automatically, according to the
received amount of light. This might take some time. With this parameter the time the
camera waits can be set. When set at ‘automatic’, the camera will wait 90/5 until the
brightness is stable. When set at ‘fixed’, the time the camera waits can be set at a specific
time. The option ‘none’ means the camera does not wait. The recommended setting is
‘automatic’.
Click the second tab to see the workflow parameters. The amount of parameters that can be
set in this tab depends on the chosen job type (the way the posters are nested). The extra
parameters help to speed up the reading of the borders.
Nesting: there are 4 settings possible.
Single poster: Only one poster will be cut out. No extra parameters are needed.
Single row: Only one row of posters will be read and cut. Then the next row will be read and
cut. The posters may differ in size in both directions. However, they must be aligned left or
right and top or bottom. Set the parameters correctly (as they are printed out).
Multiple copies: All posters must have the same size. All rows will be cut out, the rows do not
have to be complete. The copies must be aligned left or right. Set the parameter to left or
right aligned.
Random: Although the setting has ‘random’ as name, there are some limitations to the
position of the individual posters. Every frame, which is not located in the start position, must
be connected to at least one other frame (connected means: at a distance of 5 mm with white
space between it). More info see section 4.4.
Once this parameter is set, set the horizontal alignment parameter correctly (left or right).
The next two tabs are filters. The colour filter and the filter settings function similarly as with
the calibration settings.
There is one detection parameter. It is called ‘contrast’ and can be set if a light barcode
needs to be read on darker material.
Click
to check if the frames can be read. The table will prompt the user to set
the knife under the frame. Do this at the left side of the table when the jobs are left aligned,
on the right side if the jobs are right aligned. Click OK. The camera will check if the frames
can be read.
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4.1.8 Events
This menu shows all the messages that have been displayed by the flatbed cutter.
There are three types of messages:
Info: Is a message of the machine to the user.
Warning: Is a message from the machine to the user, reminding the user a certain action
needs to be taken.
Error: Is a message from the machine, reporting an error that needs the user’s attention.

FIG 4-9
4-9 EVENT MENU

4.1.9 Reboot
This button is for restarting the machine completely. It is a ‘warm restart’. The flatbed goes
through its entire initialization procedure, that is normally run when the machine is switched
off and back on again.
This reboot does not reboot the camera in the flatbed.
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4.1.10 Color Axis Control icon
The colour of the icon of Axis Control in the taskbar or tray menu can differ.
The normal colour is white.
When the icon is yellow, this means the flatbed is busy (resetting, cutting a test pattern,
waiting for a response from the user,…).
When the icon colour is red, this means Axis Control has no connection with the flatbed
cutter.

4.1.11 Axis Control options when table is busy cutting jobs from SummaFlex
Pro
When a job is started from SummaFlex Pro, the safety poles become active (
and the view of Axis Control changes. There are now two main buttons.

)

Click this button to stop the current job. The table will finish the vectors,
loaded in the buffer and reset the origin. The computer will send the rest of
the job but the table will not cut it out.
Click this button to pause the current job. The table will finish the vectors
loaded in the buffer, pause and show the two new buttons.
Click this button to resume the job. The table will start cutting the rest of
the job.
When the table is paused, the job can be aborted by clicking this button.
The carriage will move back to the current origin. The computer will send
the rest of the job but the table will not cut it out.
If the safety beams are interrupted, the table will stop immediately and the table will pause.
Summa Axis Control will give a message. Click the OK button in the message window to
continue.
NOTE: Do not use the safety beams as a pause button. It will reduce the cutting
quality. A controlled pause makes sure all vectors are cut out with the correct
speed and acceleration.
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4.2 Remote control
The remote control makes it possible for the user to come closer to the machine when this is
necessary for certain actions. It is used when:
 Setting the origin and size of loaded media.
 Setting the up and down positions of the knives in the tools.
 Switching the vacuum pump on/off.
WARNING: While the remote is used, the operator can approach the table. He
can even pass the safety beams without setting them off. So, the user must be
extra careful and stay away of the parts he is controlling with the remote.
There are two methods of connecting the remote with the computer.
Either through connection via a Bluetooth dongle or through a wireless bar.
The wireless bar is the current (latest) way of connecting.

4.2.1 Wireless Bar setup
First time connection:
It’s not necessary to install special drivers before connecting the wireless bar. Just connect
the bar to the computer with the USB connector and wait until Windows has installed the
correct driver. This could take a couple of minutes with certain Windows versions.
The bar is connected if a blue LED lights up under the mode button. The default mode is 4. If
it is not set at this mode, then press the mode button until it is set at mode 4. If the LED does
not light up, it is possible that the bar is switched off. Switch it on with the little switch on
the back of the bar behind the sync button.
To connect the remote press the sync button on the bar (the sync LED will blink).
Then press the sync button on the remote (a red button at the back; see the white arrow
figure below). First all 4 LED’s on the remote will blink. Wait until only one is activated. The
sync LED on the bar will now also be activated.
Start Axis Control. The status indicator in front of the remote controller will be green.
Reconnecting:
After this first time installation, reconnecting the remote is easier.
It is possible that the remote auto connects. If it does not auto connect, then just press the
“1” and ”2” button on the remote after Axis Control is started. The connection will be
established.
If the battery has been changed, it is possible that the sync button on the bar needs to be
pressed prior to pressing the “1” and “2” button to connect.
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4.2.2 Legacy connection setup
4.2.2.1 Starting up the remote control
There are a couple of different procedures to start up the remote. The type of procedure that
needs to be followed depends on the type of remote and on the type of Bluetooth dongle.
Type of dongles:

Needs procedure with
BlueSoleil software

Needs procedure with
Toshiba software

The software with these dongles needs to be installed upon first connection of the dongle.
This is described in the installation manual.
Types of remotes:
To check the type of remote, remove the battery pack and check the label inside.

FIG 4-10
4-10 TYPE REMOTE

Type 1: Remote Controller, RVL-003
Type 2: Remote Controller, RVL-036 version LMB-RVL-WR/Z-C2
Type 3: Remote Controller, RVL-036 version LMB-RVL-WR/Z-C4
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PROCEDURE WITH BLUESOLEIL DONGLE

Start the BlueSoleil software. Select the remote. Right click the mouse icon.

FIG 4-11
4-11 START BLUESOLEIL

For type 1 and type 2 remotes: press button 1 and button 2 simultaneously. Check if the
LED’s are blinking and click ‘Connect’.
For type 3 remotes: press button 1 and button 2 simultaneously. Check if the LED’s are
blinking. Wait for the LED’s to stop blinking and click ‘Connect’ immediately (if the pause in
between is too long, the connection will not be established).
The connection is OK if a line between the big yellow button and the remote, with a moving
red dot, will be visible for at least 10 seconds.
ATTENTION: On some computers it is necessary to use the sync button at the back
of the remote instead of the 1 & 2 button at the front.
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PROCEDURE WITH TOSHIBA DONGLE

Start the Toshiba software and select Nintendo. Right click and select connect.

FIG 4-12
4-12 START THE TOSHIBA SOFTWARE

For type 1 and type 2 remotes: press button 1 and button 2 simultaneously. Check if the
LED’s are blinking and click OK.
For type 3 remotes: press button 1 and button 2 simultaneously. Check if the LED’s are
blinking. Wait for the LED’s to stop blinking and click OK immediately (if the pause in
between is too long, the connection will not be established).
The connection is OK if a green connection symbol is visible in the icon for the Nintendo.

ATTENTION: On some computers it is necessary to use the sync button at the back
of the remote instead of the 1 & 2 button at the front.
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4.2.3 Name of the buttons on the remote

Arrow buttons.

Enter button.

Module (select) button.

Origin/Test button.
Up button
Down button

Shift button (back of remote)

4.2.4 Setting the origin and size with the remote
Press on the origin/test button to set the origin or just press one of the arrow keys. The head
will move this way the pointer is set over the origin. The origin can now be changed by
pressing the arrow keys. Push the enter button to set the origin. While the origin is set, the
(left) origin LED is flashing.
If enter is pressed, this LED will still flash for a while. Do not press any buttons on the
remote while the LED is still flashing.
Press the shift and origin/test button simultaneously to set the media size (press the shift
key first). The head will move this way the pointer is set over the upper left corner of the
media. The size can now be changed by pressing the arrow keys. Push the enter button to set
the size. While the size is set, the (right) size LED is flashing.
If enter is pressed, this LED will still flash for a while. This can take quite a long time if the
media width was changed a lot. The machine has to reposition the vacuum selector. Do not
press any buttons on the remote while the LED is still flashing.
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4.2.5 Setting the tool/ knife up and down position with the remote
Setting the up and down position of the tool/knife is best done with the remote. In order to
set the up and down position, follow the below procedure.
1. Move the origin above the loaded media.
2. Press the module button. If more than one module with a tool is mounted on the
machine, the module to calibrate can be selected by pressing the module button
several times. The module that is selected to calibrate is indicated with the LEDs at the
bottom of the remote (M1, M2 or M3).
3. First set the up position. Do this by pressing the up button and lowering the tool/knife
with the arrow buttons. Once the correct height is set, press the enter button.
ATTENTION: The up position is linked to the down position of the tool/knife for
safety reasons. If the down position has not been set yet (still at zero) it will be
impossible to set the up position. In that case, set the down position first and
afterwards the up position.
4. Then set the down position. Do this by pressing the down button. Lower the tool/knife
with the arrow buttons. Press the origin/test button to check the depth. If the depth is
not correct, then correct it by pressing the arrow keys again. Once the correct depth is
set, press the enter button.
NOTE: Make sure the speed of the tool/knife is the same speed at which the job
will be done.
ATTENTION: When using the kiss cutting tool, only the down position needs to
be set. The up position is then automatically set 4 mm higher.

4.2.6 Switching vacuum pump on/ off
The vacuum pump can be switched on and off by pressing the enter button. Pressing it
together with the shift button sets the pump to blow.
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4.3 Plug-ins
Plug-ins for Corel and Illustrator exist to make the workflow easier.

4.3.1 Plug-in for Corel (PC)
The Toolbar in Corel contains four icons.

The first icon is used to start a new drawing from the F Series template. If the icon is clicked,
then following things happen:
•

A new drawing is started from the F Series template.

•

All necessary layers are created and the working area is 1200mm x 1600mm
(portrait).

•

The active layer is the layer for print data.

If the second icon is clicked, following things happen:
•

The layer ‘Regmark’ is made the top layer, all objects in it are deleted and it is
locked.

•

All objects in all unlocked and visible layers under the Regmark layer are selected.

•

The Regmark layer is unlocked.

•

Registration marks (circles with Ø5mm) are put around the selected objects and an
arrow is added to easily recognize the orientation. All these registration marks and
the orientation mark are saved in the Regmark layer.

•

The Regmark layer is locked.

The third icon is used when the design needs to be cut from the none-printed side (in
combination with a macro in SummaFlex Pro). If the icon is clicked, following things happen:
•

The layer ‘Regmark’ is made the top layer. All objects in it are deleted and it is
locked.

•

A new top layer is created, called ‘Cut Out Squares’. It is locked.

•

All objects in all unlocked and visible layers under the Regmark layer are selected.

•

The Regmark layer and Cut Out Squares layer are unlocked.

•

Registration marks (circles with Ø5mm) are put around the selected objects and an
arrow is added to easily recognize the orientation. All these registration marks and
the orientation mark are saved in the Regmark layer.

•

On top of each registration mark, a square with the same center and size 5x5mm is
created in the Cut Out Squares layer.

•

The Regmark layer and Cut Out Squares layer are locked.
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The fourth icon is used to create a pdf file that is ready for SummaFlex Pro to import. If the
icon is clicked, following things happen:
•

All objects in the unlocked layers and in the layers where the printing/exporting is
not disabled are selected (so the objects in the Regmark layer and Cut Out Squares
layer also).

•

A dialogue box is opened, a directory (same one as the one that was used the last
time with this function) and the file name (current file name) is suggested.

•

Change the directory and file name, if necessary, then click ‘save’ without changing
any options.

NOTE:

Axis Control
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4.3.2 Plug-in for Illustrator (PC)
The extra menu under the file contains two sub menu’s.

If the first sub menu is used, following things happen:
•

The layer ‘Regmark’ is made the top layer. All objects in it are deleted and it is
locked.

•

All objects in all unlocked and visible layers under the Regmark layer are selected.

•

The Regmark layer is unlocked.

•

Registration marks (circles with Ø5mm) are put around the selected objects and an
arrow is added to easily recognize the orientation. All these registration marks and
the orientation mark are saved in the Regmark layer.

•

The Regmark layer is locked.

The second menu is used when the design needs to be cut from the none-printed side (in
combination with a macro in SummaFlex Pro). With the second sub menu following things
happen:
•

The layer ‘Regmark’ is made the top layer. All objects in it are deleted and it is
locked.

•

A new top layer, called ‘Cut Out Squares’, is created. It is locked.

•

All objects in all unlocked and visible layers under the Regmark layer are selected.

•

The Regmark layer and Cut Out Squares layer are unlocked.

•

Registration marks (circles with Ø5mm) are put around the selected objects and an
arrow is added to easily recognize the orientation. All these registration marks and
the orientation mark are saved in the Regmark layer.

•

On top of each registration mark, a square with the same center and size 5x5mm is
created in the Cut Out Squares layer.

•

The Regmark layer and Cut Out Squares layer are locked.

In order to prepare a file for SummaFlex Pro do following:
•

First save the design as a normal ai file.

•

Delete the layer(s) with the print data.

•

Save as a copy in pdf format.

•

If necessary, undo the deleting of the layer(s).
NOTE: It is better to delete the layers with printing info before making the pdf
file. Otherwise the pdf file will have too much unnecessary data in it and
importing it in SummaFlex Pro will take too long.
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To set the template for the F Series on the correct place do following:
•

Open Illustrator.

•

Go to File > New from template (a dialogue box will open. Choose a template from
the Illustrator template directory).

•

Open Windows explorer and go to directory where Summa Flatbed Tools is installed
(this directory is usually C:\Progam Files (x86)\Summa Flatbed Tools or C:\Progam
Files (x86)\Summa Flatbed Tools – depending whether it is Windows 32 bit or
Windows 64 bit).

•

Go to the template subdirectory, select the Illustrator template (file with extension
ait), right click and select copy.

•

Go to the dialogue box in Illustrator and copy the template there.

•

Click the new button.
NOTE: The next time a new file from the template is needed, just go to File > New
from Template, and select the template for the F Series.
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4.3.3 Plug-in for Illustrator for Mac (from CS4 up)
With this plug-in SummaFlex Pro marks or SummaFlex Pro marks with additional squares will
be added to the design. The additional squares can be used if the design needs to be turned
face down before it is cut. The Summa menu is added in the File menu of Illustrator. The
Plug-in is called SummaCS4mac.aip, version 1.0.0.0 for Illustrator CS4 and CS5. For
Illustrator CS6 it is called SummaCS6mac.aip and for Illustrator CC it is called
SummaCCmac.aip.

FIG 4-13
4-13 PLUG-IN FOR ILLUSTRATOR ON MAC
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4.4 Poster Trim
The poster trim workflow makes it possible to trim poster without having to use SummaFlex
Pro. The rip has to print a black border around the poster of 5 mm wide and the distance
between those black borders also needs to be 5 mm.
One poster always needs to have at least one side of its border next to another one.
Other than that, there are not a lot of restrictions. In order not to lose too much time during
the scanning of the borders, the grouping of the posters can be described and split up into
different configuration. It is important to set the configuration correctly before starting the
job.
Examples of possible configurations:
• Single poster:

• Single row (may be one row or multiple rows distance marked is max 250 mm):

XXX

XXX

or
• Multicopy:

or
• Random:

or
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Setting the parameter ‘poster trim job’ correctly.

1. Click the

button, then click the

button. A small window will open.

2. Click the
button to check if the parameters are set correctly. There are a lot
of parameter settings for poster trimming. They are all explained in section 4.1.7. Most of
the parameters will not have to be changed. The parameters to check in particular are in
the Workflow tab and in the Job structure tab.
Make sure the tool type, Cut offset and Cut velocity is set
correctly.
The cut offset is measured from the inside of the border
towards the center of the poster. So the larger the offset,
the smaller the result.
The other two parameters are usually not altered.

First set the nesting type correctly (see previous page for
samples) then the other parameter(s).

If the new settings will be used later, they can be saved with an easy recognizable name. To
do this, click the
button. Fill out the name and click ‘save’. When this configuration is
needed again, it can be chosen by clicking on the dropdown box just above the copy button.
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Starting the job
1. Load the media on the table and check how the posters are printed (choose correct
configuration).

2. Click the

3. Click the

button, then click the

button. A small window will open.

button. A new window will open with a camera view and arrows.

4. Use the arrows to set the camera under the first poster. If the alignment parameter is set
to right, then the camera has to be set under the outer most right poster. If the alignment
parameter is set to the left, then the camera needs to be set under the outer most left
poster.
5. Click apply to start the job. The borders will be read according to the settings of the job
structure parameters. Thereafter the poster will be cut.
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Maintenance and Cleaning

5.1 General Information
The cutting tables have a number of sliding surfaces, made of smooth metals and plastics.
They are virtually friction-free and require no lubrication by the operator. They will, however,
collect dust and lint that may affect the cutter’s performance. Keep the flatbed as clean as
possible by using a dust cover when not in use. When necessary, clean the unit with a soft
cloth, dampened with isopropyl alcohol or mild detergent. Do not use abrasives.
It is also recommended to check the knife on a regular basis. Replace the knife if the knife tip
is worn down or broken off.
There is an internal counter that takes track of the hours the machine has operated. After a
certain time the machine will give a message, saying that service maintenance needs to be
done. This service maintenance needs to be done by a service technician, trained by Summa.
It is highly recommended to have this maintenance otherwise the cutting quality and the
lifetime may be reduced. Those maintenance actions are not described in this manual. They
are described in the service manual. The maintenance described here can/should be done by
the operator. There are two levels of maintenance for the operator: the daily maintenance
and the weekly/monthly maintenance.

WARNING: For safety reasons, always switch off the machine before starting the
visual inspection. Most maintenance procedures are also best carried out with the
machine switched off. Only in rare cases it is necessary for the machine to be
powered on during maintenance procedures. If this is the case, follow the
described procedure.

5.1.1 Daily maintenance
The daily maintenance actions are:
1. Each day before starting up the machine, move the conveyor manually so it is moved
forward for about 1 meter.
2. Free the machine of any dust and residue that was left from the cut materials.
3. Check the correct function of the safety features (laser beam and emergency stops).

5.1.2 Weekly/ monthly maintenance
The frequency of the following described maintenance procedures depends on how much the
cutter is used. Most of those maintenance actions are triggered by a visual inspection of the
machine and its components or by deterioration in the cut quality. It is recommended to do a
complete visual inspection of the machine and all its components at least once a week.
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5.1.2.1 Cleaning the nose piece (Kiss Cutting Knife only)
The nose piece may accumulate residue from the vinyl that will result in poor cut quality. The
typical indication of a dirty nose piece is an interruption of the cutting line every 12 mm
(0.5”).
Cleaning the nose piece:
1. Remove the Kiss Cutting Tool by turning it counterclockwise. Use the menu Change tool
in Axis Control or switch off the cutter before doing this.
2. Observe the orientation of the nose piece in the tool and then push it out of its holder.
3. Remove any remaining vinyl residue, using a brush or a pair of tweezers.
4. Put the nose piece back.
5. Install the Kiss Cutting Knife again in the module.

FIG 5-1
5-1 NOSE PIECE KISS CUTTING TOOL

5.1.2.2 Cleaning the gliding disk (Cutout and EOT)
The gliding disk may accumulate residue from the vinyl that will result in poor cut quality.
Cleaning the gliding disk:
1. Remove the Single Edge, Double Edge Tool or EOT by turning it counterclockwise. Use
the menu change tool in Axis Control or switch off the cutter.
2. Remove any remaining vinyl residue, using a brush or a pair of tweezers or with
compressed air. Remove the gliding disk from the tool, if necessary.
3. Install the tool again in the module.

FIG 5-2
5-2 GLIDING SURFACE

NOTE: The gliding surfaces may be lubricated with a dry Teflon spray
before the gliding disk is set back on the tool.
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5.1.2.3 Replacing the knife guide of the EOT
The very high frequency of the EOT means that wear of moving parts inside the EOT is
unavoidable. The level of wear is unpredictable since it depends on various parameters, such
as thickness of the cut material, its consistency, usage and other general operational
parameters. The only part the operator can replace is the knife guide. If other parts are worn,
the EOT will need to be serviced in a Summa service center.
NOTE: If the EOT is set to run at high frequency, it will wear down faster and
make more noise.
Replacing the knife guide:
1. Remove the EOT from the module. Use the menu Change Tool in Axis Control or switch
off the cutter.
2. Remove the gliding disk (if it was mounted) and remove the knife.
3. Loosen the knife guide by removing the two setscrews.
4. Turn those setscrews in the two threaded holes right next to the holes the screws came
out of for a turn or three.
5. Gently remove the knife guide by pulling on those setscrews.
6. Put the new knife guide in and proceed in the reverse order of removal.

FIG 5-3
5-3 KNIFE GUIDE WITH SCREWS FOR REMOVING AND REPLACING

FIG 5-4
5-4 USAGE OF AN EXTRA TOOL IF THE KNIFE GUIDE GRIPS IN THE SHAFT
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5.1.2.4 Cleaning the conveyor belt or protective mat
After a while a lot of dust will gather in the conveyor belt. This will reduce the vacuum. The
media will not stay on its place and the cutting quality will deteriorate.
Cleaning the conveyor (protective mat):
Set the vacuum pump on ‘blow’ and clean the conveyor with a vacuum cleaner.
When a miller is mounted on the machine, this can be used to vacuum the conveyor belt or to
route the underlay. Click the media button in Axis Control. Two extra options are visible:
Clean table: Push this button to vacuum the table (loaded area). The miller in the router will
run, but it will not touch the surface.
Dust extraction: Click the radio button to set it on or off.
NOTE: If a lighter router underlay is used, the brush should barely touch the
underlay. If the conveyor type of mat is cleaned, the brush can be used to
‘brush’ the conveyor belt.

5.1.2.5 Cleaning the protection brushes at the sides
The brushes at the sides can accumulate dust. Use a vacuum cleaner to clean them. Do not
use compressed air, since this will blow all the dust inside the machine.

5.1.2.6 Cleaning Guide rails
The guide rails normally don’t need lubrication. The carriages have a built-in reservoir with
lubrication. However, should the rails be very dirty, they can be cleaned as follows.
Cleaning the rails:
1. Clean the lengths of the rails with a lint-free rag (start from the carriages and move
away from it).
2. Soak another lint-free rag with lubricant for bearings/guiding rails and go over the
lengths of the rails again.

5.1.2.7 Emptying the compressed air filter on machines without a POT
Check the filter regularly for compressed air and empty it, if necessary. To do so, remove the
front cover (two screws) and lift out the front panel.

5.1.2.8 Filling up oil supply on machines with a POT
Check the oil level monthly. If the level is below half full, add oil.
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5.1.2.9 Cleaning the ADC
In the ADC there are two fiber optic cables left or right with a small lens in front of them. This
lens can become dirty due to dust and this can interfere with the accuracy of the depth
setting. Therefore this lens needs to be cleaned regularly.
The lens itself is made out of PMMA (commonly described as Plexiglas). This means it is
scratch sensitive, so it can only be cleaned in three different ways.
When it is not too dirty, a short burst of compressed air can get rid of the dust.
If the dirt is clogged on the lens, use a lint-free cloth, dampened with warm water.
If it is really dirty, mix some washing liquid with water and use a microfiber cloth to clean it.
It can be wiped dry with a lint-free cloth, but do not apply pressure on it because this could
scratch the lens.

FIG 5-5
5-5 ADC CLEANING

5.1.2.10 Cleaning collet of the Kress router
Each time a bit is removed or replaced, the collet needs to be cleaned. Clean the collet by
tapping it gently on a flat service and/or blow the dust out of the grooves and thread (in nut
and on miller).

FIG 5-6
5-6 COLLET MILLER

WARNING: If the collet is not cleaned and the grooves become clogged with
dust, the bit can’t be secured tightly enough. If the bit then comes loose during
routing, it will damage the mats, miller and could even cause injury.
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5.1.2.11 Maintenance HF miller
•

RUN- IN CYCLE

The miller has to go through a run-in procedure, each time the miller has run less than 20
minutes in 3 weeks. Run this procedure also at first installation. An internal parameter
registers how long and when the miller has run. If a run-in procedure is necessary, Axis
Control will give a message and an extra button will be visible in the modules menu.

FIG 5-7
5-7 MODULES MENU HF MILLER WITH BURN-IN BUTTON

button and wait for the procedure to end. A window with the progress of
Click the
the run-in cycle will be visible. After it is finished, the button in the menu will also disappear.

FIG 5-8
5-8 WINDOWS RUN-IN CYCLE
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REPLACING/CLEANING THE COLLET

The miller is transported with a dummy collet (no place for inserting a routing bit). Upon first
installation this collet has to be removed and replaced with the collet of 6 mm. This
procedure is the same procedure as changing a normal collet.

1. Click

, then click on the picture of the router module and click

.

2. Take the HF miller out of the router module and put it on the table. Flip the switch on
the back of the router module.

FIG 5-9
5-9 SWITCH FOR BIT CHANGE

3. Remove the bit from the collet. Take the collet, turn it in the direction of the green
arrow and remove it.

FIG 5-10
5-10 REMOVING COLLET FROM THE MILLER

WARNING: If the collet cannot be removed manually, use the 10 mm and 13 mm
wrench to loosen the collet. Make sure to turn in the correct direction and never
use these tools to fasten a collet.
1. Inside the collet there is a setscrew to secure the collet. First make sure this setscrew
is not turned in too far. Use an Allen wrench to make sure the internal screw is only just
visible in the hole in the collet.

FIG 5-11
5-11 COLLET WITH SETSCREW
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2. Either take a new collet or clean the collet that has been removed. To clean a collet, use
one of the brushes delivered with the miller motor.

FIG 5-12
5-12 CLEANING THE COLLET

NOTE: It is advised to clean the collet a couple of times a week if the router is
used a lot or when the router bit is often changed.
3. Apply a light film of oil to the thread on the collet. Then re-insert it and screw it in
manually in the direction of the black arrow. Turn until the end, but do not tighten. Stop
as soon as the end is reached. Then turn the collet half a turn counterclockwise
(direction green arrow).

FIG 5-13
5-13 RE-INSTALL THE COLLET FROM THE MILLER

WARNING: It is very important to insert the collet as described. If the collet is
turned in too far, there will be irreversible damage to the miller motor. If the
collet is not turned in far enough, the routing bit will come loose during usage
and damage the table surface.
4. Fasten the setscrew inside the collet with the Allen wrench.

Axis Control
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Consumables

6.1 Cutter accessories and consumables
The following accessories and consumables are available for the F Series Pro Flatbed.

6.1.1 General accessories and consumables

Manual and driver USB stick

MD9071

Media flanges
(set of 2)

391-510

Hex screwdriver 4 mm

MT9010

Hex screwdriver 2.5 mm

MT9011

Tool wrench

500-1302

USB cable 3 m

500-9089

USB extension cable 0.5 m

Consumables

500-9096
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F Series

User’s Manual

6.1.2 Drag module

Standard drag knife holder for drag head

391-332

Standard drag knife 36°
(set of 5)
up to 0.25 mm cutting depth

391-360

Drag knife 60°
up to 0.6 mm cutting depth

391-231

Drag knife holder for sandblast knife

391-363

Drag knife 55°
(set of 5)
up to 0.8 mm cutting depth

391-358

Plotter pen
(set of 4)

MP06BK

Consumables
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6.1.3 Kiss Cutting Tool

Kiss cutting tool holder

500-9311

Knife holder kiss cutting tool

500-3318

Standard tangential knife 36°
(set of 5)
up to 0.25 mm cutting depth

390-534

Tangential knife 60°
up to 1.2 mm cutting depth

390-550

Double sided tangential knife
up to 0.25 mm cutting depth

390-551

Insertion tool for knives kiss cutting tool

390-553

Tangential knife 45°
up to 1 mm cutting depth

390-560

Nose piece

395-348

Consumables
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6.1.4 Cut out Tools

Single edge cutout tool
(includes 1 single edge cutout knife)

500-9312

Single edge cutout knife 65°
up to 6 mm thick material

500-9801

Gliding disc single edge

500-3303

Double edge cutout tool
(includes 2 double edge cutout knives)

500-9313

double edge cutout knife 50°
up to 3 mm

500-9802

double edge cutout knife 60°
up to 5 mm

500-9803

Gliding disc double edge

500-3315

Heavy duty cutout tool
(includes 1 heavy duty cutout knife)

500-9314

Heavy duty cutout knife 45°/90°
up to 15 mm

500-9807

Consumables
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6.1.5 Electronic Oscillating Tool

Every knife for the oscillating tool is delivered with a setscrew and a hex
screwdriver. It is recommended to replace the setscrew if the old one
has been damaged.

Electronic oscillating tool

500-9320

Single edge 65° L25
up to 5 mm

500-9800

Single edge 0°- 75° L25
up to 5 (6) mm

500-9813

Single edge 65°-80° L25
up to 5 (11) mm

500-9810

Single edge 65°-85° L25
up to 5 (11) mm

500-9811

Single edge 65°-85° L28
up to 8 (14) mm

500-9812

Single edge 45°-85° L33
up to 13 (19) mm

500-9815

Single edge 45°-86° L38
up to 18 (24) mm

500-9814

Knife guide

500-3313

Consumables
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6.1.6 Creasing Tools

creasing tool D 25 R3 H8 W7

500-9325

creasing tool D 25 R3 H8 W5.5

500-9326

creasing tool D 25 R1.5 H1.5 W1.5

500-9327

creasing tool D 15 2pt

500-9328

creasing tool D 15 1pt

500-9329

Consumables
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6.1.7 Pneumatic Oscillating Tool

Every knife for the oscillating tool is delivered with a hex
screwdriver.

POT

500-9350

POT Knife Flat Point L20 T0.63
Max material thickness: 18 mm

500‐9830
(Set of 3)

POT Knife Flat Point L27 T0.63
Max material thickness: 25 mm

500‐9831
(Set of 3)

POT Knife Flat Point L20 T1.5
Max material thickness: 18 mm

500‐9832
(Set of 3)

POT Knife Flat Point L27 T0.63
Max material thickness: 25 mm

500‐9833
(Set of 3)

POT Knife L20 T1
Max material thickness: 16 mm

500‐9834
(Set of 3)

Gliding disk POT

500-9331

Consumables
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6.1.8 V-Cut Tools

Each V-Cut tool is delivered with a fixture to position the knife.
This part can also be used for protecting the knife when the
tool is not mounted in the machine.

V-Cut tool 0°
up to 27 mm cutting depth

500-9340

V-Cut tool 15°
up to 26 mm cutting depth

500-9341

V-Cut tool 22.5°
up to 25 mm cutting depth

500-9342

V-Cut tool 30°
up to 23 mm cutting depth

500-9343

V-Cut tool 45°
up to 18 mm cutting depth

500-9344

V-Cut blade 0.9 mm
(set of 5)

500-9825

V-Cut blade hard metal

500-9826

Consumables
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6.1.9 Routing tools Kress miller

This is the wrench that is needed to loosen the
collet. It is delivered with the miller option. It
is a normal size 17 mm wrench. It can be
ordered with part number MT9014.

Collet 3 mm

500-0241

Collet 4 mm

500-0242

Collet 6 mm

500-0243

Collet 8 mm

500-0244

Vacuum cleaner bag for Bosch vacuum
cleaner (5x)

500-9332

Routing mat
(Roll 11 m)

500-9333

Miller motor

500-9334

Router bit D3/3 L60/10 1FL UC
(3x)

500-9850

Consumables
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Router bit D3/3 L60/20 1FL UC
(3x)

500-9851

Router bit D4/4 L50/12 1FL UC
(3x)

500-9852

Router bit D4/4 L70/30 1FL UC
(3x)

500-9853

Bit description:
Example: Bit D3/3 L60/10 1Fl UC:
• D3/3: shank diameter: 3 mm / routing diameter: 3 mm.
• L60/10: tool length: 60 mm / maximum routing depth: 10 mm.
• 1Fl: 1 flute.
• UC: Up Cut: milling chips are moved upwards.

Consumables
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6.1.10 Routing tools HF miller

These wrenches are delivered with the HF
miller. They can be used if the collet cannot be
removed manually. Do not use them to tighten
the collet. They cannot be ordered separately.

Collet 6 mm

500-9379

Collet 4 mm

500-9380

Routing mat (wide)
(Roll 11 m)

500-9333

Routing mat (narrow)
(Roll 11 m)

500-9336

Spare HF Spindle motor

500-9378

Bit D6/3 L50/06 MP 1 FL UC
(3x)

500-9854

Bit D6/4 L50/12 MP 1 FL UC
(3x)

500-9856

Bit D6/6 L50/12 MP 1 FL UC BAL
(3x)

500-9857

Consumables
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Bit D6/6 L58/22 MP 1 FL UC BAL
(3x)

User’s Manual

500-9858

Bit description:
Example: Bit D6/6 L50/12 MP 1Fl UC BAL:
• D6/6: shank diameter: 6 mm / routing diameter: 6 mm.
• L50/12: tool length: 50 mm / maximum routing depth: 12 mm.
• MP multi-purpose
• 1Fl: 1 flute.
• UC: Up Cut: milling chips are moved upwards.
• Bal: Balanced bit.

Consumables
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